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Terms of use and legal notices

Switch to notes view!TERMS OF USE AND LEGAL NOTICE 

Alcatel-Lucent provides this training course to you subject to these Terms of Use and Legal Notice. Your use of this training course 
and/or this site constitutes your acceptance of and agreement to these Terms of Use and Legal Notice. These Terms of Use and Legal 
Notice, as well as the contents of this training course, may be updated or amended by Alcatel-Lucent from time to time without prior 
notice to you. Your use of the Alcatel-Lucent training materials after such update or amendment constitutes your acceptance of and 
agreement to said updated or amended Terms of Use and Legal Notice.

SAFETY WARNING

Alcatel-Lucent training materials can be for products or refer to products that have both lethal and dangerous voltages present. Always 
observe all safety precautions and do not work on the equipment alone. The user is strongly advised not to wear conductive jewelry 
while working on the products. Equipment referred to or used during this course may be electrostatic sensitive. Please observe correct 
anti-static precautions.

PERMISSION TO USE CONTENT 

The information, communications, scripts, photos, text, video, graphics, music, sounds, images and other materials provided in this 
training course (collectively the "Content"), is intended for the lawful use of employees of Alcatel-Lucent and other authorized
participants in this Alcatel-Lucent training course. You are hereby granted a non-exclusive, non-transferable permission to access and 
use the Content solely for your personal training and non-commercial use. This permission may be terminated by Alcatel-Lucent at 
any time for any reason or no reason, with or without notice. You must immediately cease use of the Content upon such termination.

COPYRIGHTS AND TRADEMARKS

The unauthorized copying, displaying or other use of any Content from this training course is a violation of the law and Alcatel-Lucent’s 
corporate policies. The Content is protected in France, the U.S. and other countries by a variety of laws, including but not limited to, 
copyright laws and treaty provisions, trademark laws, patent laws and other proprietary rights laws (collectively, "IP Rights"). In 
addition to Alcatel-Lucent’s IP Rights in the Content, in part and in whole, Alcatel-Lucent, and any of the third parties who have 
licensed and/or contributed to the Content, owns a copyright in the formatting and presentation of the Content.

Alcatel-Lucent does not grant you any permission to use the Content other than the permission expressly stated in these Terms of Use 
and Legal Notice. All other use of Content from this training course, including, but not limited to, modification, publication, transmission, 
participation in the transfer or sale of, copying, reproduction, republishing, creation of derivative works from, distribution, performance, 
display, incorporation into another training course or presentation, or in any other way exploiting any of the Content, in whole or in 
part, for uses other than those expressly permitted herein is strictly prohibited and shall not be made without Alcatel-Lucent’s prior 
written consent. All characters appearing in this training course are fictitious. Any resemblance to real persons, living or dead, is purely 
coincidental.

There may be a number of proprietary logos, marks, trademarks, slogans and product designations found in the Content. Alcatel, 
Lucent, Alcatel-Lucent and the Alcatel-Lucent logos are trademarks of Alcatel-Lucent. All other trademarks are the property of their 
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Lucent, Alcatel-Lucent and the Alcatel-Lucent logos are trademarks of Alcatel-Lucent. All other trademarks are the property of their 
respective owners. Alcatel-Lucent does not grant you a license to use any of the foregoing logos, marks, trademarks, slogans and
product designations in any fashion. Granting of the right to access and use the Content for training purposes does not confer upon 
you any license under any of Alcatel-Lucent’s or any third party's IP Rights.

DISCLAIMER

ALCATEL-LUCENT DISCLAIMS ALL WARRANTIES REGARDING THE TRAINING COURSES OR THE CONTENT, EXPRESS OR IMPLIED, 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
THE ALCATEL-LUCENT WILL NOT BE RESPONSIBLE OR LIABLE FOR ANY INJURY, LOSS, CLAIM, DAMAGE, OR ANY SPECIAL, 
EXEMPLARY, PUNITIVE, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND (INCLUDING WITHOUT LIMITATION 
LOSS PROFITS OR LOSS SAVINGS), WHETHER BASED IN CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE, THAT ARISES OUT 
OF OR IS IN ANY WAY CONNECTED WITH (A) ANY USE OR MISUSE OF THE CONTENT OR THE TRAINING COURSES BY YOU, OR (B) 
ANY FAILURE OR DELAY BY ALCATEL-LUCENT, ITS OFFICERS, DIRECTORS, AGENTS OR EMPLOYEES IN CONNECTION WITH THE 
CONTENT OR THE TRAINING COURSES (INCLUDING, WITHOUT LIMITATION, THE USE OF OR INABILITY TO USE ANY COMPONENT 
OF THE CONTENT OR TRAINING BY YOU). SOME JURISDICTIONS LIMIT OR PROHIBIT SUCH EXCLUSION OF WARRANTIES OR 
LIMITATION OF LIABILITIES AND SO THE FOREGOING EXCLUSION OF WARRANTIES OR LIMITATION OF LIABILITY MAY NOT APPLY 
TO YOU.

GOVERNING LAW

These Terms of Use and Legal Notice are governed by the laws of France. The operation and use of the training course is governed by 
the laws of the country that governs your employment contract, if applicable. If any provision of these Terms of Use and Legal Notice, 
or the application thereto to a person or circumstance, is held invalid or unenforceable by law, statute or a court of competent
jurisdiction, for any reason, then such provision shall be modified and/or superseded by a provision that reflects the intent of the 
original provision as closely as possible. All other provisions of these Terms of Use and Legal Notice shall remain in full force and 
effect. You may not assign these Terms of Use or any permission granted hereunder without Alcatel-Lucent’s prior written 
consent. Nothing herein shall be deemed an employment agreement or an offer of employment or an alteration in any way of a user’s 
terms of employment with or within Alcatel-Lucent. 

Copyright © 2013 Alcatel-Lucent. All Rights Reserved



@@COURSENAME
@@PRODUCT

3
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

Course outline

1. Product Overview

1. 5620 SAM Overview Lab

2. 5620 SAM Modularity Lab

2. System Overview

1. System Architecture Lab

2. Launch the SAM GUI Client Lab

3. SAM GUI Client Components Lab

4. SAM GUI Client Windows and Forms Components and Management 
Lab

5. Finding Information in SAM GUI Client Lab

6. SAM GUI Client Workspaces Lab

3. Network Management

1. Node Preparation for SAM Discovery Lab

2. Network Element Discovery Lab

3. Equipment Management Lab

4. Equipment Inventory Lab

5. Topology Map Components and Management Lab

Welcome to 5620 SAM

R12.0 Fundamentals

1. Product Overview

1. 5620 SAM Overview Lab

2. 5620 SAM Modularity Lab

2. System Overview

1. System Architecture Lab

2. Launch the SAM GUI Client Lab

3. SAM GUI Client Components Lab

4. SAM GUI Client Windows and Forms Components and Management Lab

5. Finding Information in SAM GUI Client Lab

6. SAM GUI Client Workspaces Lab

3. Network Management

1. Node Preparation for SAM Discovery Lab

2. Network Element Discovery Lab

3. Equipment Management Lab

4. Equipment Inventory Lab

5. Topology Map Components and Management Lab

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

6. Topology Map Info Tables Lab

7. Flat Maps Lab

8. User Activity Lab

4. Fault Management

1. Alarm Status and Severity Lab

2. Dynamic Alarm List Lab

3. Alarm Information Form Lab

4. Alarm Correlation, Affecting and Aggregated Alarms Lab

5. Alarm Management tools Lab

6. Object Life Cycle State Lab

7. Historical Alarms Lab

8. Fault Management Web Application Overview Lab

5. Performance Management

1. Scheduled Performance Statistics Lab

2. On-Demand Performance Statistcs Lab



@@COURSENAME
@@PRODUCT

4
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

Course objectives

� Upon completion of this course, you should be able to:

� List the 5620 SAM functions and main features
� Identify the components of the 5620 SAM management system
� Identify the elements 5620 SAM GUI
� Identify the 5620 SAM Web Applications and their function
� Use the 5620 SAM navigation tree views to perform equipment management operations
� Discover network element (NE) devices on 5620 SAM
� Use 5620 SAM topology maps to manage the network and display the status of network 
devices and services

� Generate file inventory lists for a managed device or for the entire network
� Use the 5620 SAM to identify alarms rose against equipment and services, alarm types, 
severity, status and correlation details

� Manage the User activity logs to view information about the actions performed by each 5620 
SAM clients

� Use the dynamic alarm list to filter and search for alarms, display correlated alarms, view 
alarm history and open alarm information details

� Identify the views available in the Fault Managment Web Application and their function
� Identify the 5620 SAM statistics collection capabilities
� Use the 5620 SAM to collect, display, and save to a file scheduled and on-demand 
performance statistics in tabular or graphical forms for selected objects
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� Identify the 5620 SAM statistics collection capabilities

� Use the 5620 SAM to collect, display, and save to a file scheduled and on-demand performance statistics in 
tabular or graphical forms for selected objects

Your feedback is appreciated!

Please feel free to Email your comments to:

training.feedback@alcatel-lucent.com

Please include the following training reference in your email:

TOS36033_V4.0-EQ Edition 1

Thank you!
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Module 1
5620 SAM Overview Lab

Section 1
Product Overview
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Module objectives

Upon completion of this lab module, you should be able to:

� Log in to the classroom terminals

� Launch the 5620 SAM client GUI

� Find and open the 5620 user documentation

� Search for information in the 5620 SAM user documentation
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Module objectives [cont.]
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1 5620 SAM Overview Labs
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1 5620 SAM Overview Labs

1.1 Login to a Classroom Terminal

Switch to notes view!Lab Exercise Objective:

In order for students to become familiar with the process of login to the classroom terminals and launch the 5620 

SAM GUI, over the course of this lab exercise students will:

�Receive and record the classroom terminal login user and password

�Login to the classroom terminal

�Receive and record the login name and password required to launch 5620 SAM GUI

�Launch the 5620 SAM client GUI on the classroom terminal

Instructions:

Follow your instructor‘s directions to log in to the classroom terminal. Your instructor might provide you with a 

user and password to login to classroom terminal. Use the table bellow to record this information which will be 

relevant for the rest of this training.

Classroom Terminal Login Information

User:

Password:

Follow your instructor‘s directions to open the 5620 SAM client. Your instructor might provide you with with the 

5620 SAM Server address, a login name and password. Use the table bellow to store this information which will be 

Classroom Terminal Login Information

User:

Password:

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.
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Follow your instructor‘s directions to open the 5620 SAM client. Your instructor might provide you with with the 

5620 SAM Server address, a login name and password. Use the table bellow to store this information which will be 

relevant for the rest of this training.

5620 SAM Login Information

Server address:

Login name:

Password:

Note

The courseware created for this training course includes multiple technical references to the 

corresponding procedures in the 5620 SAM User Documentation.

In addition, the Lab Modules created for this courseware include summaries of the steps 

recommended to achieve the objective for each lab exercise. Such summaries may contain a 

subset of steps from the User Documentation procedure, visual aids (GUI screen captures) 

providing details on the location items in the GUI, details on any configuration specifically 

required to achieve the exercise’s objective, and/or instructions to apply default values for 

procedure’s portions not critical to achieve the exercise’s objective on this training.

Follow your instructor’s directions to execute the lab exercises, and if required refer to the User 

Documentation for additional information.

5620 SAM Login Information

Server address:

Login name:

Password:
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1 5620 SAM Overview Labs

1.2 Launch the 5620 SAM Client GUI

� Double-click the 5620 SAM Client App icon 

Default Login

Login Name: admin

Password: 5620Sam!

� Enter Login 
Name and 
Password

� Click on the Login button

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.
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Lab Exercise Objective:

In order for students to access the 5620 SAM User Documentation typically installed with the 5620 SAM system, 

over the course of this lab exercise students will start a SAM GUI Client session (the next lab exercise describes 

the steps to open the documentation from a SAM GUI client).

Lab Exercise Objective:

In preparation for this lab exercise provide students with a valid SAM user Login Name and Password

Note 
This lab provides instructions to launch the SAM GUI client using a desktop icon. A GUI client 

session will be used for the subsequent labs. 

A separate module in this course describes the different methods to launch a GUI client, and a 

lab module details the steps recommended to start the 5620 SAM client GUI from a Solaris or 

RHEL machine using a CLI, and to start the 5620 SAM client GUI using a web browser. Follow your 

instructors directions to launch a GUI client session.  

Technical Reference

For more information on the steps to start the 5620 SAM client GUI see Alcatel-Lucent 5620 SAM 
12.0 User Guide – 5620 SAM GUI start up procedures.

Instructions:

The following lines and the images above summarize the steps recommended to start the 5620 SAM client GUI 

using a desktop icon:

1. Double-click on the shortcut icon that was created on your desktop when the software was installed. 

In any case and regardless of the method used to launch the SAM GUI client, the 5620 SAM login window (shown 

above) appears.

2. Enter the appropriate Login Name and Password, 

3.  Click on the Login button. The 5620 SAM client GUI opens.
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1 5620 SAM Overview Labs

1.3 Open the 5620 SAM User Documentation

� Choose Help → User Documentation form 
the 5620 SAM client GUI main menu

� Help - User 
Documentation 
page opens 

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.
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Lab Exercise Objective:

In order for students to become familiar with the location of the 5620 SAM user documentation, over the course 

of this lab exercise students will open the 5620 SAM user documentation from the client GUI

Technical Reference

The 5620 SAM Release 12.0 user documentation is delivered in HTML and PDF format with the 

5620 SAM Release 12.0  software installation.

The 5620 SAM customer documentation is available for download in PDF format from the Alcatel-
Lucent Customer Support Center:

http://www.alcatel-lucent.com/myaccess.

If you are a new user and require access to this service, please contact your Alcatel-Lucent 

support representative.

Note
The user documentation is typically installed on the default location in the SAM server during 

the installation process. Should the 5620 SAM user documentation for this course is installed in a 

different location other than the default location, follow your instructor’s directions to access 

it.

Instructions:

The following lines and the images above summarize the steps recommended to open the 5620 SAM user 

documentation from the client GUI for this lab.

1. Choose Help → User Documentation form the 5620 SAM client GUI main menu

2. The help system opens on a web browser displaying the User Documentation Index which provides a summary 

of and links to all 5620 SAM customer documents, as shown in the image above. 
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1 5620 SAM Overview Labs

1.3 Open the 5620 SAM User Documentation [cont.]

Search 
field

Contents 
frame

PDF library 
index

Search 
results User Documentation 

page main frame
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The User Documentation Index displayed in the main frame presents a description of each document of the 5620 

SAM documentation suite. The documentation suite describes the 5620 SAM and the associated network 

management of its supported devices.

Technical Reference

For more information about the 5620 SAM Documentation suite, a list of the documents in the 

5620 SAM documentation suite for release 12.0, and a description for each document, see the 

Alcatel-Lucent 5620 SAM 12.0 User Guide – Prefix and/or the Prefix of most 5620 SAM 12.0 

guide documents.

The Contents Frame lists the documents included on the User Documentation Suite for the SAM release installed 

in the Server. From the Contents Frame, click on a document name from the list to open it on the main frame 

in HTML format. Click on the plus sign (+) next to a list entry to expand the view to the lower hierarchy 

level(s) contained for that entry.

Clicking in PDF Library Index tab will display a list a list of PDF documents on the left frame. From the PDF 

Library Index, click on a document name to open it on the main frame on PDF format.

Note

Users of Mozilla browsers may receive an error message when using the User  Documentation 

Index page (index.html) to open the PDF files in the 5620 SAM documentation suite. The offline 

storage and default cache values used by he browsers are the cause of the error message. 

Alcatel-Lucent recommends changing the offline storage (Mozilla Firefox) or  cache (Mozilla 1.7) 

values to 100 Mbytes to eliminate the error message.
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1 5620 SAM Overview Labs

1.5 Search info in the 5620 SAM User Documentation

� Enter query and click 
on the Go button
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Lab Exercise Objective:

In order for students to become familiar with the process of finding information in the 5620 SAM user 

documentation suite, over the course of this lab exercise students will search for a topic in the 5620 SAM user 

documentation suite using the Help system – User documentation navigation window

Note

In order to perform a search using the Help navigation window, the user documentation suite 

must have been installed on the default location in the SAM server during the SAM installation 

process. 

Should the 5620 SAM user documentation for this course is installed in a different location other 

than the default location, follow your instructor’s directions to access it to perform a search.

Instructions:

The following lines and the images above summarize the steps recommended to search for a topic using the Help 

- User documentation navigation window for this lab.

Open the help system choosing Help → User Documentation form the 5620 SAM client GUI main menu. The help 

system will open on a web browser.

1. From the Help system – User Documentation window, enter a query in the Search field. To narrow the 

search query using search terms and Boolean operators. Click on the Go button. 
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1 5620 SAM Overview Labs

1.5 Search info in the 5620 SAM User Documentation [cont.]

� Click on a search result to open 
the relevant SAM user document 
containing the searched topic

Search results 
displayed
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TOS36033_V4.0-EQ-R12.0-Ed1 Module 1.1 Edition 4
Section 1 � Module 1 � Page 13

The Help system – User Documentation window refreshes displaying the search results on the left panel.

2. Click on a search result to open the relevant SAM user document containing the searched information. The 

main frame will display the appropriate user document section with the searched item highlighted.

Note

In addition of using search terms and Boolean operators to narrow the search query, the help 

system allows to limit the scope of a search by clicking in the Scope button to select only the 

documents and/or the sections in documents that the operator is interested in.
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5620 SAM Overview Lab
End of module
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Module 2
5620 SAM Modularity Lab

Section 1
Product Overview

5620 SAM

R12.0 Fundamentals
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Module objectives

Upon completion of this lab module, you should be able to:

� View the SAM license information containing details about:
� customer name and active license key value

� host name and IP address of the main server

� number of supported operator positions

� supported 5620 SAM modules and packages

� redundancy configuration information for redundant Solaris installations

� Save to file 5620 SAM License Information

� Launch the 5620 SAM Web Applications
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Module objectives [cont.]
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1 5620 SAM Modularity Labs
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1 5620 SAM Modularity Labs

1.1 View the 5620 SAM License Information

5620 SAM Release 

� Choose Help → 5620 SAM License Information

Supported 
operator 
positions

License System 
IDs and key type

Licensed 
5620 SAM modules 
and packages
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Job Aid Objective:

In order for students to obtain information about the installed 5620 SAM software release and license capacity, 

instructions in this lab exercise will guide students to view the 5620 SAM License Information

Instructions:

This lab exercise provide instructions to view the 5620 SAM software license information including:

� customer name and active license key value

� host name and IP address of the main server

� number of supported operator positions

� supported 5620 SAM modules and packages

� redundancy configuration information for redundant Solaris installations

Technical Reference 

For more information on the steps to view the 5620 SAM License Information see Alcatel-Lucent 
5620 SAM 12.0 User Guide – Software configuration procedures – Procedure To view the 
5620 SAM software release and system information.

The following lines and the images above summarize the steps recommended to view the 5620 SAM License 

Information for this lab exercise.

1. Choose Help → 5620 SAM License Information form the 5620 SAM main menu. The 5620 SAM License (Edit)
form opens with the General tab displayed.
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1 5620 SAM Modularity Labs

1.1 View the 5620 SAM License Information [cont.]

� Click on the Devices and 
Quantities Licensed tab button

Licensed products 
information:

• Licensed
• Consumed
• Remaining 

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 1.2 Edition 4
Section 1 � Module 2 � Page 9

2. On The 5620 SAM License (Edit) form, click on the Devices and Quantities Licensed tab button.

Review the software license information, which includes the following:

� device information that includes the following:

� quantity licensed

� quantity consumed

� quantity remaining
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1 5620 SAM Modularity Labs

1.2 Save to a File 5620 SAM License Information

� Choose Export License 
Information to File 

� Specify a name, 
location and file 
format. Click on 
the Save button 
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Job Aid Objective:

In order for students to obtain information about the installed 5620 SAM software release and license capacity, 

instructions in this lab exercise will guide students to save to file 5620 SAM License Information

Instructions:

The following lines and the images above summarize the steps recommended to save to a file the 5620 SAM 

License Information for this lab exercise. 

1. Click on the More Actions button and choose Export License Information to File form the contextual menu. 

The Save As form opens.

2. Use the Save As form to specify a name, location, and format for the file that contains the exported license 

information. Click on the Save button. The license key file is saved to the specified location.

Note

License key files can be saved in HTML or text format.

Technical Reference

For more information on the steps to save to a file the 5620 SAM License Information see 

Alcatel-Lucent 5620 SAM 11.0 User Guide – 6.2 Software configuration procedures –
Procedure 6-2 To export license information to a file.
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2 - 5620 SAM Workspaces Overview Labs
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2 - 5620 SAM Workspaces Overview Labs

2.1 Launch Web Applications Lab

1 http://server:8400/login

Non-secured 
connection

https://server:9400/login

Secured 
connection

Where server is the hostname or IP 
address of the 5620 SAM server 
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Lab Exercise Objective:

In order for students to become familiar with the process to launch the 5620 SAM Web Applications, instructions 

in this lab exercise will guide students to access the Web application launch panel.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a username name and 

password of a 5620 SAM user that has access to the Web Applications. Note that the default admin user group 

can access all 5620 SAM web applications. 

Ensure the terminal has connectivity with the 5620 SAM Server, and the terminal’s web browser is compatible 

with the 5620 Web Apps.

Provide students with information about whether secured connection (SSL) is enabled or disabled in the 5620 SAM 

server.

Technical Reference

For more information on the steps to access the 5620 SAM Web Applications (including browser 

compatibility requirements) see Alcatel-Lucent 5620 SAM User Guide - 5620 SAM web 
applications section.

Instructions:

The following lines and the images above summarize the steps recommended to launch the 5620 SAM Web App

using a web browser for this lab exercise.

1. Open a web browser window and Navigate to one of the following URLs:

http://server:8400/login  for a non-secured connection (SSL not enabled on the 5620 SAM Server) or

https://server:9400/login  for a secured connection (SSL enabled on the 5620 SAM Server)

where server is the IP address or hostname of the 5620 SAM main server

The web browser opens the 5620 SAM Web Applications login page shown in the figure above.
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2 - 5620 SAM Workspaces Overview Labs

2.1 Launch Web Applications Lab [cont.]

Wireless Supervision

Equipment View Service Supervision

Fault 
Management

2
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2. In the 5620 SAM Web Applications login page, enter the provided username and password and click on the 

Login button. The 5620 SAM Web Application launch panel appears. As shown on the image above

3. Click on a Web Application icon to launch the web application.

Note

Each 5620 SAM Web Applications can also be launched using a direct URL. For instance, use one of 

the following URLs to launch the Wireless Supervision Web App:

● For a non-secured connection:

http://server:8400/WirelessSupervision

● For a secured connection:

https://server:9400/WirelessSupervision

Technical Reference

For more details on direct URLs for launching other 5620 SAM Web Applications see Alcatel-
Lucent 5620 SAM User Guide - 5620 SAM web applications section.
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Module objectives

Upon completion of this module, you should be able to:

� View information about the installed 5620 SAM system configuration, including 
5620 SAM main server and database redundancy information
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Job Aid Objective:

In order for students to view information about the installed 5620 SAM system configuration, instructions in this 

job aid will guide students to display the 5620 SAM main server and database redundancy information (if 

applicable) including:

� whether redundancy is enabled in the 5620 SAM management domain

� the IP addresses, host names, and statuses of the 5620 SAM main servers

� the IP addresses, host names, database names, and instance names of the 5620 SAM databases

Technical Reference 

For more information on the steps to view the 5620 SAM system configuration see Alcatel-
Lucent 5620 SAM 12.0 User Guide – Software configuration procedures – Procedure - To view 
the 5620 SAM software release and system information.

Instructions:

The following lines and the images above summarize the steps recommended to display the 5620 SAM installed 

system configuration.

1. Choose Administration → System information form the 5620 SAM main menu. The System Information form 

opens with the General tab displayed.
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On the System Information form General tab, view information about: 

� whether redundancy is enabled in the 5620 SAM management domain, including:

� Domain Name, the 5620 SAM domain name specified at installation

� Redundancy Enabled, selected if redundancy is enabled

� the host names, and status of the 5620 SAM primary server. 

If required, click on the Properties button to display additional information about the primary 5620 SAM 

� server. The Main Server properties form opens displaying main server information.

� the instance name, IP address, host name, and status of the 5620 SAM database servers



In addition, click to open the respective tab for viewing information about:

� Auxiliary Servers, including:

� Host Name, the host name of the auxiliary server

� Port Number, identifies the port that the auxiliary server uses to communicate with each 

main server and database

� Auxiliary Server Type, Reserved or Preferred

� Server Status, Unknown, Down, Up or Unused

� Resource Managed, selected if the auxiliary server is included in 5620 SAM resource 

management

� Public IP address, the IP address that the main servers use to reach the auxiliary server

� Private IP address, displayed if NAT is used between the main servers and the auxiliary 

server

� Auxiliary Service Server Pair Group, displaying information about the assignment of eNodeBs to 

call-trace auxiliary-server pair. It allows operator to manage which eNodeBs are assigned to 

which call-trace auxiliary-server pairs.

� Auxiliary Services, including:

� Service Name, the type of service, for example, statistics collection

� Selected, indicates whether this auxiliary server is currently used by a main server to 

process requests

� IP Address, the IP address that each main server uses to reach the auxiliary server

� Host Name, the host name of this auxiliary server

Auxiliary Server Type, Reserved or Preferred

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.
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� Auxiliary Server Type, Reserved or Preferred

� Client Delegate Servers, displays a list of client delegate servers allowing operators to 

configure the Maximum UI Sessions parameter to determine the number of allowed client 

sessions for a client delegate server

2. To view information about the installed 5620 SAM database, from the System Information form 

click on the Database button. The Database Manager (Edit) form opens with the General tab 

displayed.

Technical Reference 

For more information on the steps to view the 5620 SAM system configuration see 

Alcatel-Lucent 5620 SAM 12.0 User Guide – 5620 SAM system redundancy 
procedures– Procedure - To view the 5620 SAM main server and database 
status.
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The Database Manager (Edit) form General tab displays database information that includes the following:

� Database Name, created during 5620 SAM installation; the default is samdb

� Instance Name, created during 5620 SAM installation; the default is samdb

� Listener Port, the port on the server used for database communication

� DBID, the Oracle database ID, sometimes referred to as the SID

� Creation Time, the database creation time

� Version, the Oracle version identifier, for example, Oracle Database 11g Enterprise Edition 11.2.0.2.0

� IP Address, the IP address that the server uses as the destination address for communicating with the 

database

� Host Name, the host name of the database station

� Open Mode, specifies the type of database access, either READ or READ WRITE

� Archive Log Mode, specifies whether to archive the database log files; this is configured during database 

installation

� Protection Mode, the database protection mode, which is set by default during installation to MAXIMUM 

PERFORMANCE

3. Close the Database Manager (Edit) form. Close the System Information form 
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Module objectives

Upon completion of this lab module, you should be able to:

� Start the 5620 SAM client GUI using:
� a desktop icon

� a web browser

� a CLI from a Windows machine

� a CLI from a Solaris machine
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1 Launch the 5620 SAM GUI Labs
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1 Launch the 5620 SAM GUI Labs

1.1 Launch Using a Desktop Icon

Default Login

Login Name: admin

Password: 5620Sam!

2

1

Double-click the 5620 SAM Client App icon 

3
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Lab Exercise Objective:

In order for students to become familiar with the process to launch the 5620 SAM GUI, instructions in this lab 

exercise will guide students to start the 5620 SAM GUI client using a desktop icon.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a login name and 

password.

Technical Reference

For more information on the steps to start the 5620 SAM client GUI see Alcatel-Lucent 5620 
SAM 12.0 User Guide – 5620 SAM GUI start up procedures – Procedure - To start the 5620 
SAM client GUI on a Windows single-user client station

Instructions:

The following lines and the images above summarize the steps recommended to start the 5620 SAM client GUI  

using a desktop icon for this lab exercise.

1. Double-click on the shortcut icon that was created on your desktop when the software was installed. The 5620 

SAM login window appears. Should there be more than one SAM servers available, verify the Server address 

correspond to the SAM system you are attempting to access.

2. Enter the appropriate Login Name and Password.

3. Click on the Login button. The 5620 SAM client GUI opens.
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1 Launch the 5620 SAM GUI Labs

1.2 Launch Using a Web Browser

1

2

Navigate to the following URL:
http://server:8085/client
where server is the IP address or 
hostname of the 5620 SAM main server
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Lab Exercise Objective:

In order for students to become familiar with the process to launch the 5620 SAM GUI, instructions in this lab 

exercise will guide students to start the 5620 SAM GUI client using a desktop icon.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a login name and 

password.

Ensure the terminal’s web browser has connectivity with the 5620 SAM Server. 

Technical Reference

For more information on the steps to start the 5620 SAM client GUI see Alcatel-Lucent 5620 
SAM 12.0 User Guide – 5620 SAM GUI start up procedures – Procedure - To start the 5620 
SAM client GUI on a Windows single-user client station

Instructions:

The following lines and the images above summarize the steps recommended to start the 5620 SAM client GUI  

using a web browser for this lab exercise.

1. Open a web browser window and Navigate to the following URL:

http://server:8085/client

where server is the IP address or hostname of the 5620 SAM main server

The web browser opens the 5620 SAM Client welcome page shown in the figure above.

2. Click on the Install or Launch 5620 SAM Client link. 
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1 Launch the 5620 SAM GUI Labs

1.2 Launch Using a Web Browser [cont.]

Switch to notes view!
3. If you did not use a web browser to install the client, a form opens and prompts you for the 

client installation location. Use the form to specify the client installation directory, for 

example, C:\5620sam\client.

4. The 5620 SAM login window appears. Enter your Login Name and Password, and click on the 

Login button. 

The 5620 SAM client GUI opens.
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1 Launch the 5620 SAM GUI Labs

1.3 Launch from a Windows Machine Using a CLI

CLI allows operators to specify one or more client startup options 
See Alcatel-Lucent 5620 SAM User Guide – 5620 SAM GUI startup procedures 

for a listing of startup options 
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Lab Exercise Objective:

In order for students to become familiar with the process to launch the 5620 SAM GUI, instructions in this lab 

exercise will guide students to start the 5620 SAM GUI client from a Windows machine using a CLI.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a login name and 

password.

Provide students with instructions on any client startup 5620 SAM client startup options for Windows to be used in 

this lab exercise.

Technical Reference

For more information on the steps to start the 5620 SAM client GUI see Alcatel-Lucent 5620 
SAM 12.0 R3 User Guide – 3.4 5620 SAM GUI start up procedures – Procedure 3-1 To start the 
5620 SAM client GUI on a Windows single-user client station

Instructions:

The following lines and the images above summarize the steps recommended to start the 5620 SAM client GUI  

from a Windows machine using a CLI for this lab exercise.

Using a CLI to start the client GUI allows operators to specify one or more client startup options.

1. Open a command window. At the CLI prompt navigate to the 5620 SAM client installation drive and directory, 

entering the commands:

<drive id> ↵

cd /<sam client directory>/nms/bin ↵

where: <drive id> is the drive on which the 5620 SAM client is installed, for example, D:

<sam client directory> is the 5620 SAM client installation location, typically \5620sam\client
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1 Launch the 5620 SAM GUI Labs

1.3 Launch from a Windows Machine Using a CLI [cont.]

Switch to notes view!
2. At the CLI prompt, start the 5620 SAM client by typing nmsclient.bat ↵ . The 5620 SAM login 

window appears.

Alternatively, following your instructor’s directions at the CLI prompt you can start the 5620 

SAM client using one or more startup options. 

For example, to force a client update, enter: nmsclient.bat update ↵

Technical Reference

See Alcatel-Lucent 5620 SAM User Guide – 5620 SAM GUI startup procedures for 

a complete listing of 5620 SAM client startup options for Windows 

3. On the 5620 SAM login window, enter your Login Name and Password, and click on the Login

button. 

The 5620 SAM client GUI opens.
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1 Launch the 5620 SAM GUI Labs

1.4 Launch from a RHEL or Solaris Machine Using a CLI

CLI allows operators to specify one or more client startup options 
See Alcatel-Lucent 5620 SAM User Guide – 5620 SAM GUI startup procedures 

for a listing of startup options 
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Lab Exercise Objective:

In order for students to become familiar with the process to launch the 5620 SAM GUI, instructions in this lab 

exercise will guide students to start the 5620 SAM GUI client from a Solaris machine using a CLI.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a login name, password, 

and if applicable instructions to access the Solaris machine and launch a terminal window.

Provide students with instructions on any client startup 5620 SAM client startup options for Windows to be used in 

this lab exercise.

Technical Reference

For more information on the steps to start the 5620 SAM client GUI see Alcatel-Lucent 5620 
SAM 12.0 R3 User Guide – 3.4 5620 SAM GUI start up procedures – Procedure 3.2 Procedure 3-
2 To start the 5620 SAM client GUI on a RHEL or Solaris single-user client station and 
Procedure 3-3 To start the 5620 SAM client GUI through a client delegate server

Instructions:

The following lines and the images above summarize the steps recommended to start the 5620 SAM client GUI 

from a Solaris machine using a CLI for this lab exercise.

1. Open a bash console window on the client station. At the CLI prompt to navigate to the 5620 SAM client 

installation directory, entering the command: /<sam client directory>/nms/bin ↵

where: <sam client directory> is the 5620 SAM client installation location, typically /opt/5620sam/client
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1.4 Launch from a RHEL or Solaris Machine Using a CLI 
[cont.]

Switch to notes view!
2. Start the 5620 SAM client by typing ./nmsclient.bash ↵ . The 5620 SAM login window appears.

Alternatively, following your instructor’s directions at the CLI prompt you can start the 5620 

SAM client using one or more startup options. 

Technical Reference

See Alcatel-Lucent 5620 SAM User Guide – 5620 SAM GUI startup procedures for 

a complete listing of 5620 SAM client startup options for Solaris 

3. On the 5620 SAM login window, enter your Login Name and Password, and click on the Login 

button. 

The 5620 SAM client GUI opens.
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Launch the SAM GUI Client Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Identify the SAM GUI Client components

� Send a text message to another 5620 SAM user
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Module objectives [cont.]
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1 GUI Client Components Labs
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1 GUI Client Components Labs

1.1 Identify GUI Components

Menu bar

Tool bar

Navigation
tree

Working
panel

Dynamic
alarm list

Task bar

Status bar
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Lab Exercise Objective:

In order for students to become familiar with the 5620 SAM GUI Client, over the course of this lab exercise 
students will identify components to the 5620 SAM GUI.

Instructions:

Follow your instructor‘s directions to open 5620 SAM GUI toolbar. Take a moment to identify the seven (7) basic 
components to the 5620 SAM GUI which are:

� Menu Bar – used to execute 5620 SAM tasks

� Tool Bar – provides shortcuts for Menu functions

� Navigation Tree Window – displays all 5650 CPAM managed equipment, services, and protocols including OSPF 
and IS-IS

� Working Window Pane – displays drawings and configuration forms

� Dynamic Alarms List – displays incoming events and alarms

� Task Bar – used to track all currently opened windows of the client session.

� Status Bar – displays user account, date, redundancy, alarm-related object, propagation, and connection 
status information.

Using the Menus, the Toolbar, or Shortcuts:

� From the drop down submenu options under each top-level menu. An applicable shortcut icon for that menu 
function is shown next to the options text.

� From the menu equivalent in the Toolbar. Scrolling over the icons will display their function.

� By typing the appropriate ALT+Key shortcut. For example, ALT+P opens the policies menu.

� The underlined letter indicates the shortcut action.
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� Choose Application → Text Message

1 GUI Client Components Labs

1.4 Send a text Message

� Type the text message
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Lab Exercise Objective:

In order to communicate with another 5620 SAM user, with multiple users, or with all active users logged in to the 
5620 SAM Server, over the course of this lab exercise students will send text message to another 5620 SAM 
user.

Instructor Preparation:

Ensure each student is logged in using a different user name. 

Alternatively, if all students are logged using the same user name ask each students to identify the unique session 
number each has been assign by choosing Help → About 5620 SAM/5650 CPAM form the 5620 SAM client GUI 
main menu. A window will open, look for the session number.

Instructions:

Follow your instructor’s directions to send text messages to another 5620 SAM user or to all active users logged 

into the 5620 SAM. 

Technical Reference 

For more information on the steps to generate an inventory and save to a file listed data see 

Alcatel-Lucent 5620 SAM 12.0 R5 User Guide –3.7 Basic 5620 SAM GUI operation procedures –
Procedure 3-23 : To send a text message to another 5620 SAM user

The following lines and the images above summarize the steps recommended to open the 5620 SAM user 
documentation from the client GUI for this lab.

1. Choose Application → Text Message from the 5620 SAM main menu. The Text Message window opens. 

2. Type the text message in the text area.

Note 

Alternatively, press CTRL+V to paste information from the clipboard into the text area. For 
example, pasting a window link identifier creates a link that the recipient can click to launch the 
window.
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1 GUI Client Components Labs

1.4 Send a text Message [cont.]

� Click on the Send To… Button

� Choose a client session and click OK
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3. Click on the Send To... button. The Select Session window opens.

4. Select a client session from the list, to select multiple client sessions as message recipients hold the Ctrl 
button and click on the client sessions from the list. 
Click on the OK button to send the message. 
The text message is sent to the selected client(s). Messages are uniquely identified with the Client ID number 
of the sender. You can reply back to the sender by clicking on the Reply button. 
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SAM GUI Client Components Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Detach a GUI window to an external window and manage external windows

� Send a link to a SAM window on a GUI text message

� Generate an inventory of listed data and save to a file information from a 5620 
SAM list form

� Manage the collapsible panels state (expanded or collapsed) when properties 
forms and configuration forms open

� Manage the tabs displayed (or hidden) on 5620 SAM forms
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Module objectives [cont.]
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1 SAM GUI Client Windows Management Labs
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1 SAM GUI Client Windows and Forms Components and Management Labs

1.1 Detach a GUI Window to an External Window

� Select a GUI window For this lab exercise, a second 
copy of a Dynamic Alarm list is 
detached as external window1a

� Right-click on the window title 
bar
Choose Move to an External 
Window 
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Lab Exercise Objective:

In order to become familiar with the procedure to detach and manage external windows, instructions in this lab 

exercise will guide students to detach a GUI window to an external window.

Instructor Preparation: 

In preparation for this lab exercise identify a GUI window to be detached as external window.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to detach a GUI window to an 

external window:

Technical Reference 

For more information on the steps to filter listed information and/or search for data on 5620 

SAM list forms see Alcatel-Lucent 5620 SAM 10.0 R5 User Guide – 3.7 5620 SAM GUI search 
procedures – Procedure 3.26 To perform a simple search using column headings.

The following lines and the images above summarize the steps recommended to detach a (second copy of the) 

Dynamic Alarm List as an external window.

1. Select a GUI window.

a. For this lab exercise example, click on the “Alarm Window” shortcut icon on the Tool Bar. A second copy 

of the Dynamic Alarm window opens in the GUI Work Pane.

b. Select, or keep selected the newly opened second copy of the Dynamic Alarm window.

2. Right-click on the window title bar and choose Move to an External Window from the menu that is displayed.

Alternatively with the window selected, Choose Window → Move to an External Window form the 5620 SAM 

main menu. The selected window opens as an external window.
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1 SAM GUI Client Windows and Forms Components and Management Labs

1.1 Detach a GUI Window to an External Window [cont.]

External window managed by 
operating system, not displayed 
on 5620 SAM GUI Task bar
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The selected window is detached as an external window. For this lab exercise example, the second copy of the 

Dynamic Alrm list form is detached as an external window.

Note the following about the Dynamic Alarm List detached as external window:

� 5620 SAM GUI task bar does not display anymore the copy of the Dynamic Alarm List which has been detached 

as external window

� The detached external window is now managed by the operating system rather than the 5620 SAM GUI. 

External windows are placed into a group of open 5620 SAM windows on the operating system task bar [as 

shown in the figure above]

� Alarms in the detached Dynamic Alarm List are still being updated. That is because, any information displayed 

and/or configuration changes performed on an external window are still related to the SAM Server in the same 

manner as before the window was detached from the GUI.

� In multiple monitors display systems, an external windows can be moved and/or maximized on a separate 

monitor. For instance, allowing operators to have the SAM GUI opened on one screen and the detached 

Dynamic Alarm List on a separate screen.

� Any windows launched from an external window appear as separate external windows. For instance, any alarm 

opened by double-clicking on a line on this detached Dynamic Alarm List will open as a separate external 

window.

� From the 5620 SAM GUI:

� External windows can be viewed and brought to the front using Window menu in the Menu Bar.

� The Window menu contains an option to Close All External SAM Windows

� An external window cannot be moved back into the 5620 SAM GUI. The operator must close the external 

window and re-open it in the SAM GUI.
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1 SAM GUI Client Windows and Forms Components and Management Labs

1.2 Send a link to a SAM Window on Text Message

1

A SAM window link identifier for the opened 
window is copied to the SAM Clipboard

Right-click 
on the tab 
name
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Lab Exercise Objective:

In order to share with another SAM user a link to the SAM window currently opened on the GUI, instructions in this 

lab exercise will guide students to send a link to a SAM window on a GUI text message.

Lab Exercise preparation: 

In preparation for this lab exercise open a SAM window for which a link will be send.

Ensure another user is logged in using a unique SAM user name. Alternatively, if all users are logged in using the 

same user name, use the Connection ID to identify the message addressee.

Instructions:

The following lines and the images above summarize the steps recommended send a link to the 5620 SAM 
License – Device and Quantities Licensed list form.

Open a SAM window to be shared with another SAM user. If the a window contain multiple tabs, make sure to 

open the tab of interest to be shared, as the link sent will point the tab of interest in a window.

For this lab exercise example, open the 5620 SAM license – Device and Quantities Licensed list form, 

choosing Help → 5620 SAM License Information form the 5620 SAM main menu. The 5620 SAM License (Edit)
form opens with the General tab displayed. Click on the Devices and Quantities Licensed tab button.

1. Right-click on a tab name that is to be sent on a text message, and choose the Copy Property Form Identifier 

function. The tab on the form identefier link is copied to the clipboard.

Alternatively: With the SAM window to be shared opened in the foreground, choose Application  → Save 
Window To Clipboard from the 5620 SAM main menu. The SAM window link identifier for the opened window 

is copied to the SAM Clipboard.
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1 SAM GUI Client Windows and Forms Components and Management Labs

1.2 Send a link to a SAM Window on Text Message [cont.]

On the recipient's GUI
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On the recipient’s GUI.

A Text Message window appears when a text message is received. The text message may include a window link 

identifier which the recipient can click on to launch the window, the linked SAM window will open. If the SAM 

window contains multiple tabs, the window will open the tab displayed the sender‘s GUI when the window 

link identifer was created by saving the window to the clipboard.

For this lab example, the figures above show a text message a SAM user logged in as John received. The text 

message includes a window link identifier to the 5620 SAM License form with the Device and Quantities 
Licensed tab displayed.

Note

Please note that when a SAM window form opened using a window link identifier received on a 

text message contains configurable parameters and/or lists of elements, the SAM window will 

display only the configurable parameter values and list elements that have been committed to 

the SAM Server at the time of opening the window link.

Changes to configurable parameters and/or elements to a list are committed to the SAM Server 

either by clicking on the OK or Apply button on the SAM window form.

Most lists on SAM window forms can be refreshed by clicking on the Search button.
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2 Managing Lists on 5620 SAM Windows and 
Forms Labs
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2 Managing Lists on 5620 SAM Windows and Forms Labs

2.1 Modify Columns Displayed in a List Form

� Right-click on the 
list heading

� Choose Column 
Display 

� Select one or more entries
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Lab Exercise Objective:

In order for students to become familiar with the procedure to modify the columns that are displayed in a 5620 

SAM list form, instructions in this lab exercise will guide students to hide, show and sort columns that are 

displayed in a list form.

Instructions:

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to hide on the 5620 SAM license – Device and Quantities Licensed list form the Consumed and Exceeded
columns for this lab exercise.

To open the 5620 SAM license – Device and Quantities Licensed list form, choose Help → 5620 SAM License 
Information form the 5620 SAM main menu. The 5620 SAM License (Edit) form opens with the General tab 

displayed. Click on the Devices and Quantities Licensed tab button.

1. Right-click on the list heading to generate an inventory of data, a contextual inventory menu appears. 

2. Choose Column Display from the contextual menu. The Column Display form opens with the names of all 

displayed columns in the Displayed on Table list.

3. Select one or more column name entries form the Displayed on Table list (to select multiple entries press and 

hold down the Ctrl key and click on the entries).
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2 Managing Lists on 5620 SAM Windows and Forms Labs

2.1 Modify Columns Displayed in a List Form [cont.]

� Click on 
the left 
arrow 
button

� Click on the OK button
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4. Click on the left arrow button. The selected column names move to the Available for Table list panel.

If required, reorganize the order in which columns appear in the list by selecting a column name from the 

Displayed on Table list and using the up arrow and down arrow buttons.

5. Click on the OK button. The Column Display form closes, and the list reappears with the modifications 

applied to the columns displayed in the list. 
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2 Managing Lists on 5620 SAM Windows and Forms Labs

2.2 Generate an Inventory and Save to a File Listed Data

� Choose Help → 5620 SAM License Information

� Right-click on the 
list heading

� Choose Save 
To File 

� Click on the Devices and Quantities Licensed tab button
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Job aid Objective:

In order for students to become familiar with the procedure to generate an inventory and save to a file the data 

available on most 5620 SAM list forms, instructions in this lab exercise will guide students to generate an 

inventory of listed data and save listed information to a file

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to generate an inventory and 

save to a file the data available on a 5620 SAM list form:

Technical Reference 

For more information on the steps to generate an inventory and save to a file listed data see 

Alcatel-Lucent 5620 SAM 10.0 R5 User Guide – 3.8 5620 SAM GUI search procedures –
Procedure 3-37 To view and manage listed information and Procedure 3-38 To save listed 
information to a file.

The following lines and the images above summarize the steps recommended to generate an inventory and save 

to a file the data listed on the 5620 SAM licensed devices information form.

1. Choose Help → 5620 SAM License Information form the 5620 SAM main menu. The 5620 SAM License (Edit)
form opens with the General tab displayed.

2. Click on the Devices and Quantities Licensed tab button.

3. Right-click on the list heading to generate an inventory of data, a contextual inventory menu appears. The 

Count indicates the number of objects in the list.

4. Choose Save To File from the contextual menu. The Save As form opens.
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2 Managing Lists on 5620 SAM Windows and Forms Labs

2.2 Generate an Inventory and Save to a File Listed Data [cont.]

Switch to notes view!Note 

On the Save As form, the 5620 SAM uses the user home directory as the default location for 

saved files.

5. Use the Save As form to specify the name and location of the file that is to contain the listed information. 

The information can be saved in the following formats:

� plain text

� HTML

� CSV

6. Click on the Save button. The information is saved as specified and the Save as form closes.
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3 Manage Collapsible Panels State on Windows 
and Forms Labs

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 2.4 Edition 4
Section 2 � Module 4 � Page 17



5620 SAM � R12.0 Fundamentals
System Overview � SAM GUI Client Windows and Forms Components and Management Lab

2 � 4 � 18
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

3 Finding Information in Windows and Forms Labs

3.1 Collapse All Collapsible Panels

Right-click 
on a tab 
name

Open a 5620 SAM Form

1
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Lab Exercise Objective:

In order for students to become familiar with the procedure manage the state (collapsed or expanded) of 

collapsible panels of a form when it opens, instructions in this lab exercise will guide students collapse all

panels on a form and close the form, collapsible panels state will be saved.

Instructor Preparation: 

In preparation for this lab exercise identify a GUI window for which collapsible panel state will be changed.

Ensure each student is logged in using an unique SAM user, as preferences for collapsible panels will be saved on 

a per user basis.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to perform a search on a list 

form using the column headings:

Technical Reference 

For more information on the use of collapsible panels see Alcatel-Lucent 5620 SAM 12.0 R3 
User Guide – 4.1 5620 SAM GUI overview.

The following lines and the images above summarize the steps recommended to collapse all panels in the 5620 

SAM License Information form.

1. Open a 5620 SAM form. 

For this lab exercise example to open the 5620 SAM License information form, choose Help → 5620 SAM 
License Information form the 5620 SAM main menu. The 5620 SAM License (Edit) form opens with the 

General tab displayed.

Right-click on a tab name and choose the Collapse All Panels function. All panels in the form are collapsed.
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3 Finding Information in Windows and Forms Labs

3.1 Collapse All Collapsible Panels [cont.]

Re-open the 5620 SAM Form

The form opens displaying all 
panels collapsed
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2. Close the 5620 SAM form. The current state of all collapsible panels in the form is saved for this form.

For this lab exercise example to close the 5620 SAM License information form.

3. Re-open the form. Note that the last saved state of all collapsible panels is displayed.

The user may choose to leave selected collapsible panels opened and other panels collapsed. The collapsible 

panels state for this form is saved when the form is closed. 

Note

The collapse panel funtions are only available on form tabs containing at least one collapsible 

panel.

The Collapse All Panels fuction is not displayed, when all panels in the form are already 

collapsed.
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3 Finding Information in Windows and Forms Labs

3.2 Expand All Collapsible Panels

Right-click 
on a tab 
name

Open a 5620 SAM Form

1
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Lab Exercise Objective:

In order for students to become familiar with the procedure manage the state (collapsed or expanded) of 

collapsible panels of a form when it opens, instructions in this lab exercise will guide students expand all

panels on a form and close the form, collapsible panels state will be saved.

Instructor Preparation: 

In preparation for this lab exercise identify a GUI window for which collapsible panel state will be changed.

Ensure each student is logged in using an unique SAM user, as preferences for collapsible panels will be saved on 

a per user basis.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to perform a search on a list 

form using the column headings:

The following lines and the images above summarize the steps recommended to expand all panels in the 5620 

SAM License Information form.

1. Open a 5620 SAM form. 

For this lab exercise example to open the 5620 SAM License information form used in the previous lab 

exercise, or a form for which different panels states (some collapsed and some expanded) has been previously 

saved.

Right-click on a tab name and choose the Expand All Panels function. All panels in the form are expanded.

Note

In order for the Expand All Panels fuction to be available, at least one panel on the form must be 

collapsed.



5620 SAM � R12.0 Fundamentals
System Overview � SAM GUI Client Windows and Forms Components and Management Lab

2 � 4 � 21
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

4 Manage Tabs on 5620 SAM Forms 
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4 Manage Tabs on 5620 SAM Forms 

4.1 Tabs on 5620 SAM Forms Overview

Available actions and 
parameters organized in tabs

Tabs displayed using the Show All Tabs button are hidden again when form reopens

Show all tabs Tabs selector

Displayed 
by default in 
most forms

+
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In properties forms, configuration forms and other windows and forms in the SAM GUI, all possible actions and 

parameters available using the form are organized in different tabs. As a result, some forms may contain multiple 

tabs depending on the complexity of the object the form represents. 

In most multiple tab forms, the General tab is displayed by default.

In order to simplify the 5620 SAM GUI view, some forms open by default with hidden tabs. Operators can display 

selected hidden tabs or all tabs while the form is open by clicking on the tab selector or the Show All Tabs 
button.

To temporarily display all hidden tabs, click on the Show All Tabs button on the right side of the form. The form 

displays all available tabs. In this case, as well as in cases where there are no available tabs hidden in the form, 

the Show All Tabs button is disabled.

Note
Tabs that are displayed this way are hidden again when the form is closed and reopened.
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4 Manage Tabs on 5620 SAM Forms 

4.2 Custom Tab Display

Tab selector

Move to 
Hidden Tabs

Move to 
Displayed Tabs

Move up or down Save Tab Settings

+
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Using the Tab selector button, operators can customize the display of tabs on configuration forms, and save the 

tab display preferences. 

Each 5620 SAM operator can display, hide, or arrange the sequence of tabs on a configuration form to customize 

which tabs are visible for a specific object type according to their operational requirements. 

Custom settings for tabs on configuration forms are saved as user preferences. These preferences are not 

affected by a change of workspaces.

Note
A system administrator can configure the default behavior for custom tab configuration from 

the System Preferences form. See the 5620 SAM System Administrator Guide for more details.
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SAM GUI Client Windows and Forms Components and Management Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Perform a search on a 5620 SAM list form using column headings

� Save filters for future use on a list form

� Find attributes in a configuration form
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Module objectives [cont.]
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1 Finding Information in Windows and Forms Labs
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1 Finding Information in Windows and Forms Labs

1.1 Perform a List Search Using Column Headings

� Choose Help → 5620 SAM License Information

� Use the filter 
area of any 
column heading 
to configure the 
filter criteria

� Click on the Devices and Quantities Licensed tab button

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 2.5 Edition 1
Section 2 � Module 5 � Page 8

Lab Exercise Objective:

In order for students to become familiar with the procedure to search for data on 5620 SAM list forms, 

instructions in this lab exercise will guide students to perform a search on a 5620 SAM list form using column 

headings.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to perform a search on a list 

form using the column headings:

Technical Reference 

For more information on the steps to view the 5620 SAM License Information see Alcatel-Lucent 
5620 SAM 10.0 R5 User Guide – 3.8 5620 SAM GUI search procedures – Procedure 3.30 To 
perform a simple search using column headings.

The following lines and the images above summarize the steps recommended to perform a search for 7705, 7750 

and 7710 licensed devices data from the 5620 SAM License Information.

1. Choose Help → 5620 SAM License Information form the 5620 SAM main menu. The 5620 SAM License (Edit)
form opens with the General tab displayed.

2. Click on the Devices and Quantities Licensed tab button.

3. Configure the filter criteria using the filter area of any column heading. If required, specify an operation from 

an operation drop-down menu.
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1 Finding Information in Windows and Forms Labs

1.1 Perform a List Search Using Column Headings [cont.]

� Click on the 
Search button
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Notes for the use of search operators

•Entering a value into a filter area of a column heading without specifying an operation from an 

operation drop-down menu causes a default operation to be automatically selected.

•Selecting NONE in an operation drop-down menu clears the filter area of the associated column 

heading. 

•Clicking on the Toggle Quick Filter button toggles the visibility of the filter areas on or off. 

•The filter areas of the column headings are disabled if a filter was applied using the filter 

window, if the filter window is open, or if a saved filter was loaded using the saved filter drop-

down list.

4. Click on the Search button. The results list is displayed based on the filter.

5. To refresh the search results using the currently defined filter, click on the Search button. If applied, the 

current filter is used even when the filter areas are hidden or closed.

6. Close the List Form.
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1 Finding Information in Windows and Forms Labs

1.2 Save Filters for Future Use on a List Form

� Click on the 
filter button

� Click on the 
Save button

� Configure the 
parameters � Click on the 

Save button
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Lab Exercise Objective:

In order to save a filter criteria for future use on a list form, over the course of this lab exercise students will 

save a list form filter.

Instructor Preparation: 

In preparation for this lab exercise identify a list form for which a filter will be saved, and the filter criteria to be 

used.

Instructions:

The following lines and the images above summarize the steps recommended to save a filter for future use on a 

list form.

1. Click on the filter button : the edit filter form opens. Define the filer properties as described in the 

procedure (previous page) 

2. Click on the Save... button. The Save Filter form opens.

3. Configure the parameters: 

� Filter Name

� Description

� Public, enabling the Public parameter makes the saved filter visible to all users accessing the list on the SAM 

server 
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1 Finding Information in Windows and Forms Labs

1.2 Save Filters for Future Use on a List Form [cont.]

Switch to notes view!
4. Click on the Save button. The Save Filter form closes. The defined filter is saved for a future 

search on a similar object type and the configured parameters are populated in the filter 

window. 

5. Click on the Apply button or the OK button to use the filter. The results list is displayed based on 

the filter.

6. If the filter window is open, click on the Close button. The filter window closes.

Close the List Form.
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1 Finding Information in Windows and Forms Labs

1.3 Locating Attributes on Configuration Forms

� Select a port in the list and 
right click to open the 
contextual menu

� Choose 
properties in 
the list 

Find attribute function helps locating specific attributes on a configuration 
form

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 2.5 Edition 1
Section 2 � Module 5 � Page 12

Lab Exercise Objective:

In order to identify the location of an attribute within a configuration form, instructions in this lab exercise will 

guide students to use the Find button located in the bottom right of a configuration form to open the tab 

where the attribute resides appears and highlight the attribute name. 

Instructor Preparation: 

Provide students with instructions on a configuration form in which an attribute should be found in this lab.

Instructions:

Follow your instructor’s directions to find an attribute on a configuration form.

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to find the MTU attribute in a Physical Port properties form for this lab exercise.

1. Select a port from Equipment view in the navigation tree. Right-click to open the port’s contextual menu.

2. Choose Properties from the port’s contextual menu. The Physical Port properties form opens with the 

General tab displayed.



5620 SAM � R12.0 Fundamentals
System Overview � Finding Information in SAM GUI Client Lab

2 � 5 � 13
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

1 Finding Information in Windows and Forms Labs

1.3 Locating Attributes on Configuration Forms [cont.]

� Click on the Find button

� Configure the filter 
criteria and click on 
the Search button
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3. Click on the Find button located in the bottom right of the configuration form, or press CTRL+F. The Find 

Attribute in list form opens and displays the attributes on the configuration form.

4. Configure the filter criteria and click on the Search button. A list of attributes is displayed.

For this lab exercise example, enter “MTU” on the Attribute Title column filter, and click on the Search
button
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1 Finding Information in Windows and Forms Labs

1.3 Locating Attributes on Configuration Forms [cont.]

� Choose an attribute and click 
on the Show on Form button

� The parameter in the 
corresponding tab is highlighted
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5. Choose an attribute from the list and click on the Show on Form button.

Alternatively, double-click on the attribute row, or select an entry in the list and press Enter.

6. On the configuration form, the selected name of the tab, panel, or field is highlighted and the associated tab 

is displayed.
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Module objectives

Upon completion of this lab module, you should be able to:

� Customize the menus, toolbars, tree labels, topology icon labels and window 
layout selections on the 5620 SAM GUI by creating and customizing workspaces

� Allow the selection of a preconfigured workspace by adding a workspace to 
the workspace selector and changing the current workspace

� Set the workspace that appears by default each time the 5620 SAM client 
opens
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1 Create and Customize a Workspace
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1.1 Create a Workspace

Application→Manage Workspaces 1

+

2
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Lab Exercise Objective:

In order to customize menus, toolbars, tree labels, topology icon labels, list and window layout selections on the 5620 SAM 

GUI, over the course of this lab exercise students will create a SAM GUI Workspace.

Note

The creation of Public SAM GUI Workspaces is not typically a SAM Operator task, but rather a SAM System 

Administrator task. However, all SAM users have the ability to create, edit, and delete private  workspaces. 

Therefore this lab exercise has been included in this SAM Fundamentals course to provide a broader picture 

of the workspace customization capabilities through the creation of a customized workspace for this 

training. In addition with the required scope of command users can create public workspaces. 

Should workspaces have been pre-provisioned in advance for this course, you instructor may demo the 

process and/or ask you to skip this lab exercise. 

Instructor preparation: 

Provide each student with instructions for the menu bar, toolbar, tree labels, topology icon labels and window layout 

preferences that will be customized on the workspace created for this lab exercise.

Instructions:

Follow your instructor’s directions to create a workspace. The following lines and the figures above summarize the steps 

recommended to create a workspace for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 SAM, 
Release 12.0 User Guide – 5620 SAM GUI workspace customization procedures.

1. Choose Application→Manage Workspaces from the 5620 SAM main menu. The Manage Workspaces form opens.

2. Click on the Create button to create a workspace. The Workspace (New Instance) (Create) form opens with the Menus
tab displayed.
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1.1 Create a Workspace

Application→Manage Workspaces 1

2

+
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Lab Exercise Objective:

In order to customize menus, toolbars, tree labels, topology icon labels, list and window layout selections on the 5620 SAM 

GUI, over the course of this lab exercise students will create a SAM GUI Workspace.

Note

The creation of Public SAM GUI Workspaces is not typically a SAM Operator task, but rather a SAM System 

Administrator task. However, all SAM users have the ability to create, edit, and delete private  workspaces. 

Therefore this lab exercise has been included in this SAM Fundamentals course to provide a broader picture 

of the workspace customization capabilities through the creation of a customized workspace for this 

training. In addition with the required scope of command users can create public workspaces. 

Should workspaces have been pre-provisioned in advance for this course, you instructor may demo the 

process and/or ask you to skip this lab exercise. 

Instructor preparation: 

Provide each student with instructions for the menu bar, toolbar, tree labels, topology icon labels and window layout 

preferences that will be customized on the workspace created for this lab exercise.

Instructions:

Follow your instructor’s directions to create a workspace. The following lines and the figures above summarize the steps 

recommended to create a workspace for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 SAM, 
Release 12.0 User Guide – 5620 SAM GUI workspace customization procedures.

1. Choose Application→Manage Workspaces from the 5620 SAM main menu. The Manage Workspaces form opens.

2. Click on the Create button to create a workspace. The Workspace (New Instance) (Create) form opens with the Menus
tab displayed.
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1.1 Create a Workspace [Cont.]

3
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3. Following your instructor’s directions configure the parameters:

� Name specifies a user defined name for the workspace with a range of 1 to 80 characters.

� Description specifies the description of the customized workspace with a range of 1 to 80 characters.

� Scope indicates the ownership of the customized form. The options are:

� Private

� Public

The private workspace is visible only to users that have created the workspace.

Note

Based on the SAM user’s assigned scope of command role and permissions, an operator can 

configure the Scope. Otherwise, Private will be set by default and cannot be modified.
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1.1 Create a Workspace [Cont.] +

5

4
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4. Click on the Menus, Toolbar, Tree, Topology, and/or Window Layout, to customize the workspace that is 

being created. 

5. Follow your instructor’s directions to customize the parameters specific to the selected tab.

Technical Reference 

For more information on the steps to customize the menu bar, toolbar, tree labels, topology 

icon labels, and window layout, of a workspace see Alcatel-Lucent 5620 SAM, Release 11.0 R3 
User Guide – Section 3.8 5620 SAM GUI workspace customization procedures

For this lab exercise example, the images above and the following step describe the customization of the 

Menu for the creation of a customized workspace. The All Menu Items panel displays the default menu items 

and the Custom Menu panel displays the selected menu items. Follow your instructor’s directions to 

customize the Menu for the workspace that is being created, perform one of the following actions:

a. To remove a menu or menu item from the workspace, select a menu or menu item on the Custom Menu 
panel and right-click on a and choose an Delete from the contextual menu.

b. To add a menu or menu item to the workspace:

i. Drag and drop the menu or menu item from the All Menu Items panel into the Custom Menu 

panel, or

ii. Select a menu or menu item on the All Menu Items panel and press CTRL+C, or right-click and 

choose an Copy from the contextual menu. Select the location where the menu or menu item will 

be added on the Custom Menu panel and press CRTL+V, or right-click and choose an Paste from 

the contextual menu. (Note that menu items can only be pasted in an existing menu, and not as 

menus itself)

c. To rename a menu or menu item in the workspace, in the Custom Menu panel right-click on a menu or 

menu item and choose Rename from the contextual. Type a name for the menu or menu item and press 

Enter.
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1.1 Create a Workspace [Cont.]

Legend indicating the 
usage of menu items

6
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d. To add a menu to the workspace, in the Custom Menu panel, if required, expand the menus up to the 
menu or menu item where the menu will be added. Right-click on the empty space or on the menu or 
menu item and choose Add Menu. The menu is added under the selected menu item or as the last 
element inside the selected menu. Type a name for the menu and press Enter.

e. To customize a mnemonic for the workspace, in the Custom Menu panel right-click on the menu or 
menu item in the Custom Menu panel and select Edit Mnemonic.

Note 1

The Legend at the bottom of the Menus tab indicates the usage of menu items from the All Menu 
Items panel in the Custom Menu panel, as shown in the image above.

Note 2

When customizing the Menu of a workspace, the following items must be included in the menu 
bar:

� Application→User Preferences

� Application→Manage Workspaces

If any of these menu items were deleted from the Menu, an error message will appear when 
trying to save the changes indicating the missing menu item. Changes to the workspace will not 
be saved until the identified missing mandatory menu item or items are added to the Custom 
Menu panel.

6. Follow your instructor’s directions to customize other elements (such as toolbars, tree labels, topology icon 
labels and window layout selections) for this lab.
Click on the OK or Apply button. A dialog box appears. Click on the Yes button to save the changes and close 
the dialog box. The Workspace (New Instance) (Create) form closes. 

7. Click on the Search button on the Manage Workspaces form to refresh the workspaces list. Confirm the 
newly created workspace appears on the list.
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1.2 Customize a Workspace

Application→Manage Workspaces 1

2
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Lab Exercise Objective:

In order to modify the customization of menus, toolbars, tree labels, topology icon labels and window layout 
selections on the 5620 SAM GUI, over the course of this lab exercise students will customize a SAM GUI 
Workspace.

Note

The SAM GUI Workspace customization is not typically a SAM Operator task, but rather a SAM 
System Administrator task. This lab exercise has been included in this SAM Fundamentals course 
to provide a broader picture of the workspace customization capabilities through the 
customization of an existing workspace for this training. Should workspaces have been pre-
provisioned in advance for this course, you instructor may demo the process and/or ask you to 
skip this lab exercise. 

Instructor preparation: 

Provide each student with instructions for the modifications to the customized menu bar, toolbar, tree labels, 
topology icon labels and window layout preferences that will be applied to an existing workspace.

Instructions:

Follow your instructor’s directions to customize a workspace. The following lines and the figures above 
summarize the steps recommended to customize the window layout of a simple workspace for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI workspace customization 
procedures.

1. Choose Application→Manage Workspaces from the 5620 SAM main menu. The Manage Workspaces form 
opens. 

2. Click on the Search button to update the workspace list.
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3

4

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 2.6 Edition 2
Section 2 � Module 6 � Page 14

3. Select a workspace from the list, and click on the Properties button. The Workspace (Name) [Edit] form 

opens with the Menus tab displayed.

4. Click on the Menus, Toolbar, Tree, Topology, and/or Window Layout, to customize the workspace.

Technical Reference 

For more information on the steps to customize the menu bar, toolbar, tree labels, topology 

icon labels, and window layout, of a workspace see Alcatel-Lucent 5620 SAM, Release 11.0 R3 
User Guide – Section 3.8 5620 SAM GUI workspace customization procedures
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1.2 Customize a Workspace [Cont.] +
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5. Follow your instructor’s directions to customize the parameters specific to the selected tab. 

For this lab exercise example, the images above and the following steps describe the customization of the 

window layout of an existing workspace. 

a. Click on the Window Layout tab.

b. Follow your instructor’s directions to modify the size and location of the Tree, Map, and Alarm window in 

the GUI Client.

c. Set the Window Layout to Set to Current (Custom) in order for all the currently opened Tree, Map, 

Alarm window in the main GUI client will open at their current size and location

Note

By setting the Window Layout to Set to Default (Default), the Tree, Map, Alarm window in the 

main GUI client will open at the default size and location.

6. Click on the OK button. A dialog box appears.

Click on the Yes button to save the changes and close the dialog box. The Workspace (Name) [Edit] form 

closes.

7. Close the Manage Workspaces form.
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2 Change the Current Workspace
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2.1 Add Workspace to Workspace Selector

Application→User Preferences 1

2

+

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 2.6 Edition 2
Section 2 � Module 6 � Page 17

Lab Exercise Objective:

In order to allow users the selection of a preconfigured workspace to change the current workspace, over the 
course of this lab exercise students will add a workspace to the workspace selector.

Instructor preparation: 

In preparation for this lab, ensure at least one customized workspace has been configured and is available for all 
SAM users (configured as public).

It is recommended that individual SAM users have been created for each student, as there is a limitation of 
maximum eight workspaces that can be added to the workspace selector per user. For the execution of this 
lab exercise the instructor may ask each student to log in using their own SAM user.

In order to allow the successful addition of workspaces in this lab, ensure the parameter Allow Mandatory 
Workspaces Only is disabled in the user group‘s preferences to which the SAM user belongs to.

Provide each student with instructions on the workspace to be added to the workspace selector for the user 
currently logged in for this lab exercise. 

Instructions:

Follow your instructor’s directions to add a workspace to the workspace selector. The following lines and the 
figures above summarize the steps recommended to add a public workspace to the workspace selector for this 
lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 12.0 User Guide –5620 SAM GUI workspace customization procedures.

1. Choose Application→User Preferences from the 5620 SAM main menu. The User Preferences form opens 
with the General tab displayed.

2. Click on the Workspaces tab.
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2.1 Add Workspace to Workspace Selector [Cont.]
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3. Click on the Add button. The Add Workspace - User Preference form opens.

Note

The Add button is disabled and the user cannot change the list of workspaces on their User 
Preferences form if the Allow Mandatory Workspaces Only is enabled (check box selected) 

during user group configuration for the group the user currently logged in belongs to.

Note 2

Up to a maximum of eight workspaces can be added.

4. Choose a workspace from the list. Click on the OK button. The Add Workspace form closes and the 

workspace is displayed in the list in the Workspaces tab of the User Preferences form.

5. To change the sequence of the workspaces that appear in the workspace drop-down selector, select a 

workspace and click on the Move Up or Move Down buttons.

6. Click on the OK button. A dialog box appears. Click on the Yes button to save the changes and close the 

dialog box. The User Preferences form closes. 

7. Verify that the newly added workspace is displayed in the workspace selector drop-down in the top right 

corner of the menu bar.
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Lab Exercise Objective:

In order to display a customized view of menus, toolbars, tree labels, topology icon labels and window layout 

selections on the 5620 SAM GUI, over the course of this lab exercise students will change the current 

workspace.

Instructor preparation: 

In preparation for this lab, ensure the workspace to be applied has been added to the workspace selector.

Provide each student with instructions on the workspace to be applied for the user currently logged in for this lab 

exercise. 

Instructions:

Follow your instructor’s directions to change the current workspace. The following lines and the figures above 

summarize the steps recommended for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI workspace customization 
procedures. Procedure 3-33 To change the current workspace

1. Click on the workspace selector drop-down on the top right corner of the menu bar.

2. Choose a workspace.
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Upon choosing a workspace from the workspace selector, the 5620 SAM redraws the menu bar, toolbar, closes all 

alarm, tree, map windows and opens the alarm, tree, and map windows from the new workspace layout. 

The workspace selector displays the workspace currently in use.

Note

If the workspace selector displays .Workspace Out of Sync. this indicates that the current 

workspace has been modified or deleted.
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Lab Exercise Objective:

In order to set the customized view of menus, toolbars, tree labels, topology icon labels and window layout 

selections on the 5620 SAM GUI that appears by default each time the 5620 SAM client opens, over the course 

of this lab exercise students will set the default workspace.

Instructor preparation: 

In preparation for this lab, ensure that the workspace to be set as default has been added to the workspace 

selector.

Provide each student with instructions on the workspace to be set as default for the user currently logged in for 

this lab exercise. 

Instructions:

Follow your instructor’s directions to set the default workspace. The following lines and the figures above 

summarize the steps recommended for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI workspace customization 
procedures.

1. Choose Application→User Preferences from the 5620 SAM main menu. The User Preferences form opens 

with the General tab displayed.

2. Click on the Workspaces tab.
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3. Choose the workspace in the list, and Click on the Set as Default button.

Verify that the check mark in the Default column in the list is now on the workspace set as default.

4. Click on the OK button. A dialog box appears. Click on the Yes button to save the changes and close the 

dialog box. The User Preferences form closes. 
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Module summary

This lab module presented exercises to:

� Create and customize workspaces to customize the menus, toolbars, tree 
labels, topology icon labels and window layout selections on the 5620 SAM GUI 

� Add a workspace to the workspace selector and to change the current 
workspace allowing the selection of a preconfigured workspace 

� Set the workspace that appears by default each time the 5620 SAM client 
opens
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SAM GUI Client Workspaces Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Provide the basic configuration to the lab’s network SR-OS based devices to 
enable the 5620 SAM to discover and manage them
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1 Network Element Discovery Labs

1.1 Convention Format for CLI Commands

Switch to notes view!
Note 
The following information explains the convention format for CLI commands used 

in this Job Aid and is for information purposes only. Actual Job Aid instructions 

begin on the next page.

The CLI system prompt is shown in bolded text followed by # or $:

NODE_X#

or NODE_X>config>system>security#

or NODE_XXXX>config>system>security>mgt-access-filter>entry$

The CLI command string is shown in unbolded text.

NODE_X# show time ↵

The ↵ symbol indicates that the Enter key should be pressed.

As shown above, system commands such configure, show, security, etc. are shown as unbolded. 
These commands can be typed in or partially typed in and completed by pressing the Tab key. Text 
that must be manually entered is shown delimited by the < and > symbols.

NODE_X# admin set-time <YYYY/MM/DD hh:mm> ↵
This example indicates that the year, month, day, and time must be entered manually.
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1 Network Element Discovery Labs

1.2 Basic Network Device Configuration Lab

Switch to notes view!
Lab Exercise Objective:

In order for the 5620 SAM to discover and manage the lab’s network devices, over the course of this lab exercise 
students will perform the following actions to provide devices with the basic configuration or verify the 
equipments configuration:

� Configure the network device’s boot parameters including:

� Verify, and if required re-configure, the Internet address of the Ethernet interface

� Set persistence on

� Define a location for the primary configuration file

� Configure the network device’s ID (system address)

� Configure and enable the SNMP protocol parameters (community string and packet size)

Instructor Preparation: 

Provide students with information to initiate a CLI session with network element and information about the IP 
address and SNMP information required for the 5620 SAM to discover it.

Instructions:

Initiate a CLI session with the appropriate network element device. 

Technical Reference 

For more information about the steps to commission these equipments see Alcatel-Lucent 
5620 SAM, Release 11.0  User Guide – Section 13.4 Alcatel-Lucent and Telco device 
commissioning procedures - Procedure 13-1 To commission a 7210 SAS-E, 7210 SAS-
M24F, 7210 SAS-M24F2XFP, 7210 SAS-M24F2XFP [ETR], 7210 SAS-X24F2XFP, 7450 
ESS, 7705 SAR, 7710 SR, or 7750 SR for 5620 SAM management.
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The following lines summarize the steps recommended to perform the basic network device configuration to a 
7210, 7450, 7705, 7710 or 7750 for 5620 SAM management using SNMPv2 for this lab. 

Follow your instructor‘s directions or see the appropriate device documentation for other equipments 
commissioning.

1. Use the table below to register the router’s basic boot and SNMP parameters provided by your instructor: 

Lab’s router Basic Boot Parameters
Ethernet Interface IP Address / Network Mask:
System IP Address / Network Mask:
SNMP Community string:

2. Verify the current configured boot parameters on the bof file:

NODE_X# bof ↵
NODE_X>bof# show bof ↵

If the Internet address of the Ethernet interface is not configured or does not match the address provided by 
your instructor enter the following command:

NODE_X>bof# address <IP address/subnet> ↵

3. Set persistence on

NODE_X>bof# persist on ↵

Lab’s router Basic Boot Parameters

Ethernet Interface IP Address / Network Mask:

System IP Address / Network Mask:

SNMP Community string:
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1 Network Element Discovery Labs

1.2 Basic Network Device Configuration Lab [cont.]

Switch to notes view!4. Define a location to save the configuration file  

NODE_X>bof# primary-config <file location:/file path/filename.cfg> ↵

5. Save the boot parameters changes

NODE_X>bof# save ↵
NODE_X>bof# exit all ↵

6. Define the router’s ID (System Address)

NODE_X# configure router interface system address <IP address/32> ↵

7. Configure SNMP Security

NODE_X# configure system security snmp ↵
NODE_X>config>system>security>snmp# community <community string> rwa version both ↵
NODE_X>config>system>security>snmp# exit all ↵

8. Enable SNMP

NODE_X# configure system snmp ↵
NODE_X>config>system>snmp# packet-size 9216 ↵
NODE_X>config>system>snmp# no shutdown ↵
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NODE_X>config>system>snmp# no shutdown ↵
NODE_X>config>system>snmp# exit all ↵

9. Confirm changes

NODE_X# show bof ↵
NODE_X# show router interface ↵
NODE_X# configure system security snmp ↵
NODE_X>config>system>security>snmp# info ↵
NODE_X>config>system>security>snmp# exit all ↵
NODE_X# show system security communities ↵
NODE_X# configure system snmp ↵
NODE_X>config>system>snmp# info ↵
NODE_X>config>system>snmp# exit all ↵

10. Save the network device’s configuration

NODE_X# admin save ↵
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Node Preparation for SAM Discovery Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Configure a Mediation Policy to discover network devices

� Create a Discovery Rule to discover network devices on 5620 SAM

� Verify that network devices are discovered and are managed by the 5620 SAM

� Perform manual reconciliation of network devices
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1 Network Element Discovery Labs
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1 Network Element Discovery Labs

1.1 Mediation Policy Configuration

� Choose Administration → Mediation

� Configure the parameters:
• Polling Synchronization Time
• Polling Admin State
• Discovery Rule Scan Interval 
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Lab Exercise Objective:

In order to define the interval and ratio used by 5620 SAM to poll the network devices for SNMP MIB configuration 

changes, and the access security parameters for the 5620 SAM to discover and manage network devices, 

instructions in this lab exercise will guide students to configure a mediation policy 

Instructor Preparation: 

Provide students with NE access information for CLI and file transfer (FTP or SSH) user names and passwords, and 

SNMP configuration.

If required, provide students with instructions on any MIB entry policies that should be enabled and the polling 

interval for each MIB entry policy. 

Instructions:

Follow the appropriate procedure's instructions to configure a mediation policy

Technical Reference

For more information on the steps to configure a mediation policy see Alcatel-Lucent 5620 
SAM, Release 12.0 R3 User Guide – Section 14.8 Device discovery procedures –
Procedure 14-4 To configure NE mediation.

The following lines and the figures above summarize the steps recommended to configure a Mediation Policy 
(using SNMPv2) for this lab:

1.Choose Administration ���� Mediation from the main menu. The Mediation (Edit) form opens with the General
tab displayed.
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1 Network Element Discovery Labs

1.1 Mediation Policy Configuration [cont.]

Switch to notes view!
2. Configure as required the parameters:

� Polling Synchronization Time is the reference time for all polling intervals, which are 

typically defined in a given policy.

� Polling Admin State (Up or Down)

� Discovery Rule Scan Interval specifies how often 5620 SAM database rescans the network 

according to discovery rules that are enabled.
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1 Network Element Discovery Labs

1.1 Mediation Policy Configuration [cont.]

� Click on the Mediation Security tab 
button
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3. Click on the Mediation Security tab button.

i. Click on the Add button to create a new SNMP mediation security policy, or select an existing policy and 

click on the Properties button to modify the policy. The Mediation Policy form opens.

ii. Configure the Display Name and the Security Model from the general mediation parameters. 

For this job aid example, select SNMPv2c from the Security Model drop-down list.

iii. In the SNMP v1/v2c panel, configure the Community String parameter. The Community String value must 

match the SNMP community string value on the managed device, as configured on the Basic Network Device 

Configuration job aid.

iv. Configure the parameters in the CLI and File Transfer panels. Set the User Name and User Password as 

required. Ensure that the user and password are already configured on the network devices to which this 

mediation security policy will be associated. Register the values on the table bellow.

Lab’s Network Device CLI Parameters

User Name:

User Password:

Lab’s Network Device File Transfer Parameters

User Name:

User Password:
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1 Network Element Discovery Labs

1.1 Mediation Policy Configuration [cont.]

� Click on the MIB Entry Policies tab to configure 
MIB polling intervals for network devices
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4. If required, click on the MIB Entry Policies tab to configure MIB polling intervals for specific network devices. 

i. The MIB Entry Policies tab window displays a list of MIBs organized by the product name of the device that 

supports the MIB.

ii. Configure the search filter to look for the NE specific MIBS and click on the Search button. The Mediation 
(Edit) form displays the MIB entry policies for the NE.

iii. Select one or more MIBs from the list.

iv. Click on the Properties button. The MIB Entry Policy (Edit) form opens.

v. Configure the parameters:

● Polling Interval specifies how often MIB elements of discovered and managed devices are polled for 

changes to their MIBs. When changes are detected, the 5620 SAM rereads the MIB element and updates 

the database. The default is 15 minutes. When this parameter is disabled, synchronization between 

network elements and the database do not occur.

● Administrative State (Up or Down)

vi. Click on the OK button.

vii. Confirm the action. The MIB Entry Policy (Edit) form closes and the Mediation (Edit) form reappears.

viii.Click on the Apply button on the Mediation (Edit) form to save the changes, if required.
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1 Network Element Discovery Labs

1.1 Mediation Policy Configuration [cont.]

Switch to notes view!5. Click on the OK button. A dialog box appears.

6. Click on the OK button. The Mediation Security form closes and the Mediation (Edit) form reappears.

7. Close the Mediation (Edit) form.
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1 Network Element Discovery Labs

1.2 Discovery Rule Configuration

Switch to notes view!Lab Exercise Objective:

In order for the 5620 SAM to discover and manage network devices, instructions in this lab exercise will guide 

students to  perform the following actions for specifying the way devices are scanned and verifying 5620 SAM 

has discovered and is managing the devices:

� Create a discovery rule to discover network devices

� Discover Network Elements

� Verify the network devices are discovered and managed by the 5620 SAM

Instructor Preparation: 

Provide students with information about the IP address, addresses or IP address ranges to scan the network for 

devices according to the created discovery rule

Instructions:

Follow your instructor’s directions to create a discovery rule to discover network device(s). 

Technical Reference 

For more information on the steps to create discovery rules see Alcatel-Lucent 5620 SAM, 
Release 12.0 R3 User Guide - Section 14.8 Device discovery procedures – Procedure 14-5 To 
discover devices.

The following lines summarize the steps recommended to create a discovery rule for this lab:

1. Choose Administration ���� Discovery Manager from the 5620 SAM main menu. The Discovery Manager (Edit)
form opens with the Discovery Rules tab displayed.
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form opens with the Discovery Rules tab displayed.

i. Click on the Add button. The Create Discovery Rule - Specify General Attributes form opens.

ii. Specify a Description for the discovery rule that is up to 80 characters. Specify the Administrative State. 

When the administrative state is set to Up, the network is scanned according to the discovery rule when the 

discovery rule is saved. The network is also scanned according to the discovery rule as specified by the 

Discovery Rule Scan Interval parameter in the Mediation window. If the administrative state is set to Down, 

the network is not scanned as specified by these conditions.

iii. Click on the Next button. The Add Rule Elements form opens.

iv. Click on the Add button. The TopologyDiscoveryRuleElement (Create) form opens.

v. Configure the network device’s parameters IP Address and Mask Bits. Enter the parameters previously used 

to configure the network device during the Basic Network Device Configuration Lab.

vi. Click on the OK button. The TopologyDiscoveryRuleElement (Create) form closes. The discovery rule is 

saved.

vii. Add more rule elements as required by performing substeps iv to vi.

viii.Click on the Next button. The Configure Mediation Security form opens.

ix. Specify the mediation policies for Read Access, Write Access, and SNMP Trap Access. Click on the Select
button and choose the mediation policy created on the Network Device Discovery – Configure Mediation 

Policy Lab.

x. Click on the Finish button to complete creation of the Discovery Rule using default values. The Create 
Discovery Rule – Configure Mediation Security form closes and a warning dialog box opens.

xi. Click on the OK button on the warning dialog box to close it. The Discovery Manager form reappears.
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1 Network Element Discovery Labs

1.2 Discovery Rule Configuration [cont.]

Switch to notes view!2. Click on the Apply button on the Discovery Manager form to discover the network devices by scanning the 

network as specified on the created discovery rule. 

The 5620 SAM discovers devices by scanning the network as specified by the discovery rules. After a device is 

discovered, the 5620 SAM sets the device in a managed state and reconciles the device elements into its 

database. 

Discovery rules that are disabled or shut down are not applied.
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1 Network Element Discovery Labs

1.3  Verify NE Discovery

Switch to notes view!The following lines summarize the steps recommended to verify the specified NEs are discovered and managed by 

the 5620 SAM:

1. Open the Discovery Manager form and click on the Managed State tab button. A list of managed devices 

opens. 

i. Verify the newly discovered network device is on the managed devices list.

ii. Verify the management state of the network device displayed in the Site State column. 

Managed is the default state. If the device is unmanaged, select the device from the list and click on the 

Manage button.

2. Perform a management IP address ping to ensure connectivity to the network managed device. From the 

Managed State tab

i. Click on the managed network device in the list. 

ii. Click on the appropriate ping button. 

iii. Review the ping information to verify connectivity.

3. Verify the network device configuration has been reconciled with the 5620 SAM database by clicking on the 

Resync Status tab button. The status is displayed in the Resync Status column.

4. Close the Discovery Manager form.

5. Move the discovered network device icon into a group on the topology map. All newly discovered network 

devices should be listed in the Discovered NEs group.
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devices should be listed in the Discovered NEs group.

i. Double-click on the Discovered NEs group icon. The Discovered NEs window opens with the list of  

discovered nodes.

ii. Select the discovered network node(s) from the list and drag-and-drop the listing into the appropriate 

group. 

iii. The network node icon will appear in that group.

6. The network devices that have been successfully reconciled appear in the 5620 SAM navigation tree and the 

Equipment Manager form.
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1 Network Element Discovery Labs

1.4 Initiate a Manual Reconciliation 

Switch to notes view!Follow your instructor’s directions, and if required initiate a device’s manual reconciliation. The following lines 

summarize the steps recommended to initiate a manual reconciliation of a network device for this lab:

1. Open the Discovery Manager form and click on the Managed State tab button. A list of managed devices 

opens. 

2. Click on the Resync Status tab button. The status is displayed in the Resync Status column.

3. Follow your instructor’s directions, if a manual reconciliation of the network device is required:

i. Choose the network device or devices from the list 

ii. Click on the Resync button.

4. Close the Discovery Manager form.
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Module objectives

Upon completion of this lab module, you should be able to:

� Find specific objects in the navigation tree

� Simplify the view in densely populated in the navigation trees by making an 
object root in the navigation tree or in a new navigation tree
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1 Equipment Management Labs

1.1 Find an Object in the Navigation Tree

1

3

2
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Lab Exercise Objective:

In order to find specific objects in the navigation tree, instructions in this lab exercise will guide students to 

perform a search using the navigation tree.

Instructor Preparation:

Provide students with instructions on the specific object that should be found using the navigation tree for this 

lab exercise.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to search in the navigation 

tree for objects, such as nodes, shelves, ports and other objects.

Technical Reference 

For more information on the steps to find specific objects in the navigation tree see Alcatel-
Lucent 5620 SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI search procedures 
– Procedure 3-32 To perform a search using the navigation tree.

The following lines and the figures above summarize the steps recommended to find a node performing a search 

by site name:

1. Click on the Find... button on the navigation tree or press CTRL+F. The Find panel opens.

2. Configure the parameters as necessary. The parameters that are available for configuration vary depending on 

the view that has been selected.

3. Click on the Find button or press Enter. The first matching object is selected and expanded in the navigation 

tree.
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1 Equipment Management Labs

1.1 Find an Object in the Navigation Tree [cont.]

Switch to notes view!4. To find additional matching objects, click on the Next button          or press F3. The next matching object is 

selected and expanded in the navigation tree.

5. To return to the previous matching object in the navigation tree, click on the Previous button           or press 

Shift+F3.

6. If required, click on the Clear button to clear all parameters configured in step 2.

7. Click on the Find... button or press CTRL+F to close the Find panel.
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1 Equipment Management Labs

1.1 Find an Object in the Navigation Tree [cont.]

1b
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1b. Alternatively, use the Quick Find field in the Equipment view of the Navigation Tree, configure the 

parameters and press Enter
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1 Equipment Management Labs

1.2 Customizing the Navigation Tree Labels

Application→Manage Workspaces 1

2
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Lab Exercise Objective:

In order to customize the tree labels in the navigation tree, over the course of this lab exercise students will 

create a new SAM GUI Workspace, or modify an existing a SAM GUI Workspace.

Instructor preparation: 

Provide each student with instructions for the modifications to the customized tree labels preferences that will 

be applied to a workspace.

Instructions:

Follow your instructor’s directions to create a new workspace or customize an existing workspace. 

The following lines and the figures above summarize the steps recommended to customize the tree labels of a 

workspace for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI workspace customization 
procedures.

1. Choose Application→Manage Workspaces from the 5620 SAM main menu. The Manage Workspaces form 

opens. 

2. Click on the Search button to update the workspace list.
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1 Equipment Management Labs

1.2 Customizing the Navigation Tree Labels [cont.] +

3

4
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3. Select a workspace from the list, and click on the Properties button. The Workspace (Name) [Edit] form 

opens with the Menus tab displayed.

4. Click on the Tree tab to customize the tree labels of the workspace.

Technical Reference 

For more information on the steps to customize the menu bar, toolbar, tree labels, topology 

icon labels, and window layout, of a workspace see Alcatel-Lucent 5620 SAM, Release 11.0 R3 
User Guide – Section 3.8 5620 SAM GUI workspace customization procedures
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1 Equipment Management Labs

1.2 Customizing the Navigation Tree Labels [cont.]

GUI Workspace 
Customize tree labels

Equipment Groups

Network Elements

Manage Workspaces form’s Tree tab allows restoring label text to default values 
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5. Choose the tree type from the drop-down menu.

6. As shown in the figure above for Equipment Group labels, up to two field texts can be customized. And for 

Network Element labels, up to five field texts (if applicable) can be customized.

Note

Customized labels cannot be specified for the Unmanaged NEs, the Discovered NEs, or the 

Network groups.

7. Click on the OK button. A dialog box appears.

8. Click on the Yes button to save the changes and close the dialog box.

9. Close the Manage Workspaces form. 
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1 Equipment Management Labs

1.3 Make an Object Root in the Navigation Tree 

� Select an object and right-
click to open the contextual 
menu

� Choose Make 
Root In New 
Tree 
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Lab Exercise Objective:

In order to help users simplify the equipment view in densely populated in the navigation trees, instructions in 
this lab exercise will guide students to make an object root in the navigation tree or in a new navigation tree.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to make an object root in the 
navigation tree or in a new navigation tree.

Technical Reference 

For more information on the steps to make an equipment view’s object root in the navigation 

tree, and to restore the default in the navigation tree see Alcatel-Lucent 5620 SAM, Release 
11.0 R3 User Guide – Section 4.2 Basic Navigation tree procedures – Procedure 4-1 To make a 
selected object the root of the navigation tree, Procedure 4-2 To make a selected object the 
root of another navigation tree and Procedure 4-3 To restore the default navigation tree 
root.

The following lines and the figures above summarize the steps recommended to to make a selected object the 
root of another navigation tree:

1. On the Equipment view of the navigation tree, select the object you want to make root and right-click on the 
object to open the contextual menu.

Note 
The Make Root option and the Make Root In New Tree option are only available in the Equipment 
view. See Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide - section 4.1 Navigation tree 
overview for information about the navigation tree objects that support the menu option.
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1 Equipment Management Labs

1.3 Make an Object Root in the Navigation Tree  [cont.]

Switch to notes view!2. Choose Make Root In New Tree from the contextual menu. Another navigation tree window appears with the 

selected object as the root of the tree.

Note 

Up to seven navigation tree windows can be open at the same time and each tree must have a 

different root when it is first created.

To restore the default navigation tree root

When the root is not the network object, the Make Root At Top Level button in the navigation tool’s tool bar is 

enabled.

Click on the Make Root At Top Level button in the navigation tree toolbar to restore the default root of the tree.
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1 Equipment Management Labs

1.4 Compare Equipment Configuration Side by Side

Make Root In New Tree option redefine the root of the tree

Allows comparing 
equipment 

configuration 
side by side

Expand to view 
child objects 
configuration
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The Make Root In New Tree contextual menu option allow operators to redefine the root of the tree. This option 

is available in the Equipment view of the Navigation tree. 

For instance, by making two different NEs root in a new tree operators can compare side by side the equipment 

configuration of the two NEs. Each new tree allows expanding the NEs objects to reveal the child objects 

configuration.

After the comparison, operators may close the new navigation tree windows opened, or use the Make Root At Top 

Level button to restore the navigation tree to the default root, which is the network.
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Equipment Management Lab
End of module
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Module objectives

Upon completion of this module, you should be able to:

� Generate and save an inventory list for a device

� Generate and save an inventory list for the entire network
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1 Inventories for a Device Labs
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1 Inventories for a Device Labs

1.1 Create an Inventory for a Device - Port Types Example

� Choose Manage→Equipment→Equipment 

� Choose Network Element 
(Network) 
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Lab Exercise Objective:

In order to gather inventory data about port types for a managed device using the 5620 SAM client GUI and save 

the data in a file format for further processing on another platform, instructions in this lab exercise will guide 

students to generate and save an inventory list of port types for a managed device.

Instructor Preparation: 

Point out to each student a managed device for which an inventory list of port types will be generated.

Instructions:

Follow the appropriate procedure for detailed instructions on all available options to list and sort inventory data

Technical Reference 

For more information on the steps to perform inventory of port types for management device 

see Alcatel-Lucent 5620 SAM, Release 11.0 User Guide – Section 22.4 Inventory management 
procedures – Procedure 22.1 To list and sort inventory data, Procedure 22-7 To inventory 
port types for a managed device, Procedure 22-2 To save inventory output in HTML format 
and Procedure 22-3 To save inventory output in CSV format.

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to generate an inventory data list for all port types in a managed device and save it to a CSV file for this lab 

exercise:

1. Choose Manage→Equipment→Equipment from the 5620 SAM main menu. The Manage Equipment form 

opens.

2. Choose Network Element (Network) from the object drop-down list.
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1.1 Create an Inventory for a Device - Port Types Example 
[cont.]

� Click on the Search button 

� Choose an NE and click on 
the Properties button
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3. Click on the Search button. The list form displays the results of the inventory search.

4. Choose an NE from the list and click on the Properties button. The Network Element (Edit) form opens.
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1.1 Create an Inventory for a Device - Port Types Example 
[cont.]

� Click on the Inventory tab 

� Choose Port (Physical 
Equipment) 
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5. On the Network Element (Edit) form click on the Inventory tab button

6. Choose Port (Physical Equipment) from the object drop-down list. The list form displays the results of the 

inventory search.
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1 Inventories for a Device Labs

1.2 Save an Inventory for a Device

� Right-click on the list heading and 
choose Save to File 

� Choose a directory, 
create a file name 
and choose a file 
type. Click on the 
Save button
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To save the inventory list of port types for a managed device: 

1. Right-click on the list heading, the contextual inventory menu opens. The Count shows the number of objects 

in the list. Choose Save to File from the contextual inventory menu. The Save form opens.

2. On the Save form, use the Save In parameter to choose a directory in which to save the listed information. 

Use the File Name parameter to assign a file name. Choose a file type to save from the Files of Type drop-

down menu, the options are HTML or CSV.

For this lab exercise example choose HTML.

Click on the Save button. 

The results list of the inventory of port types for a managed device for this lab are saved to the specified 

HTML file.

3. Close the Save form.

4. Close the Equipment Window Filter form. 
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2 Inventories for the Entire Network Labs
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2 Inventories for the Entire Network Labs

2.1 Create an Inventory for the Entire Network 

� Choose Manage→Equipment→Equipment 

� Choose a network object 
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Lab Exercise Objective:

In order to gather an inventory data list about a the entire network using the 5620 SAM client GUI and save the 

list in a file format for further processing on another platform, instructions in this lab exercise will guide 

students to generate and save an inventory list for the entire network.

Instructions:

Follow the appropriate procedure for detailed instructions on all available options to generate and save an 

inventory list for the entire network.

Technical Reference 

For more information on the steps to perform inventory management task on a device see 

Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide – Section 22.4 Inventory management 
procedures – Procedure 22-1 To list and sort inventory data, Procedure 22-2 To save 
inventory output in HTML format and Procedure 22-3 To save inventory output in CSV 
format.

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to generate an inventory data list for all cards (physical element) in the entire network and to save the list to 

a HTML file for this lab exercise:

1. Choose Manage→Equipment→Equipment from the 5620 SAM main menu. The Manage Equipment form opens.

2. Choose a network object from the Object Type drop-down list.

If required configure the filter criteria. You can click on the Search button without creating additional filters.

In order to generate for this lab example an inventory data list for all cards (physical equipment) in the entire 

network, choose Card (Physical Equipment) from the drop-down list.
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2 Inventories for the Entire Network Labs

2.1 Create an Inventory for the Entire Network  [cont.]

� Click on the Search button
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3. Click on the Search button. The list form displays the inventory list for all Cards data in the entire network 

including: site ID and name of the device the card is installed on, card's part number and serial number, slot 

ID and Name, shelf type, number of daughter card slots, number of installed daughter cards, software version.

If required, do one of the following:

a. Sort in ascending or descending order by clicking on a column heading. The arrow direction changes to 

indicate the order in which the data is sorted.

b. Move a column by clicking on the column, dragging the column to the right or left, and dropping the column 

in its new location.

4. Right-click on the list heading, the contextual inventory menu opens. The Count shows the number of 

objects in the list. 

If required, do one of the following:

a. Remove a column by deselecting the column name in the contextual inventory menu. The column 

disappears from the display.

b. Sort multiple columns by choosing Show Sorting from the contextual inventory menu. The Show Sorting
form opens. Choose the property or properties from the Available for Sorting panel and click on the right 

arrow button. The property or properties appear in the Used for Sorting panel. Click on the Sort Ascending
or Sort Descending button, as required. 
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2 Inventories for the Entire Network Labs

2.2 Save an Inventory for the Entire Network

� Right-click on the list heading 
and choose Save to File 

� Choose a directory, 
create a file name 
and choose a file 
type. Click on the 
Save button
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To save the inventory output list to a HTML file:

1. Right-click on the list heading, the contextual inventory menu opens. The Count shows the number of 

objects in the list. Choose Save to File from the contextual inventory menu. The Save form opens.

Alternatively if required, use the contextual inventory menu to do one of the following:

a. Remove a column by deselecting the column name in the contextual inventory menu. The column 

disappears from the display.

b. Sort multiple columns by choosing Show Sorting from the contextual inventory menu. The Show Sorting
form opens. Choose the property or properties from the Available for Sorting panel and click on the right 

arrow button. The property or properties appear in the Used for Sorting panel. Click on the Sort Ascending
or Sort Descending button, as required.

2. To save the inventory output list to a HTML file, choose Save to File from the contextual inventory menu. The 

Save form opens. 

3. On the Save form, use the Save In parameter to choose a directory in which to save the listed information. 

Use the File Name parameter to create a filename. 

Choose CSV Only from the Files of Type drop-down menu.

4. Click on the Save button. The results of the inventory search are saved to the specified HTML file.

5. Close the Save form.

6. Close the Equipment Window Filter form.
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Equipment Inventory Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Create topology groups in order to organize the physical topology map into a 
hierarchical structure

� Populate a topology group

� Select and apply a map background image over which the map objects can be 
overlaid in the topology maps
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Module objectives [cont.]
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1 Topology Map Components Labs
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1 Topology Map Components Labs

1.1 Create Topology Groups

� Choose Create→Equipment→Group

� Configure a Name
and Description

� Click on the 
OK button
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Lab Exercise Objective:

In order to create a hierarchical structure in the physical topology map, instructions in this lab exercise will guide 

students to create a topology group.

Instructions:

Follow the appropriate procedure for detailed instructions on all available options to create topology groups.

Technical Reference 

For more information on the steps to configure create a topology group see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – 5.7 5620 SAM map management procedures – Procedure 5-
29 To create a topology group

The following lines and the figures above summarize the steps recommended to create a topology group in the 

physical topology map: 

1. Open the Group (Create) form by choosing Create→Equipment→Group from the 5620 SAM main menu.

Alternatively you could right-click on the Network icon in the equipment view of the navigation tree and 

choose Equipment→Create Group from the contextual menu.

2. Configure the parameters:

● Name

● Description

3. Click on the OK button to confirm the action.

After the topology group is created, an object for the topology group is displayed in the equipment navigation 

tree, and on the physical topology map.
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1 Topology Map Components Labs

1.1 Create Topology Groups [cont.]

Switch to notes view!Alternatively, if Spans have been configured in the 5620 SAM, you could apply one or more Spans to the group. To 

do this click on the Apply button.

4. Click on the Spans tab button.

5. Click on the Add button. The Select Span(s) - Equipment Group form opens with a list of available spans.

6. Select one or more spans to apply to the topology group.

7. Click on the OK button. The Select Span(s) - Equipment Group form closes and a dialog box appears.

8. Click on the OK button to confirm the action.
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1 Topology Map Components Labs

1.2 Populate a Topology Group

Switch to notes view!To populate a newly created topology group 

Click on a map object in the map panel, for example, a router or router group, and drag the object onto the 

newly created topology group icon in the map or the newly created topology name in the map navigation 

tree. The map object becomes a descendant object of the newly created topology group.

Alternatively, in the map navigation tree select a topology object name and drag the object onto the newly 

created group object in the map navigation tree. The topology group object becomes a descendant object of 

the newly created group object.

Note 
Although there is no limit to the number of topology groups, Alcatel-Lucent recommends a 

maximum of 10 000 topology groups per system for optimal performance. Each topology group 

can contain a maximum of 500 objects
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1 Topology Map Components Labs

1.3 Apply a Map Background Image

5620 SAM provides map background image examples

� Image examples are installed on the SAM server by default under
/5620sam/server/nms/images/map/background

5620 SAM allows you to add your own map image to the directory, ensure 
that: 

� the image file type is GIF

� the size is a maximum of 2000 × 2000 pixels

Map background images available in the server are copied to the client 
during the client installation and/or client upgrade process

� Image examples in the client machine are located by default under
/5620sam/client/nms/images/map/background

Browse this folder to select the map image file name you would like to 
apply as background
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Lab Exercise Objective:

In order to use a map background image over which the map objects can be overlaid in the topology maps, 

instructions in this lab exercise will guide students to select and apply a map background image.

Lab Exercise Preparation: 

In preparation for this lab exercise find the file name for the image you want to use as map background by 

browsing the folder that contains the example images. Typically 

/5620sam/client/nms/images/map/background

Instructions:

Follow the appropriate procedure for detailed instructions on all available options to apply a map background 

image.

Technical Reference 

For more information on the steps to configure create a topology group see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – 5.6 5620 SAM map configuration procedures – Procedure 
5-27 To change the map background image
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1 Topology Map Components Labs

1.3 Apply a Map Background Image [cont.]

� Right-click on an empty 
portion of the map an 
choose Properties

� Configure a Name
and Description
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The following lines and the figures above summarize the steps recommended to apply a map background using 

the Europe map image example provided by the 5620 SAM for this lab exercise: 

1. Open the Group (Edit) form by right clicking on an empty portion of the map to which you want to apply the 

background image and choose Properties from the contextual menu.

Alternatively you could open the Group (Edit) form using one of the following methods:

a. From the map navigation tree, right click on a group name and choose Properties from the contextual 

menu.

b. Right click on a Group icon on the map and choose Properties from the contextual menu.

2. On the Group (Edit) form modify the Background Image parameter to specify a new map image file. 

For this lab exercise example, europe.gif

3. Click on the OK button. A dialog box appears. Click on the Yes button to proceed.
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1 Topology Map Components Labs

1.3 Apply a Map Background Image [cont.]
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The topology map group refreshes displaying the selected example image as map background. The images above 

show the Europe map applied as background for the topology group.
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1 Topology Map Components Labs

1.4 Customizing the Topology Map Icon Labels

Application→Manage Workspaces 1

2
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Lab Exercise Objective:

In order to customize the topology map icon labels, over the course of this lab exercise students will create a 

new SAM GUI Workspace, or modify an existing a SAM GUI Workspace.

Instructor preparation: 

Provide each student with instructions for the modifications to the customized topology map icon labels 

preferences that will be applied to a workspace.

Instructions:

Follow your instructor’s directions to create a new workspace or customize an existing workspace. 

The following lines and the figures above summarize the steps recommended to customize the topology map icon 

labels of a workspace for this lab:

Technical Reference 

For more information on the steps to create and customize a workspace see Alcatel-Lucent 5620 
SAM, Release 11.0 R3 User Guide – Section 3.8 5620 SAM GUI workspace customization 
procedures.

1. Choose Application→Manage Workspaces from the 5620 SAM main menu. The Manage Workspaces form 

opens. 

2. Click on the Search button to update the workspace list.
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1 Topology Map Components Labs

1.4 Customizing the Topology Map Icon Labels [cont.]+

3

4
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3. Select a workspace from the list, and click on the Properties button. The Workspace (Name) [Edit] form 

opens with the Menus tab displayed.

4. Click on the Topology tab to customize the tree labels of the workspace. A list of topology map icons is 

displayed.

Technical Reference 

For more information on the steps to customize the menu bar, toolbar, tree labels, topology 

icon labels, and window layout, of a workspace see Alcatel-Lucent 5620 SAM, Release 11.0 R3 
User Guide – Section 3.8 5620 SAM GUI workspace customization procedures
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1 Topology Map Components Labs

1.4 Customizing the Topology Map Icon Labels [cont.]

Manage Workspaces form’s Topology tab allows restoring icon label to default values 

Customize topology map labels

Icon label customization supported for:

Network Element Service Site
Service 

Access Point
Subscriber 
Interface

CPAM 
Routers

CPAM 
Subnets

CPAM Simulated  
Routers

CPAM Simulated  
Subnets

+
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3. Select a topology map icon. The figure above displays the topology icons for which the label can be 

customized.

4. Customize Text Field #1 and Text Field #2 to identify the information to display in each map icon label.

Note

The available options for label customization vary depending on the object type selected.

5. Click on the OK button. A dialog box appears.

6. Click on the Yes button to save the changes and close the dialog box.

7. Close the Manage Workspaces form.

Note

The Manage Workspaces form’s Topology tab also allows restoring all topology map icon labels to 

the default values by choosing the Default option using the Text Field #1 drop-down menu.
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Topology Map Components and Management Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� configure a network element information (info) table to display in the map 
additional information values for NEs

� enable or disable the display of Info Tables

� enable the display of Info Tables on mouse over

� enable or disable the display Info Tables on selected network elements

� modify an info table configuration to use an existing info table for hiding or 
displaying in the map additional information values

� enable the display of Info Tables for links on mouse over 
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Module objectives [cont.]
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1 Info Tables Configuration Labs
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1 Info Tables Configuration Labs

1.1 Configure Info Tables - Network Element

� Click on the Global Info Tables button

� Select Configure

� Click on the 
Create button
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Lab Exercise Objective:

In order to display in the map additional information values for NEs, instructions in this lab exercise will guide 

students to configure a network element information (info) table.

Instructor Preparation:  

Provide students with instructions on the values for network elements that will be displayed in info tables on the 

map.

Instructions:

The following lines and the figures above summarize the steps recommended to configure an info table for the 

physical topology map for this lab exercise which displays the following  information for NEs: 

� active management IP

� chasis type

� last resync end and start time

� Object Life Cycle (OLC) state 

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Select the Configure menu item. The Physical Topology - Info Table Configurations form opens.

3. Click on the Create button. The Physical Topology - Info Table Configuration form opens.
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1 Info Tables Configuration Labs

1.1 Configure Info Tables - Network Element [cont.]

� Assign a Name and 
select attributes for 
display

� Click on the 
OK button
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4. Assign a name by configuring the Configuration Name parameter. Choose Network Element object type and 

click on the associated check box to select the attribute for display in the information table.

For this lab exercise example select:

� Active Management IP (General)

� Chassis Type

� Last Resync End Time

� Last Resync Start Time

� OLC state

5. Click on the OK button. The Physical Topology - Info Table Configuration form closes, and the new 

configuration is listed on the Physical Topology - Info Table Configurations form.

6. Close the Physical Topology - Info Table Configurations form.

Technical Reference 

For more information on the steps to configure an info table and to apply the info table to NEs 

on the map see Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide – Section 5.6 5620 SAM 
map configuration procedures – Procedure 5.15 To create an information table 
configuration and Procedure 5-16 To enable or disable a global information table.
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1 Info Tables Configuration Labs

1.2 Modify Info Table Configuration – Link

� Select Configure

� Click on the Global Info Tables button

� Select an entry and 
click on the 
Properties button
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Lab Exercise Objective:

In order to use an existing info table for displaying in the map additional information values for links, instructions 

in this lab exercise will guide students to modify the info table configuration adding link information 

attributes.

Instructor Preparation:  

In preparation for this lab exercise identify the values to hide or add to an existing info table.

Instructions:

The following lines and the images above summarize the steps recommended to modify the info table 

configuration for the physical topology map for this lab exercise which displays the following information for 

discovered physical links: 

� endpoint A and B port pointer

� Link discovered from

� Link operational state

� Referenced 

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Select the Configure menu item. The Physical Topology - Info Table Configurations form opens.

3. Choose an entry from the list and click on the Properties button. The Physical Topology - Info Table 
Configuration form opens.

For this lab exercise example, the images above show the steps to modify the info table configured for the 

previous lab exercises.
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1 Info Tables Configuration Labs

1.2 Modify Info Table Configuration – Link [cont.]

� Choose an 
object type 
and select 
attributes 
for display

� Click on the 
OK button
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4. Choose an object type and click on the associated check box to select the attribute for display in the 

information table.

For this lab exercise example choose Discovered Physical Link and select:

� Endpoint A Port Pointer

� Endpoint B Port Pointer

� Link Discovered From

� Link Operational State

� Link Referenced 

5. Click on the OK button. The Physical Topology - Info Table Configuration form closes, and the modified 

configuration is listed on the Physical Topology - Info Table Configurations form.

6. Close the Physical Topology - Info Table Configurations form.

Technical Reference 

For more information on the steps to configure an info table and to apply the info table to links 

on the map see Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide – Section 5.6 5620 SAM 
map configuration procedures – Procedure 5-15 To create an information table 
configuration and Procedure 5-16 To enable or disable a global information table
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2 Display Info Tables Labs
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2 Display Info Tables Labs

2.1 Display Info Tables - Network Element 

� Click on the Global Info Tables button

� Choose info table
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Lab Exercise Objective:

In order to display in the map the configured additional information values for all NEs, instructions in this lab 

exercise will guide students to enable the display of Info Tables for NEs.

Instructions:

The following lines and the figures above summarize the steps recommended to display the previously configured 

info tables on the physical topology map. 

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Select a radio button to apply an existing global information table configuration. 

For this lab exercise example, select the radio button for the previously configured info table.

The map is refreshed displaying info tables with the corresponding information.

Technical Reference 

For more information on the steps to apply the info table to NEs on the map see Alcatel-Lucent 
5620 SAM, Release 11.0 R3 User Guide – Section 5.6 5620 SAM map configuration procedures 
– Procedure 5-16 To enable or disable a global information table
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2 Display Info Tables Labs

2.2 Display Info Tables - Mouse Over Network Element

� Click on the Global Info Tables button

� Choose Mouse

� Place mouse 
pointer over an NE
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Lab Exercise Objective:

In order to display in the map the configured additional information values for a pointed NEs, instructions in this 

lab exercise will guide students to enable the display of Info Tables for NEs on mouse over.

Instructions:

The following lines and the figures above summarize the steps recommended to display an info table when 

placing the mouse pointer over a network element on the physical topology map. 

On a topology map displaying information tables.

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Choose the Mouse checkbox 

The map is refreshed with info tables not displayed in the map.

3. Place the mouse pointer over a network element, the info table for the network element is displayed with the 

corresponding information.

To Disable the Display of Info Tables

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Select the Off radio button to disable global information tables display.
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2 Display Info Tables Labs

2.3 Display Info Tables - Selected Network Element

� Select a network 
element and right-
click

� Choose Selected Info 
Tables – Info Table 
Name 
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Lab Exercise Objective:

In order to display in the map the configured additional information values for a selected NEs, instructions in this 

lab exercise will guide students to enable the display of Info Tables on selected NEs.

Instructions:

The following lines and the figures above summarize the steps recommended to display the info table for a 

selected network element on the physical topology map.

1. Select a network element and right-click to open the contextual menu.

2. Choose the Selected Info Tables – Info Table Name
The map is refreshed with the info table for the selected network element displayed in the map.

To Disable the Display Info Tables on Selected Network Elements

1. Select a network element and right-click to open the contextual menu.

2. Choose the Selected Info Tables – Off
The map is refreshed with the info table not displayed in the map for the selected element.

Technical Reference 

For more information on the steps to apply the info table to selected NEs on the map see 

Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide – Section 5.6 5620 SAM map 
configuration procedures – Procedure 5.17 To enable or disable a selected information table
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2 Display Info Tables Labs

2.4 Display Info Tables – Mouse Over Link 

� Choose info table and Mouse

� Click on the Global Info Tables button
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Lab Exercise Objective:

In order to display in the map the configured additional information values for a pointed links, instructions in this 

lab exercise will guide students to enable the display of Info Tables for links on mouse over.

Instructions:

The following lines and the figures above summarize the steps recommended to enable the display of info table 

when placing the mouse pointer over a link on the physical topology map.

1. Click on the Global Info Tables button. A drop-down menu opens with the information table configurations 

displayed.

2. Select a radio button to apply an existing global information table configuration. 

For this lab exercise example, select the radio button for the info table configuration modified in the previous 

lab exercise.

If the info table is configured for network elements, the map is refreshed displaying info tables with the 

corresponding information for network elements.

Choose the Mouse checkbox. 

The map is refreshed with info tables not displayed in the map.
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2 Display Info Tables Labs

2.4 Display Info Tables – Mouse Over Link  [cont.]

� Expand link 
group

� Place mouse pointer 
over expanded link
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3. Right-click on the plus sign of a link group and choose Expand Group from the contextual menu. 

The map is refreshed with the link group expanded.

As shown in the images above, if a link group contains only one link, when the link group is expanded the link 

line on the map will display thinner with no plus sing in it.

4. Place the mouse pointer over an expanded link group, the info table for the link group is displayed with the 

corresponding information.

Technical Reference 

For more information on the steps to apply the info table to links on the map see Alcatel-Lucent 
5620 SAM, Release 11.0 R3 User Guide – Section 5.6 5620 SAM map configuration procedures 
– Procedure 5-16 To enable or disable a global information table
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Topology Map Info Tables Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� open a flat map topology view to have a complete network view without 
topology groups

� Identify the characteristics of flat maps objects

� Identify the functions available from flat maps
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Module objectives [cont.]
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1 Flat Maps Labs
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1 Flat Maps Labs

1.1 Open a Flat Map Topology View

� Select Application � Flat 
Maps and choose one flat 
map option

Alternatively, click 
on the Display 
Filterable Flat 
Map button 

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 3.7 Edition 4
Section 3 � Module 7 � Page 8

Lab Exercise Objective:

In order to have a complete network view without topology groups, instructions in this lab exercise will guide 

students to open a flat map topology view.

Instructor Preparation: 

In preparation for this lab exercise provide students with instructions on the network elements, physical links, 

discovered physical links, and/or optical links to be included in the flat map.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to open a flat map

Technical Reference 

See Alcatel-Lucent 5620 SAM, Release 11.0 R3 User Guide – 5.5 Basic 5620 SAM map 
procedures - Procedure 5-5 To open a flat map for more details on the procedure.

The following lines and the images above summarize the steps recommended to open a flat physical topology map 

for this lab exercise:

1. Choose Application→Flat Maps→Physical Topology from the 5620 SAM main menu. The Topology Filter -

Physical Topology - Flat filter form opens.

Alternatively, click on the Display Filterable Flat Map button located in the map window tool bar to display 

a flat map of the current topology map view.
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1 Flat Maps Labs

1.1 Open a Flat Map Topology View [cont.]

� Choose one or more object 
filters and click on the “+” 
icon.

� Click on the Apply button

� Configure a filter 
criteria and click on Add 
button to create the 
filter

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 3.7 Edition 4
Section 3 � Module 7 � Page 9

2. Use the Topology Filter - Physical Topology - Flat filter form to choose one or more of the object filters and 

click on the “+” icon to create the filter. A filter window for each of the selected object types will open.

For this lab exercise example, use the Object Filters to Add drop-down menu to choose the object types 

filters to include in the flat map. The available options are:

� Discovered Physical Link

� Network Element

� Optical Link

� Physical Link

3. Configure a filter criteria for each of the object type filters selecting an Attribute and Function using the 

corresponding drop-down menu, and typing a Value, as required. Click on the Add Object Filter button. The 

selected object filter is displayed in the corresponding object filter panel.

4. Click on the Apply button to apply the filter. The Physical Topology – Flat map view is refreshed displaying 

only the map objects defined in the filter.
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1 Flat Maps Labs

1.2  Identify the Functions and Characteristics of a Flat Map

Double-click to display 

the object’s properties 

form

Right click to display 

the contextual menu 

for the object
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On the Physical Topology – Flat map view, note that:

� object icons in a flat map are displayed at a reduced size

� link lines are thinner

� and object information is not displayed

From a flat map, the operator can: 

� double-click on a NE in the flat map to display the object properties. For example, by double-clicking on an 

NE, a property form opens, from which allows operators to view or configure the NE parameters.

� right-click on an object in the flat map to display the contextual menu for the object. 
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Flat Maps Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� list the sessions on the 5620 SAM 

� list user activities on the 5620 SAM

� Filter logged activities performed during a session

� Filter all logged activities performed by a user

� Navigate from “session” to “activity”

� Navigate from “activity” to “session”

� Navigate from “activity” to “object”

� Navigate from “object” to “activity”

� Navigate from “task” to “activity”
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Lab Module Objectives

Upon completion of this lab module, you will be able to:

�list the sessions on the 5620 SAM 

�list user activities on the 5620 SAM

�Filter logged activities performed during a session

�Filter all logged activities performed by a user

�Navigate from “session” to “activity”

�Navigate from “activity” to “session”

�Navigate from “activity” to “object”

�Navigate from “object” to “activity”

�Navigate from “task” to “activity”
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1 User Activity Logs
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1 User Activity Logs

1.1 User Activity - Session

Administration → Security → User Activity 1

2
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Lab Exercise Objective:

Each 5620 SAM GUI client, 5620 SAM-O JMS client, or XML API request creates a 5620 SAM client session. In order 

to view a list of 5620 SAM client sessions, over the course of this lab exercise students will use the 5620 SAM 

GUI client to open a list of session activity records on the 5620 SAM.

Instructor preparation: 

Ensure each student is logged in using an user account with the appropriate scope of command rights to see the 

5620 SAM User Security - Security Management form.

Instructions:

The following lines and the figures above summarize the steps recommended to list all sessions:

1. Choose Administration -> Security -> User Activity from the 5620 SAM main menu. The 5620 SAM User Activity 

form opens with the Session tab displayed.

2. Click on the Search button, a list of session activity records is displayed. 

Technical Reference 

For more information Alcatel-Lucent 5620 SAM 11.0 R3 User Guide – 9.7 Workflow to manage 
5620 SAM user and group security– Procedure 9-28 To view the user activity log and 
Procedure 9-25 To view and manage the active 5620 SAM client sessions 
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1 User Activity Logs

1.1 User Activity - Session [cont.]

1. Session Time

2. Session Type

3. User Name

4. Session IP Address

6. Session State

5. Session ID

7. Additional Info.
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User Activity form refreshes displaying a list of session records on the 5620 SAM.

The image above shows an example of the display and identifies the listed session parameters: 

1. Session Time (User login time and date) 

2. Session Type (such as GUI, JMS and OSS)

3. Associated Username (example : admin,….)

4. Session IP address (Client IP Address)

5. Session ID : Unique identifier of the session 

6. Session state (Connected, Disconnected, access violation, Server startup…)

7. Additional Information (Session connected, login failure ….)
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1 User Activity Logs

1.2 User Activity - Activity

Administration → Security → User Activity 1

3

2
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Lab Exercise Objective

In order to view logged recent user activity entries, over the course of this lab exercise students will use the 5620 

SAM GUI client to open a filterable list of activities logged (except read-only activities) on the 5620 SAM.

Instructor preparation

Ensure each student is logged in using an user account with the appropriate scope of command rights to see the 

5620 SAM User Security - Security Management form.

Instructions

The following lines and the figures above summarize the steps recommended to list all sessions:

1. Choose Administration -> Security -> User Activity from the 5620 SAM main menu. The 5620 SAM User Activity 

form opens with the Session tab displayed. 

2. Click on the Activity tab.

3. Click on the Search button.

Technical Reference 

For more information Alcatel-Lucent 5620 SAM 11.0 R3 User Guide – 9.7 Workflow to manage 
5620 SAM user and group security– Procedure 9-28 To view the user activity log and 
Procedure 9-25 To view and manage the active 5620 SAM client sessions 
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1 User Activity Logs

1.2 User Activity - Activity [cont.]

1. Timestamp

2. Session Type

3. Username

4. Activity Type

5. Sub-type

6. Site Name

7. Site ID

8. Object Name

9. Object ID
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User Activity form Activities tab refreshes displaying a list of session activity records on the 5620 SAM.

The image above shows an example of the display and identifies the listed activity parameters:

1. Timestamp : The time at which the activity occurs

2. Session type:  such as GUI, JMS, or OSS 

3. Username (example : Admin)

4. Activity Type : Operation , Save , Deployment

� Operation : configuration, modification, deletion 

� Save : if the result of the operation is a database changing 

� Deployment : if a network deployment is a consequence of the activity

5. Activity Subtype : additional details on the activity (example for operation, this parameter specifies if the 

operation is  creation, modification, or deletion)

6. Site Name (information about the site) 

7. Site ID (information about the site) 

8. Object Name : if the operation is related to an object (example of activity on an object: Port Shutdown)

9. Object ID : if the operation is related to an object (example of activity on an object: Port Shutdown)

Other parameters (not displayed on this picture)

� Object Type (example Test Manager), State ( Success…), Session ID, Session IP address, Session Time, 

Request ID
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1 User Activity Logs

1.3 Filter Logged Activities Performed During a Session

1

2

3

4
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Lab Exercise Objective:

In order to view a list of activities performed during a user session, over the course of this lab exercise students 

will use the 5620 SAM GUI client to create list filter for displaying activities performed during a selected 

session.

Instructor preparation: 

Ensure each student is logged in using an user account with the appropriate scope of command rights to see the 

5620 SAM User Security - Security Management form.

Provide each student with instructions of a session for which logged actions will be filtered for this lab.

Instructions:

The following lines and the figures above summarize the steps recommended to filter all logged activities 

performed during a session

1. On User Activity form, click on Session tab. 

2. Click on the Search button. The list refreshes displaying a list of session records on the 5620 SAM.

3. Following your instructors directions. Select a session from the list and click on the Properties button, 

alternatively double-click on a session from the list. A Session [Identifier] form opens with the General tab 

displayed.

4. On the Session [Identifier] form click on the Activity tab.

5. Click on the Search button. The Activity tab displays all the activities performed during the selected session.
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1 User Activity Logs

1.4 Filter Logged Activities Performed by an User

1

2

3
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Lab Exercise Objective:

In order to view a list of activities performed by an user, over the course of this lab exercise students will use the 

5620 SAM GUI client to create list filter for displaying activities performed by a selected used.

Instructor preparation: 

Ensure each student is logged in using an user account with the appropriate scope of command rights to see the 

5620 SAM User Security - Security Management form.

Provide each student with instructions of a user for which logged actions will be filtered for this lab.

Instructions:

1. On User Activity form, click on Activity tab. 

2. Click on the Filter icon. The User Activity Filter form opens.

3. Select “username” as Attribute.
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1 User Activity Logs

1.4 Filter Logged Activities Performed by an User [cont.]

4

5
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4. Following your instructor’s directions enter the username for which logged actions will be filtered for this 

lab. The example above shows a filter specified for a username that contains “lannion”.

5. Click on the Apply button. The User Activity form Activity tab’s list refreshes displaying logged activities 

performed by the selected user.
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2 Navigate Using User Activity Logs
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2 Navigate Using User Activity Logs

2.1 Navigation from “Session” to “Activity”

� Click on a GUI session 
record

� Click on the Activity 
tab
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Lab Exercise Objective:

In order to trace down activities performed during a client session using logged user activity, over the course of 

this lab exercise students will use the GUI client to navigate from a “session” to the related “activities”.

Instructor Preparation:

Provide students with instructions on a client session for which activities will be viewed.

Instructions:

The following lines and the figures above summarize the steps recommended to navigate from a “session” to the 

related “activities” for this lab:

1. On the User Activity form, select a GUI Session from the session list.

2. Click on the Activity tab.

Technical Reference 

For more information Alcatel-Lucent  5620 SAM 11.0 R3 Troubleshooting guide – Chapter 8 —
Troubleshooting using the 5620 SAM user activity log 
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2 Navigate Using User Activity Logs

2.1 Navigation from “Session” to “Activity” [cont.]

� Click on the Search button
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3. Click on the Search button. The form lists all activities associated with the session. 
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2 Navigate Using User Activity Logs

2.2 Navigation from “Activity” to “Session”

� Click on an activity

� Click on the Session 
tab

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 3.8 Edition 4
Section 3 � Module 8 � Page 19

Lab Exercise Objective:

In order to trace down the client session during which a selected activity was performed using logged user 

activity, over the course of this lab exercise students will use the GUI client to navigate from an “activity” to 

the related “session”

Instructor Preparation:

Provide students with instructions on an activity or activities for which the client session will be viewed.

Instructions:

The following lines and the figures above summarize the steps recommended to navigate from an “activity” to 

the related “session” for this lab:

1. On the User Activity form, click on the Activity tab and double-click on an activity from the list. 

Alternatively, select an activity from the list and click on the Properties button. The Activity form opens.

2. On the Activity form, click on the Session tab.
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2 Navigate Using User Activity Logs

2.2 Navigation from “Activity” to “Session” [cont.]

� The associated session is 
listed

� Click on the Search 
button
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3. Click on the “search” button 

4. The session linked to the activity is displayed

Technical Reference 

For more information Alcatel-Lucent  5620 SAM 11.0 R3  Troubleshooting guide – Chapter 8 —
Troubleshooting using the 5620 SAM user activity log
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2 Navigate Using User Activity Logs

2.3 Navigation from “Activity” to “Object”

1. Click on the “View 
Object” Button
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Lab Exercise Objective:

In order to trace down the object related to a selected logged user activity, over the course of this lab exercise 

students will use the GUI client to navigate from an “activity” to the related “object” properties window.

Instructor Preparation:

Provide students with instructions on an activity or activities for which the object properties window will be 

viewed.

Instructions:

Follow your instructor’s directions to navigate from an “activity” to the related “object” properties window for 

this lab.

Technical Reference 

For more information Alcatel-Lucent 5620 SAM 11.0 R3 Troubleshooting guide – Chapter 8 —
Troubleshooting using the 5620 SAM user activity log 

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to navigate from a port shutdown “activity” to the related port “object” properties window:

1. Open the Activity window. Click on the View Object button besides the “Object ID” parameter to navigate to 

the affected object’s properties form.

The object’s Properties form opens.
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2 Navigate Using User Activity Logs

2.4 Navigation from “Object” to “Activity”

� Click on User 
Activity

� User activities associated to 
the object
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Lab Exercise Objective:

In order to trace down recent activities performed for a selected object using the logged user activity, over the 

course of this lab exercise students will use the GUI client to navigate from an “object” properties window to 

the related user “activity”.

Instructor Preparation:

Provide students with instructions on an object for which related logged activities will be viewed.

Instructions:

Follow your instructor’s directions to navigate from an “object” properties form to the related user “activity” for 

this lab.

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to navigate from a port “object” properties form to the related user “activities”:

1. Open an object’s properties form. Select the User activity in the bottom left corner of the properties form.

Should the properties form has been resized click on the More Actions button and select User Activity from 

the contextual menu, as shown in the image above.

2. The User Activity form opens with a filter applied to display all associated activities logged for the selected 

object.



5620 SAM � R12.0 Fundamentals
Network Management � User Activity Lab

3 � 8 � 23
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

2 Navigate Using User Activity Logs

2.5 Navigation from Task manager to User Activity

� Choose one port and 
open the properties 
form

� Modify the description 
parameter
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Lab Exercise Objective:

In order to trace down the activity related to a 5620 SAM task, over the course of this lab exercise students will 

use the GUI client to navigate from a “task” on the task manager to the related “activity”.

Instructor Preparation:

Provide students with instructions on a task to be performed for which the associated activity will be viewed.

Instructions:

Follow your instructor’s directions to navigate from a “task” to the related user “activity” for this lab.

In order to exemplify the procedure, the following lines and the figures above summarize the steps recommended 

to navigate from a “task” perform on a port in the task manager to the related “activity” for this lab:

1. Open an object’s properties form for which a task will be performed. 

For this lab example, a port is selected on the Navigation Tree and its Properties form is opened.

2. Following your instructors perform a task.

For this lab example, the images above show the steps to modify the Description parameter. 
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2 Navigate Using User Activity Logs

2.5 Navigation from Task manager to User Activity [cont.]

� Choose Application → Task 
Manager

� Click on a task
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3. Open the Task Manager. Choose Application -> Task Manager from the main menu. The Task manager form 

opens. 

4. Double-click on the performed task from the Task Manager list. The Task form opens.
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2 Navigate Using User Activity Logs

2.5 Navigation from Task manager to User Activity [cont.]

� Select User Activity 

	 Select Additional Info 
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5. On the Task form click on User Activity button

6. The activity form opens. 

If required, click on Additional Info.
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User Activity Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Use the topology map for viewing object alarm status, severity and opening 
alarm information

� Use the navigation tree for viewing object alarm status and severity, 
aggregated alarm status and severity for parent objects, and for opening alarm 
information
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Module objectives [cont.]
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1 View Alarm Information – Status and Severity 
Labs
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1 View Alarm Information – Status and Severity Labs

1.1 View Alarm Information – Using Topology Maps

Right-click 
and choose  
Properties

1
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Lab Exercise Objective:

In order to use the topology map for viewing alarm information about objects represented on the map, 

instructions in this lab exercise will guide students to view object alarm status and severity for an NE using 

the topology map, and to open alarm information.

Technical Reference 

For more information on procedures to perform alarm management tasks see Alcatel-Lucent 
5620 SAM User Guide – Alarm management procedures section.

Instructor Preparation: 

In preparation for this lab exercise ensure there is at least one alarmed map object, or if required insert a fault 
condition to an object. 

Provide students with details on the topology map object for which alarm information (object alarm status, 
severity and alarm details) will be accessed in this exercise.

Instructions:

The following lines and the images above summarize the steps recommended to view object alarm status of a NE 
using the topology map and open alarm information for this lab exercise:

1. On the topology map, right click on the NE and choose Properties from the contextual menu. The Properties

form appears with the General tab displayed.

Note 

When one or more alarms are raised against a specific object or related object, an indicator 

appears on the Faults tab of the object properties form. As shown in the image above. The 

indicator does not represent the severity of the alarm, only that an alarm exists.
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1 View Alarm Information – Status and Severity Labs

1.1 View Alarm Information – Using Topology Maps [cont.]

2

3
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2. Click on the Faults tab. The Fault tab opens with the Object Alarms tab displayed.

Note

An indicator appears on the Object Alarms, Affecting Alarms, Aggregated Alarms, and/or 

Alarms on Related Objects tabs of the object Properties form – Faults tab, when one or more 

alarms for each of this types are raised against a specific object or related object.

In each of these tabs, alarms are displayed in the list indicating status and color-coded by 

severity.

3. To view a specific alarm, double-click on the line or choose an alarm from the list and click on the View 

Alarm button to open. The Alarm Info form appears with the Alarm tab displayed.
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1 View Alarm Information – Status and Severity Labs

1.2 View Alarm Information – Using Navigation Tree 

Use the navigation tree to 
find alarms against objects

Aggregated alarm

Expand to view 
child objects as 

required

Object alarm
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Lab Exercise Objective:

In order to use the navigation tree for viewing object alarm information, instructions in this job aid will guide 

students to view object alarm status, aggregated alarm status for parent objects, and to open alarm 

information using the navigation tree

Technical Reference 

For more information on procedures to perform alarm management tasks see Alcatel-Lucent 
5620 SAM User Guide – Alarm management procedures section.

Instructor Preparation: 

In preparation for this lab exercise ensure there is at least one alarmed object in the navigation tree, or if 
required insert a fault condition to an object. 

Provide students with details on the navigation tree object for which alarm information (object alarm status, 
severity and alarm details) will be accessed in this exercise.

Instructions:

The following lines and the images above summarize the steps recommended to view object alarm status, 
aggregated alarm status for parent objects and open alarm information on a port using the navigation tree for 
this job aid:

Use the navigation tree to view alarms against objects. Alarms in circles represent aggregated alarms. Alarms in 

squares represent object alarms (as shown in the image above).
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1

1 View Alarm Information – Status and Severity Labs

1.2 View Alarm Information – Using Navigation Tree  [cont.]

Object alarm
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Note 

When an aggregated alarm is indicated, and no object alarm is seen for any child object, change 

the view of the equipment tree.

An aggregated alarm may not appear in the selected view from the navigation tree. For 

example, with the Equipment drop-down menu selected, a critical alarm aggregated against the 

device object may appear. However, no object below the device object has a critical alarm. 

That is because the critical alarm is aggregated from the network view of the router. The alarm 

is based on the entire object, but the equipment view shows a subset of the entire object.

1. Identify and select an object in the navigation tree displaying the object alarm identifier (Alarm in square). 

Right click on the object in the navigation tree and choose Properties from the contextual menu. The 

Properties form appears with the General tab displayed.

Note 

When one or more alarms are raised against a specific object or related object, an indicator 

appears on the Faults tab of the object properties form. As shown in the image above. The 

indicator does not represent the severity of the alarm, only that an alarm exists.
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1 View Alarm Information – Status and Severity Labs

1.2 View Alarm Information – Using Navigation Tree  [cont.]

2

3
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2. Click on the Faults tab. The Fault tab opens with the Object Alarms tab displayed.

Note

An indicator appears on the Object Alarms, Affecting Alarms, Aggregated Alarms, and/or 

Alarms on Related Objects tabs of the object Properties form – Faults tab, when one or more 

alarms for each of this types are raised against a specific object or related object.

In each of these tabs, alarms are displayed in the list indicating status and color-coded by 

severity.

4. To view a specific alarm, double-click on the line or choose an alarm from the list and click on the View 

Alarm button to open. The Alarm Info form appears with the Alarm tab displayed.
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Alarm Status and Severity Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Modify the order in which columns are displayed in the 5620 SAM Dynamic 
Alarm list form

� Display alarm flags with the number of alarms color-coded by severity

� Limit the number of alarms displayed in the dynamic alarms window according 
to a user configured criteria
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Module objectives [cont.]
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Dynamic Alarm List - Information Columns Displayed

� Right-click on any 
column heading 

�Choose 
Column 
Display
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Job Aid Objective:

In order to modify the order in which columns are displayed in the 5620 SAM Dynamic Alarm list form, instructions 

in this job aid will guide students to hide, show and sort columns that are displayed in the dynamic alarm list 

form.

Instructions:

The following lines and the images above summarize the steps recommended to display the Severity colum as the 

second column shown in the Dynamic Alarm Window.

1. From the Dynamic Alarm Window, right-click on the list heading the contextual inventory menu appears. 

2. Choose Column Display from the contextual menu. The Column Display – Alarm Window form opens with the 

names of all displayed columns in the Displayed on Table list.
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Dynamic Alarm List - Information Columns Displayed [Cont.]

� Select one or 
multiple entries 

� Use the up and down arrow to 
rearrange column display order
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3. Select one or more column name entries form the Displayed on Table list (to select multiple entries press and 

hold down the Ctrl key and click on the entries).

For this job aid example, the images above show the steps to select the Severity column.

4. Click on up arrow and down arrow buttons to rearrange the order in which the selected columns are 

dispayed.

For this lab example, use the up arrow button to move the Severity column to the second position.

Alternatively, to stop displaying one or multiple columns on the Dynamic Alarm List select the column names 

from the Displayed on Table list and use the left arrow button to move the selected columns to the 

Available for Table list panel.

The columns listed in the Available for Table list will not be displayed in the Dinamyc Alarm List form.

5. Click on the OK button. The Column Display – Alarm Window form closes, and the Dinamic Alarm window list 

reappears with the modifications applied to the columns displayed in the list. 
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Dynamic Alarm List - Configure Alarm Flags

� Choose Application→User Preferences 

� Configure the Show 
Alarm Flags parameter

� Click on the 
OK button
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Job Aid Objective:

In order to display in the dynamic alarm list the number of alarms, color-coded by severity, that have been 

detected since the flag was reset, instructions in this job aid will guide students to configure alarm flags.

Technical Reference: 

See Alcatel-Lucent 5620 SAM, Release 10.0 R5 User Guide – 37.3 Alarm management 
procedures - Procedure 37-6 To configure alarm flags for the procedure specify whether 
alarm flags are displayed in the alarm list.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to show or hide the 
monitoring flag panel in the dynamic alarm list.

The following lines and the images above summarize the steps recommended to display the monitoring alarm 
flags panel in the dynamic alarm for job aid example:

1. Choose Application→User Preferences from the 5620 SAM main menu. The User Preferences form opens 
with the General tab displayed.

2. Configure the Show Alarm Flags parameter.

3. Click on the OK button. The User Preferences form closes, and the Monitoring Flag panel appears in the 
dynamic alarm list Alarm Window.

Note 
The time the last alarm for that severity was detected is also displayed.
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Dynamic Alarm List – Filter

� Click on the filter icon

� Click on Add

� Configure a first filter 
on “Node Name”
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Job Aid Objective:

In order to limit the number of alarms displayed in the dynamic alarms window according to a user configured 

criteria, instructions in this job aid will guide students to create a filter to display only selected alarms. 

Instructions:

The following lines and the images above summarize the steps recommended to create filter to display only 

alarms for a severity type on a selected group of nodes for this job aid example:

1. Click on the Filter icon beside the filter drop-down list. The Alarm Window filter form opens.

2. Configure the filter criteria: first filter on, Node name

3. Click on the Add button
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Dynamic alarm List – filter (Cont.) 

� Click on Add
� Configure a second 

filter on “Severity”

� Click on the Apply 
button

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 4.2 Edition 4
Section 4 � Module 2 � Page 11

4. Configure a second filter with “severity”

5. Click on Add

6 Apply the filter on the Dynamic Alarm List. The Alarm window refreshes displaying in the Dynamic Alarm list 

only alarms for the selected severity type declared against the selected group of nodes.
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Dynamic Alarm List Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� View detailed information about an alarm using the Alarm Info

� Identify the alarm information details contained on each of the Alarm Info form 
tabs

� View additional information details about an alarm by open the corresponding 
alarm description in the 5620 SAM Alarm Reference list documentation 
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View Alarm Information Details – Info Form

Double-click

or select and right-click 
on the selected alarm(s)

� Open the Alarm Info form
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Job Aid Objective:

In order to obtain detailed information about an alarm, instructions in this job aid will guide students to open the 

alarm info form and view alarm’s detailed information.

Job Aid Preparation: 

In preparation for this job aid identify an alarm to view its detailed information.

Instructions:

Follow the appropriate procedure's for detailed instructions on all available options to view alarm information.

Technical Reference 

See Alcatel-Lucent 5620 SAM, Release 10.0 R5 User Guide – 37.3 Alarm management 
procedures - Procedure 37-9 To view alarm information for more details.

The following lines and the images above summarize the steps recommended to open the alarm info form and 
view alarm’s detailed information:

1. Open the Alarm info form for the alarm of interest from: 

� the Dynamic Alarm List, the Faults tab of an object properties form, or the Current and Historical 
Alarm Snapshot list by double-clicking on an entry, or by right-clicking and choosing Show Alarm from 

the contextual menu.

� the Faults tab of an object properties form, or the Current and Historical Alarm Snapshot list by 

choosing an alarm from the list and clicking on the View Alarm button.

The Alarm Info form opens with the Alarm tab displayed.
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View Alarm Information Details – Info Form [Cont.]

� View alarm details in the Alarm Info form tabs 

Info tab

Alarmed Object type, name 
and ID

Domain, Site ID and Name

Severity and Probable cause

OLC state

Acknowledged and Cleared 
status

First and Last time detected

Alarm name, type and policy
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2. Use the Alarm Info form tabs to view information details about the alarm.

Use the Alarm – Info tab to view the following details:

� Domain, Site ID and name

� Alarmed Object type, name and ID

� Alarm name, type and related policy

� Severity

� OLC State

� Probable cause

� Acknowledge status

� Cleared status

� First and last time detected

� Number of correlated alarms and correlated alarm ID

� Additional text

The Alarm Info tab also contains buttons to:

� Copy alarm information to the SAM clipboard

� View the alarm object properties form

� View the related alarm policy

� View alarm history

� Acknowledge, clear or delete the alarm
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View Alarm Information Details – Info Form [Cont.]

Severity tab

(NE time) Last time records

Current, previous, original and 
highest severity

(Client time) Last time records
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Use the Alarm – Severity tab to view detailed information about alarm severity, and alarm severity alterations. 

The Alarm – Severity tab display the following parameters:

� Current Severity

� Previous Severity

� Original Severity

� Highest Severity

� (Client time) and (NE Time) Last Time Records panels show details about the time at which the last instance for 

the following operations occurred:

� Severity Changed

� Cleared

� Promoted

� Demoted

� Escalated

� De-escalated
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View Alarm Information Details – Info Form [Cont.]

Severity tab

(NE time) Last time records

Current, previous, original and 
highest severity

(Client time) Last time records
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Use the Alarm – Statistics tab to view details about how often the alarm has been raised, based on the specified 

scenarios. As each new instance of the alarm is raised, the number of occurrences statistic increases. The 

Alarm – Statistics tab displays the following parameters:

� Frequency

� Number of occurrences

� Number of occurrences since acknowledged

� Number of occurrences since cleared
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View Alarm Information Details – Info Form [Cont.]

Acknowledgement tab

Acknowledgement  Info

Urgency

Acknowledgement Notes
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Use the Alarm – Acknowledgement tab to view details about when the alarm was acknowledged, the user that 

acknowledged the alarm, and the user that set the urgency. The Alarm – Acknowledgement tab displays the following 

parameters:

� Acknowledgement Info

� Acknowledged by

� Last Time Acknowledged

� Previously Acknowledged

� Urgency

� Acknowledgement Notes



5620 SAM � R12.0 Fundamentals
Fault Management � Alarm Information Form Lab

4 � 3 � 12
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

View Alarm Information Details – Info Form [Cont.]

Details

Description

Raising condition

Remedial action

Clearing condition
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Use the Alarm – Details tab to view details about the description of the alarm, raising condition and clearing 

condition for the alarm, and action to be taken to clear the alarm. The Alarm – Details tab displays the following 

parameters:

� Alarm description. If the description information is more than 250 characters, click on the ...button to view the 

entire description.

� Raising condition

� Clearing condition

� Remedial action. If the remedial action information is more than 250 characters, click on the ...button to view 

the entire description.
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View Alarm Information Details – Info Form [Cont.]

Details

Description

Raising condition

Remedial action

Clearing condition
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Use the Alarm – Details tab to view details about the description of the alarm, raising condition and clearing 

condition for the alarm, and action to be taken to clear the alarm. The Alarm – Details tab displays the following 

parameters:

� Alarm description. If the description information is more than 250 characters, click on the ...button to view the 

entire description.

� Raising condition

� Clearing condition

� Remedial action. If the remedial action information is more than 250 characters, click on the ...button to view 

the entire description.
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View Alarm Information Details – Info Form [Cont.]
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Use the following tabs to view more alarm details: 

� Affected Objects tab: contains a list of objects that are affected by the alarm. All alarms list the affected 

objects, even when correlation alarm suppression is enabled. 

� Affecting Objects tab: contains a list of objects that directly affect the object in alarm. 

� Correlated Alarms tab: contains a list of correlated alarms. Correlated alarms are raised against other 

objects that are dependent on the alarmed object. 
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View Alarm’s Description in Reference Documentation 

� Open the Alarm 
Info form

� Copy the 
Alarm Name

� Enter the Alarm Name in 
the Search field of the User 
Documentation Index. 
And click on the Go button

Search results are displayed  in the 
User Documentation’s left panel
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Job Aid Objective:

In order to obtain more details about an alarm information, instructions in this job aid will guide students to open 

the corresponding description for the alarm in the 5620 SAM Alarm Reference list documentation. 

Job Aid Preparation: 

In preparation for this job aid: 

� identify an alarm for which more details are required

� ensure having access to 5620 SAM on-product customer documentation (typically installed on the 5620 SAM 

Server during the SAM installation process)

� open the 5620 SAM on-product customer documentation help system by choosing Help → User Documentation
form the 5620 SAM client GUI main menu. The help system opens on a web browser displaying the User 
Documentation Index

Instructions:

The following lines and the images above summarize the steps recommended to open the description in the 5620 

SAM Alarm Reference list documentation for an “Equipment Administratively Down“ alarm for this job aid 

example.

1. Identify an alarm of interest and open the Alarm Info form.

For this job aid example, the images above show the Alarm info form for an equipment administratively down 

alarm. This type alarm could have been generated by shutting down a port on a managed equipment, for 

instance during a maintenance procedure.
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View Alarm’s Description in Reference Documentation [Cont.]

Switch to notes view!
2. Look for the Alarm Name parameter in the Alarm Info form Alarm – Info tab. Copy the alarm 

name to the clipboard (typically by selecting the alarm name and clicking Control+“C“), or take 

note of the alarm name. 

For this job aid example, the alarm name is “EquipmentAdministrativelyDown”

3. Bring to the foreground the 5620 on-product customer documentation help system opened on a 

web browser in preparation for this job aid. 

Enter the Alarm Name in the Search field of the User Documentation Index, by inserting the 

alarm name previously copied to the clipboard (typically by clicking Control+”V”), or by typing 

the alarm name. And click on the Go button. 

The Help system – User Documentation window refreshes displaying the search results on the 

left panel.

Note

In the 5620 SAM Alarm Reference list documentation, alarms are organized in 

chapters by device type. An alarm that applies to multiple devices has multiple 

entries in this guide; each entry for such an alarm varies only by the applicable major 

NE release information, which depends on the device type.

4. Click on the search results entry for the Alarm Reference corresponding to the type of device 

against which the alarm has been raised.

For this job aid example, click on the 7750 SR alarms.

The Help system – User Documentation window refreshes displaying in main frame the 

appropriate user document section with the searched item highlighted.

For this job aid example, the main frame displays the EquipmentAdministrativelyDown
description in the 7750 SR alarms section of the 5620 SAM Alarm Reference document. The 
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description in the 7750 SR alarms section of the 5620 SAM Alarm Reference document. The 

alarm name  EquipmentAdministrativelyDown text is highlighted

5. View the Alarm Reference entry table corresponding to the alarm name.

For this job aid example, the alarm reference entry table for the 

EquipmentAdministrativelyDown alarm.
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View Alarm’s Description in Reference Documentation [Cont.]

� Click on the search result entry 
corresponding to the type of device

� View the alarm entry 
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The table title for an alarm entry is the alarm name. When the same alarm name is found in multiple packages, 

the table title includes the package name in parentheses. Each alarm entry contains the following information: 

� Name — the alarm name, and the alarm name ID in parentheses

� Type — the alarm type, and the type ID in parentheses

� Package — the containing package of the alarm, which maps to a package in the 5620 SAM-O XML Reference

� Raised on class — the package and object class in package.class format 

� Severity — the alarm default severity level

� Implicitly cleared — whether the alarm automatically clears when the clearing alarm condition is true

� Default probable cause — the typical probable cause of the alarm, and the probable cause ID in parentheses

� Applicable major NE releases — the major device releases against which the alarm can be raised; the releases 

are applicable to the device specified in the chapter title 

� Description — the alarm description

� Raising condition — a logical statement that describes the internal 5620 SAM parameter values that initiate the 

raising of the alarm 

� Clearing condition — a logical statement that describes the internal 5620 SAM parameter values that initiate 

the clearing of the alarm 

� Remedial action — a statement or series of steps recommended by Alcatel-Lucent as the fault clearance 

procedure for the alarm
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Alarm Information Form Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Enable or disable the display of correlated alarms in the dynamic alarm list
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Module objectives [cont.]
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Disable the Display of Correlated Alarms

� Select Application→User Preferences

� Configure the Show 
Correlated Alarms
parameter

� Click on the 
OK button
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Job Aid Objective:

In order to specify whether the dynamic alarm list displays correlated alarms, instructions in this job aid will 
guide students to enable or disable the display of correlated alarms in the dynamic alarm list.

Technical Reference 

See Alcatel-Lucent 5620 SAM, Release 10.0 R5 User Guide – 37.3 Alarm management 
procedures - Procedure 37-7 To enable or disable the display of correlated alarms for the 
procedure to specify whether correlated alarms are displayed in the alarm list

Note 

The display of correlated alarms may slow GUI performance while the 5620 SAM adds the alarms 

to the dynamic alarm list.

Instructions:

Follow the appropriate procedure's instructions to specify whether the dynamic alarm list displays correlated 
alarms.

The following lines and the images above summarize the steps recommended to disable the display of correlated 
alarms in the dynamic alarm list:

1. Choose Application→User Preferences from the 5620 SAM main menu. The User Preferences form opens 
with the General tab displayed.

2. Configure the Show Correlated Alarms parameter, uncheck the box to disable the display of correlated 
alarms.

3. Click on the OK button. The User Preferences form closes and alarm option is applied.
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Disable the Display of Correlated Alarms [Cont.]

� Verify the Alarm Window 
title bar displays Correlated 
Alarms Not Shown
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4. Verify the Alarm Window title bar displays Correlated Alarms Not Shown. 

Note 

When the operator disables the display of correlated alarms in the dynamic alarm list, the 

correlated alarms are still listed in the Correlated Alarms tab of the Alarm Info form.
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Alarm Correlation, Affecting and Aggregated Alarms Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Configure the alarm window settings (such as specifying specify whether new 
incoming alarms generate an audible sound, show alarm flags, show correlated 
alarms by default)

� View the alarm severity alteration configuration, and to enable or disable the 
severity alterable functionality

� Acknowledge alarms to indicate to other SAM operators that a problem is under 
investigation thus providing records to avoid duplicate resources are applied to 
the same problem
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1 – Alarm Management Tools Labs
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1 – Alarm Management Tools Labs

1.1 Configure Alarm Window Settings

Application→User Preferences 1

2
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Job Aid Objective:

In order to specify whether new incoming alarms generate an audible sound, show alarm flags, show correlated 

alarms by default, instructions in this job aid will guide students configure the alarm window settings.

Technical Reference 

See Alcatel-Lucent 5620 SAM, Release 12.0  User Guide – Alarm management procedures - for 

more details on the procedure to configure alarm window settings.

Instructions:

The following lines and the images above summarize the steps recommended to modify the alarm window 
settings by turning off 5620 SAM GUI client’s audible alarms for this job aid:

1. Choose Application→User Preferences from the 5620 SAM main menu. The User Preferences form opens 

with the General tab displayed.

2. Configure the Turn on Audible Alarms parameter, disable audible alarms by unchecking the box.

3. Click on the OK button. The User Preferences form closes, and the tunr off audible alarm option is applied.
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1 – Alarm Management Tools Labs

1.2 Severity Alterations

Administration→Alarm Settings 1
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Job Aid Objective:

In order to manage alarms using the severity alterations tool, instructions in this job aid will guide students to 

view the alarm severity alteration configuration, and to enable or disable the severity alterable functionality.

Job Aid Preparation: 

In preparation for this job aid, in order to enable or disable the severity alterable functionality log in as an admin 

user, or an user who is assigned an account with either the administrator scope of command role or a scope of 

command role with write access permissions to the fm.GlobalPolicy class

Instructions:

The following lines and the images above summarize the steps recommended to view the alarm severity 
alteration configuration, and to enable or disable the severity alterable functionality:

1. Choose Administration→Alarm Settings from the 5620 SAM main menu. The Alarm Settings form opens with 

the General tab displayed. Administratively
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1 – Alarm Management Tools Labs

1.2 Severity Alterations [cont.]

Administration→Alarm Settings 1

2
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2. Use the Severity tab parameters to view, enable or disable the alarm severity alteration configuration:

� Enable Severity Settings: When this parameter is enabled, operators can specify whether to allow automatic 

changes to severity based on individual alarm policies or manual changes to severity based on operator 

actions. 

� Use the Manual panel to view and/or modify the manual changes to severity allowed based on operator 

actions:

� Enable Manual Severity Settings: specifies whether operators can manually change the severity of alarm

� Allow Manual Severity promotion: to allow an operator to increase the severity of an alarm

� Allow Manual Severity demotion: to allow an operator to decrease the severity of an alarm

� Allow Manual Clearing of Automatically Clearing (Self Clearing) Alarms: to allow an operator to clear an 

alarm if the alarm is self-clearing. A self-clearing alarm is cleared when an alarm-clearing condition 

occurs

� Use the Automatic panel to view and/or modify whether to allow automatic changes to severity based on 

individual alarm policies 

� Enable Automatic Severity Settings: specifies whether to enable automatic severity changes for alarms 

based on specific alarm policies

� Allow Automatic Severity Promotions: specifies whether to automatically promote the severity of the 

alarm based on the specific alarm policy 

� Allow Automatic Severity Demotions: specifies whether to automatically demote the severity of the 

alarm based on the specific alarm policy

� Allow Policy Based Escalation: specifies whether to automatically de-escalate the severity of an alarm 

based on the specific alarm policy 

� Allow Policy Based De-escalation: specifies whether to automatically de-escalate the severity of an 

alarm based on the specific alarm policy 
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1 – Alarm Management Tools Labs

1.3 Alarm Acknowledgement

1

Method 1 – Using Alarm 
Info form to access the 
acknowledgment form 
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Job Aid Objective:

In order to indicate to other SAM operators that a problem is under investigation thus providing records to avoid

duplicate resources are applied to the same problem, instructions in this job aid will guide students through

the process of acknowledging an alarm.

Technical Reference 

See Alcatel-Lucent 5620 SAM, Release 12.0  User Guide – Alarm management procedures - for 

more details on the procedures to manage alarms.

Job Aid Preparation: 

In preparation for this job aid, ensure there is at least one alarm in the system to be investigated and that 
therefore will be acknowledged.

In order to successfully modify the Assign Severity parameter log in as an admin user, or an user who is assigned 
an account with either the administrator scope of command role or a scope of command role with write 
access permissions to the fm.GlobalPolicy class. And the ensure the Enable Severity Settings, Enable Manual 
Severity Settings, Allow Manual Severity Demotions, and Allow Manual Severity Promotions parameters are 
appropriately configured.

Instructions:

The following lines and the images above summarize the steps recommended to acknowledge an alarm, Method 1 
– How to open the acknowledgement form using an Alarm Info form:

1. Open the Alarm Info form for the alarm that is being investigated, and click on the Acknowledge button.

The form refreshes with the Acknowledgement tab and Notes sub-tab displayed.

Alternatively, operators can click on the Acknowledgement tab and the Notes sub-tab to access the same 

form view.

If required, click on the Search button to reflesh the list and see any previous acknowledgement notes for 

the alarm.
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Method 2 – Using the 
Faults tab in a form to access 
the acknowledgment form 

1 – Alarm Management Tools Labs

1.3 Alarm Acknowledgement [cont.]

1
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The following lines and the images above summarize the steps recommended to acknowledge an alarm, Method 2 
– How to open the acknowledgement form using the Faults tab on an object properties form:

Note

This method allows to acknowledge at the same time multiple alarms declared against the same 

object.

An indicator appears on the Faults tab of the object properties form when one or more alarms 

are raised against a specific object or related object. The indicator does not represent the 

severity of the alarm, only that an alarm exists.

1. Click on the Faults tab on the Properties form of an object to see a list of more alarms are raised against a 

specific object or related object, select one or more alarms from the list, right-click and choose 

Acknowledge Alarm(s) from the contextual menu. The Alarm Acknowledgement form opens.

Note

The Alarms to be Acknowledge field in the form displays a summary of the alarms that are to 

be acknowledge using the form.
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1 – Alarm Management Tools Labs

1.3 Alarm Acknowledgement [cont.]

Method 3 – Using the 
Dynamic Alarm list to access 
the acknowledgment form 

1
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The following lines and the images above summarize the steps recommended to acknowledge an alarm, Method 3 
– How to open the acknowledgement form using the Dynamic Alarm List:

Note

This method allows to acknowledge at the same time multiple alarms. The alarms to be 

acknowledged using this method could be declared against a single object or against different 

objects.

1. From the dynamic alarm list, select one or more alarms right-click and choose Acknowledge Alarm(s) from 

the contextual menu. The Alarm Acknowledgement form opens.

Note

The Alarms to be Acknowledge field in the form displays a summary of the alarms that are to 

be acknowledge using the form.
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1 – Alarm Management Tools Labs

1.3 Alarm Acknowledgement [cont.]

2

Method 1

Method 2 & 3

2
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2. Use the Notes field in the Alarm Info form the Acknowledgement tab and Notes sub-tab (for Method 1), or 

the Acknowledgement text box in the The Alarm Acknowledgement form (for Methods 2 & 3), the enter 

data about the alarm acknowledgement as required and according to the SAM operator‘s compamy alarm 

policies.

If required, use the Urgency parameter to specifies the user-defined urgency for managing the alarm. The 

options are: Indeterminate (default); Minor; Major; and, Critical

Note

The Urgency parameter is a user-defined informative parameter for managing the alarm, and it 

is not linked to changes in alarm severity.

Also if required, operators with the required span of control can use the Assigned Severity parameter to 

change the severity level of an alarm. The options are:

� Cleared

� Indeterminate

� Info

� Condition

� Warning

� Minor

Note

The Assigned Severity parameter is configurable when the Enable Severity Settings, Enable 
Manual Severity Settings, Allow Manual Severity Demotions, and Allow Manual Severity 
Promotions parameters are appropriately configured. 



5620 SAM � R12.0 Fundamentals
Fault Management � Alarm Management tools Lab

4 � 5 � 15
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

1 – Alarm Management Tools Labs

1.3 Alarm Acknowledgement [cont.]

Switch to notes view!3. Click on the OK button. A dialog box appears.

4. Click on the OK button to continue. 

Note

For each of the acknowledged alarms, a check mark appears under the Acknowledge column in 

both, the Dynamic Alarm List, and in the alarms list in the Faults tab of the object’s properties 

form. 

This allows users to use the Acknowledgement criteria for filtering the alarm lists to display only 

not-acknowledged alarms, or in other words alarms that have not been taking care of by any 

other SAM operator.
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Alarm Management tools Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:

� Configure the system preference for OLC parameters and alarm behavior
� Schedule OLC state  revert

� Configure the creation of an OLC alarm prior to the OLC revert 

� Set the OLC state of an object
� Using the object’s Properties form

� Using the SAM GUI client main menu

� Using the Dynamic Alarm window

� Monitor the scheduling of OLC state change

� Filter alarms in the Dynamic Alarm window based on the OLC state
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Lab Objective:

In order to set the 5620 SAM system preferences for OLC parameters and behavior, over the course of this lab 
exercise students will :

� schedule an OLC revert

� configure the creation of an OLC alarm prior to the OLC revert 

Instructor Preparation: 

In preparation for this lab provide students with the schedule that should be used for changing the OLC state, and 

decide whether an alarm should be raised prior to the OLC revert.

Instructions:

The following lines and the figures above summarize the steps recommended to configure the system preference 

for OLC parameters and alarm behavior for this lab: 

1. Choose Administration→System Preferences from the 5620 SAM main menu. The System Preferences form 

opens with the Services tab displayed. 

2. Click on the OLC tab button.
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3. On the System Preferences form with the OLC tab displayed, configure the parameters:

� Create Info Alarm Prior to OLC Revert specifies whether the 5620 SAM raises an alarm before the OLC 

state of an object reverts to the opposite state

� Specify Lead Time of Alarm Notification Prior to OLC Revert (minutes) specifies how many minutes 

before the OLC state of an object reverts to the opposite state that the 5620 SAM raises a notification 

alarm 

4. Configure the parameters in the Configure Revert OLC State Time Options on Object Property Forms panel:

� Time 1 : the default value is 4 hours – For the exercise change the default value : 5 minutes

� You can specify the menu options that appear for the Revert OLC State parameter on object properties 

forms, other than the default values 

Click on the OK button. A dialog box appears.

Click on the Yes button. The System Preferences form closes.
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Lab Objective:

In order to set the OLC state of an object, over the course of this lab exercise students will configure the OLC 
state using the object’s Properties form

Instructor Preparation: 

In preparation for this lab identify an NE or object to change the OLC state.

Instructions:

The following lines and the figures above summarize the steps recommended to use an object’s Properties form 

for setting the OLC state for this lab:

1. Open an NE Properties form. 

2. On the NE Properties form with the General tab displayed, check the Current OLC State in the OLC panel.
Use the Current OLC State parameter to specify whether a the object is In Service or in Maintenance mode.

3. If required, schedule to revert the OLC state. The Revert OLC State parameter allows to specify whether the 

service object reverts back to either the In Service mode or the Maintenance mode after the selected time, 

depending on the current “Current OLC State”. 
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Lab Objective:

In order to set the OLC state of one or more objects, over the course of this lab exercise students will configure 
the OLC state from the main menu.

Instructor Preparation: 

In preparation for this lab identify one or more NEs or objects to change the OLC state.

Instructions:

The following lines and the figures above summarize the steps recommended from the main menu to use the OLC 

form for changing the OLC state of one or more objects.

Caution 

Changing the OLC state of multiple objects can affect 5620 SAM performance and can take 
several minutes to complete. Changing the OLC state of a parent object changes the OLC state of 
the child objects.

1. Choose Administration - OLC from the 5620 SAM main menu. The OLC form appears with the OLC tab 
displayed. 

2. Select Network Element from the object drop-down menu. If required, configure the filter criteria, as 
required. (For this exercise, choose No Filter) 

3. Click on the Search button. A list of objects appears based on the type of object selected, and the filter 
criteria. 
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4. Select one entry or multiple entries from the list.

5. Click on the OLC State button, and choose Maintenance or In Service from the drop-down menu. 

6. The OLC state of the object changes in the filtered list panel. 

Note 

Operators can configure the Revert OLC State parameter on the properties form for the object. 

The Revert OLC State parameter allows to specify that the object automatically reverts to either 

the In Service mode or the Maintenance mode after a selected time, depending on the current 

OLC state of the object. 
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Lab Objective:

In order to set the OLC state of an alarmed objects, over the course of this lab exercise students will configure 
the OLC state from the alarm window.

Instructor Preparation: 

In preparation for this lab identify an alarmed object to change the OLC state.

Instructions:

The following lines and the figures above summarize the steps recommended to use the alarm window for 

changing the OLC state of an alarmed object.

On the Alarm Window with the Alarm Table tab open, the dynamic alarm list incoming network alarms.

1. Select an alarm from the list. You can select multiple alarms. 

2. Right-click on the alarm and choose Assign OLC State from the contextual menu. The OLC State Assignment 

window opens.

3. Choose Maintenance or In service from the Assigned OLC State drop-down menu.

4. Click on the OK button. Click on the Yes button. 
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Lab Objective:

In order to monitor the scheduling of OLC state changes, instructions in this job aid will guide students on the 
steps to view the scheduling of OLC state changes of network equipment or a service using the OLC –
Schedules form.

Instructor Preparation: 

In preparation for this lab schedule to revert the OLC state of an NE or object.

Instructions:

The following lines and the figures above summarize the steps recommended to use the OLC – Schedules form for 

viewing the scheduling of OLC state changes of network equipment or a service.

1. Choose Administration OLC from the 5620 SAM main menu. The OLC form opens with the OLC tab displayed. 

2. Click on the Schedules tab. A list of scheduled OLC state changes appears.

Configure the filter criteria, if required.

View the following information:

� object ID and name

� current OLC state

� OLC state to which the object reverts at the scheduled time

� time when the OLC state reverts

To open the object properties form, select an entry and click on the Properties button.



5620 SAM � R12.0 Fundamentals
Fault Management � Object Life Cycle State Lab

4 � 6 � 14
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

Filter Alarms Based on the OLC State

1

2

3

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 4.6 Edition 4
Section 4 � Module 6 � Page 14

Lab Objective:

In order to reduce to use the OLC state to reduce the number of alarms listed in the Dynamic Alarm list, 
instructions in this job aid will guide students on the steps to filter alarms based in the alarm window based 
on OLC state.

Instructor Preparation: 

In preparation for this lab set to Maintenance mode the OLC state of one or more NEs or objects, as required.

Instructions:

The following lines and the figures above summarize the steps recommended to create a filter in the alarm 

window, to display only alarms declared against objects set to Maintenance OLC mode.

1. Click on the Alarm Table tab in the alarm window

2. Configure the OLC state heading filter on the alarm list and choose Maintenance from the drop-down menu.

3. Click on the Search button. The Alarm window refreshes with a filter applied, displaying only alarms declared 

against objects set to Maintenance OLC mode.
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Module objectives

Upon completion of this lab module, you should be able to:

� View logged alarm history records in an alarm log database

� Identify the information contain on an Alarm History Object form
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Lab Exercise Objective:

In order to keep track of what has transpired in their network and the frequency to which things occur, 
instructions in this lab exercise will guide students to view logged alarm history records in an alarm log 
database.

Instructor Preparation: 

Provide students with instructions on an alarm to view its history record.

In preparation for this lab exercise the instructor may have performed, or may ask students to perform one or all 

of the following: severity alterations, alarm acknowledgements, raised and clear the alarms multiple times to 

create statistical record entries for the alarm.

Instructions:

The following lines and the figures above summarize the steps recommended to view logged alarm history records

1. From the 5620 SAM main menu, choose Tools � Historical Alarms, The Historical Alarms form opens.

2. If required, specify a filter to narrow the range of historical alarms displayed. Click on the Search button. 

The list of historical alarm records appears based on the filtering criteria.

Note

When sorting alarms, sorting more than 50 000 outstanding or logged alarms may slow GUI 

performance. Use filters to return a reasonable number of alarms.

3. Double-click on an alarm history record from the list. Alternatively, select an alarm history record entry from 

the list, and click in the Properties button.

The Alarm History Object form for the selected record opens with the Info tab displayed. 
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Use the Alarm History Object form’s Info tab to view information about the alarmed object, type of alarm, 

severity, probable cause, first and last time detected.

The Alarm History Object form’s Info tab also displays the following parameters: 

� Alarm Status describing the reason the alarm was logged to the historical alarm database

� Cleared By displaying the name of SAM user that cleared the alarm

� Time Logged with the timestamp when alarm was moved to the historical alarm database

The Info tab contains a View Alarmed Object button which allows to open the properties form for the alarmed 

object.
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Use the Alarm History Object form’s Severity tab to view information pertaining to the severity of the alarm and 

any changes that may have occurred as a result of escalation and/ or demotion.  This also includes the time that 

the alarm was declared and at which any changes occurred.

The severity tab includes parameters such as:

� Highest Severity indicating the most severe status assigned to the alarm. Alarm severity can change due to 

escalation.

� Last time records for severity changed, time cleared, promoted, demoted, escalated and de-escalated 

according to the both the client time and the NE time
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Use the Alarm History Object form’s Statistics tab to view information pertaining to the frequency at which the 

alarm has occurred including: 

� Frequency

� Number of Occurrences indicating how often the alarm was raised

� Number of Occurrences since Clear

� Number of Occurrences since Acknowledged
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Use the Alarm History Object form’s Acknowledgement tab to view information about when the alarm was 

acknowledged, the user that acknowledged the alarm, and the user that set the urgency.

� Acknowledged parameter specifies that the alarm has been acknowledged. Details about the last time the 

alarm was acknowledged appear under the Last Time Acknowledged and Acknowledge by parameters.

� Previously Acknowledged parameter specifies that the alarm had been previously acknowledged.

� Urgency details the user assigned urgency information for the alarm. And the Urgency Assigned by displays the 

name of SAM user that assigned urgency information for the alarm.
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Alternatively, the Historical Alarms form can also be opened:

� Selecting one or more alarms on the Alarm Window, and using the View Alarm(s) History contextual menu. 

Note that the View Alarm(s) History and View Object(s) Alarm History menu options are unavailable when 

more than 20 alarms are selected from the list.

� From the Alarm Info form, clicking on the View Alarm History button. See image above.

� From an object Properties form Faults tab, clicking on the View Alarm History button.
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Module objectives

Upon completion of this lab module, you should be able to:

� Launch the Fault Management web application using :

� the Web Application launch panel

� a direct URL

� Identify browser compatibility issues and to refer to the appropriate 
documentation to troubleshoot the issue
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1

1 Launch the Fault Management Web Application

1.1 Launch the FM Web App Lab

http://server:8400/login

Non-secured 
connection

https://server:9400/login

Secured 
connection

Where server is the hostname or IP 
address of the 5620 SAM server 
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Lab Exercise Objective:

In order for students to become familiar with the process to access the 5620 SAM Fault Management web 

application, instructions in this lab exercise will guide students to launch the Fault Management web application 

using the Web Application launch panel.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a username name and 

password of a 5620 SAM user that has access to the Web Applications. Note that the default admin user group 

can access all 5620 SAM web applications. 

Ensure the terminal has connectivity with the 5620 SAM Server, and the terminal’s web browser is compatible 

with the 5620 Web Apps.

Provide students with information about whether secured connection (SSL) is enabled or disabled in the 5620 SAM 

server.

Technical Reference

For more information on the steps to access the 5620 SAM Web Applications (including browser 

compatibility requirements) see Alcatel-Lucent 5620 SAM User Guide - 5620 SAM web 
applications section.

Instructions:

The following lines and the images above summarize the steps recommended to launch the 5620 SAM Web App

using a web browser for this lab exercise.

1. Open a web browser window and Navigate to the following URL:

http://server:8400/client  for a non-secured connection (SSL not enabled on the 5620 SAM Server) or

http://server:9400/client  for a secured connection (SSL enabled on the 5620 SAM Server)

where server is the IP address or hostname of the 5620 SAM main server

The web browser opens the 5620 SAM Web Applications login page (shown in the figure above).
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1 Launch the Fault Management Web Application

1.1 Launch the FM Web App Lab [cont.]

2

Fault Management

3
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2. In the 5620 SAM Web Applications login page, enter the provided username and password and click on the 

Login button. The 5620 SAM Web Application launch panel appears. As shown on the image above

3. Click on the Fault Management Web Application icon (red icon with an exclamation mark, shown in the image 

above) to launch the FM web app. The Fault management Web App launches with the Top Unhealthy NEs 

View displayed.



5620 SAM � R12.0 Fundamentals
Fault Management � Fault Management Web Application Overview Lab

4 � 8 � 10
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

1

1 Launch the Fault Management Web Application

1.2 Launch the FM Web App – Direct URL Lab

http://server:8400/FaultManagement

Non-secured 
connection

https://server:9400/FaultManagement

Secured 
connection

Where server is the hostname or IP 
address of the 5620 SAM server 
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Lab Exercise Objective:

In order for students to become familiar with the process to access the 5620 SAM Fault Management web 

application, instructions in this lab exercise will guide students to launch the Fault Management web application 

using a direct URL.

Instructor Preparation: 

In preparation for this lab exercise provide students with the 5620 SAM Server address, a username name and 

password of a 5620 SAM user that has access to the Web Applications. Note that the default admin user group 

can access all 5620 SAM web applications. 

Ensure the terminal has connectivity with the 5620 SAM Server, and the terminal’s web browser is compatible 

with the 5620 Web Apps.

Provide students with information about whether secured connection (SSL) is enabled or disabled in the 5620 SAM 

server.

Technical Reference

For more information on browser compatibility requirements see Alcatel-Lucent 5620 SAM User 
Guide - 5620 SAM web applications section.

Instructions:

The following lines and the images above summarize the steps recommended to launch the 5620 SAM Web App

using a web browser for this lab exercise.

1. Open a web browser window and Navigate to one of the following direct URLs:

http://server:8400/FaultManagement  for a non-secured connection (SSL not enabled on the 5620 SAM 

Server), or

https://server:9400/FaultManagement  for a secured connection (SSL enabled on the 5620 SAM Server)

where server is the IP address or hostname of the 5620 SAM main server

The web browser opens the 5620 SAM Web Applications login page (shown in the figure above).
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1 Launch the Fault Management Web Application

1.2 Launch the FM Web App – Direct URL Lab [cont.]

2
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2. In the 5620 SAM Web Applications login page, enter the provided username and password and click on the 

Login button. The 5620 SAM Fault management Web App launches with the Top Unhealthy NEs View 

displayed.

Technical Reference

For more details on direct URLs for launching other 5620 SAM Web Applications see Alcatel-
Lucent 5620 SAM User Guide - 5620 SAM web applications section.
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1

1 Launch the Fault Management Web Application

1.3 FM Web App – Browser Compatibility Troubleshooting

Where server is the hostname or IP 
address of the 5620 SAM server 

http://server:8400/FaultManagement

Non-secured 
connection

https://server:9400/FaultManagement

Secured 
connection

http://server:8400/login  or https://server:9400/login  or
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Lab Exercise Objective:

In order for students to become familiar with the process to troubleshoot browser compatibility issues with the 

5620 SAM Fault Management web application, instructions in this lab exercise will guide students to identify 

browser compatibility issues and to refer to the appropriate documentation for browser compatibility 

requirements.

Note

This lab has been designed in case browser compatibility issues with the 5620 SAM Web 

Applications are encountered during course delivery. 

In case it is not needed, it may be skipped or shown as demo using the images above, as required.

Instructor Preparation: 

In preparation for this lab exercise identify a terminal with an installed non-compatible browser with web 

applications.

Provide students with the 5620 SAM Server address, a username name and password of a 5620 SAM user that has 

access to the Web Applications. Note that the default admin user group can access all 5620 SAM web 

applications. 

Ensure the terminal has connectivity with the 5620 SAM Server, and the terminal’s web browser is compatible 

with the 5620 Web Apps.

Provide students with information about whether secured connection (SSL) is enabled or disabled in the 5620 SAM 

server.

Instructions:

The following lines and the images above summarize the steps recommended to identity and troubleshoot 

browser compatibility issues with the 5620 SAM Web Apps for this lab exercise.

1. Open a non-compatible web browser window and navigate to the one of the URLs to launch the FM Web App.

The web browser opens a Browser Compatibility error page (E.g. shown in the figure above).
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1 Launch the Fault Management Web Application

1.3 FM Web App – Browser Compatibility Troubleshooting [cont.]

Switch to notes view!2. Refer to the Alcatel-Lucent 5620 SAM User Guide - 5620 SAM web applications section for information on 

browser compatibility requirements.

Perform one of the following:

a. Open a compatible web browser, or

b. Install or update a browser to meet the minimum compatibility requirements.
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Fault Management Web Application Overview Lab
End of module
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Module objectives

Upon completion of this lab module, you should be able to:
� Create an NE MIB statistics policy to schedule performance statistics collection

� Apply an NE MIB statistics policy to selected managed devices by assigning sites 
to the collection policy

� Configure the polling interval for a MIB Statistics class on an NE MIB statistics 
policy

� Modify, enable or disable collection of performance statistics by creating a 
specific MIB statistics collection policy

� Configure the polling interval for a MIB Statistics class on a specific NE MIB 
statistics collection policy

� Apply a specific MIB statistics policy to selected managed devices by assigning 
sites to the collection policy

� Display and save to file scheduled performance statistics records for a selected 
object and for a set of objects

� Create a historical performance statistics data graph

� Save to a file historical performance statistics graphical results and tabular 
results
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Module objectives [cont.]
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1 NE MIB Performance Statistics Configuration 
Labs
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1 NE MIB Performance Statistics Configuration Labs

1.1 Create an NE MIB Performance Statistics Policy

� Choose Tools→Statistics→MIB Policies 

� Choose NE MIB Statistics 
Policy (SNMP) and click on 
the Create Button
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Lab Exercise Objective:

In order to regularly gather performance statistics information about physical equipment, routing, and other NE 

properties for monitoring and troubleshooting purposes, over the course of this lab exercise students will 

create an NE MIB statistics policy to schedule performance statistics collection.

Instructor Preparation:

Provide students with instructions on the naming convention to be used for the policy, and the polling 

synchronization time (which is critical to synchronize with an specific MIB policy).

Instructions:

Follow your instructor‘s directions to create an NE MIB statistics Policy on 5620 SAM in order to schedule MIB 

performance statistics collection on one or more NEs.

Technical Reference 

For more information on the steps to create an NE performance statistics policy see Alcatel-
Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 3.3 Performance statistics 
collection procedures – Procedure 3-1 To create or modify an NE MIB statistics policy using a 
top-down method

The following lines and the images above summarize the steps recommended to create an NE MIB performance 

statistics collection policy for this lab.

1. Choose Tools→Statistics→MIB Policies from the 5620 SAM main menu. The MIB Statistics Policies form opens.

2. Choose NE MIB Statistics Policy (SNMP) from the object drop-down list, and click on the Create button. The 

NE MIB Statistics Policy (Create) form opens.
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1 NE MIB Performance Statistics Configuration Labs

1.1 Create an NE MIB Performance Statistics Policy [cont.]

� Configure the parameters:
• Auto-Assign ID / Policy ID
• Displayed Name
• Polling Synchronization time
• Polling Admin State

� Click on 
the OK 
Button
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3. On the NE MIB Statistics Policy (Create) form, configure the parameters:

� Auto-Assign ID specifies whether the 5620 SAM automatically assigns a unique ID to the created object. This 

parameter is enabled by default.

� Policy ID specifies a unique ID number for the policy. The range is 1 to 65 535. To manually assign a Policy 

ID number the operator must disable the Auto-Assign ID parameter.

� Displayed Name specifies a unique name for the created policy object. The range is 0 to 80 characters.

� Polling Synchronization Time specifies the polling synchronization start time from which the polling 

intervals are calculated in hh:mm format based on a 24-hour clock. When the server restarts, the next 

appropriate collection interval is calculated and polling restarts. By default, this parameter is populated 

with the server time when the window was opened, it may be modified as required.

� Polling Admin State specifies whether the polling of managed devices is enabled (up). The options are:

� Up (default)

� Down

4. Click on the OK button. The NE MIB Statistics Policy (Edit) form closes and the MIB Statistics Policies form 

refreshes with the newly configured policy in the list. 

Alternatively:

Click on the Apply button on the NE MIB Statistics Policy (Edit), the form refreshes to display additional tab 

buttons.
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� Choose an 
entry from the 
list and click on 
the Properties 
button

1.1 Create an NE MIB Performance Statistics Policy

1.1.1 Configure Polling for MIB Statistics Class

� Choose Tools→Statistics→MIB Policies

� Choose NE MIB Statistics Policy (SNMP) 
and click on the Search button
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Lab Exercise Objective:

In order to configure the collection criteria for an NE performance statistics collection policy, over the course of 

this lab exercise students will configure the polling interval for a MIB Statistics class on an NE performance 

statistics collection policy.

Instructor Preparation:

Provide students with instructions on the MIB statistics class(es) to be configured in the policy. This may include 

port statistics, routing protocol statistics, among others.

Instructions:

Follow your instructor‘s directions to modify the polling interval for a MIB Statistics class on an NE performance 

statistics collection policy.

Technical Reference 

For more information on the steps to modify the polling interval for a MIB Statistics class see 

Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 3.3 Performance 
statistics collection procedures – Procedure 3-5 To configure polling for a MIB statistics 
class and Alcatel-Lucent 5620 SAM 11.0 R3 User Guide – Section 14.8 Device discovery 
procedures - Procedure 14-4 To configure NE mediation 

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to modify the previously created NE performance statistics collection policy configuring the polling interval to 

collect every 5 minutes OSPF site performance statistics from 7750 managed devices for this lab using.

1. Choose Tools→Statistics→MIB Policies from the 5620 SAM main menu. The MIB Statistics Policies form opens.

2. Choose NE MIB Statistics Policy (SNMP) from the object drop-down list. Click on the Search button. The list 

form displays the configured NE MIB statistics policies.
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1.1 Create an NE MIB Performance Statistics Policy

1.1.1 Configure Polling for MIB Statistics Class [cont.]

� Click on the MIB 
Entry Policies tab

� Configure the search 
filter and click on the 
Search button

	 Select one or more 
MIB counters from 
the list, and click on 
the Properties 
button
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3. Choose an entry from the list and click on the Properties button. The NE MIB Statistics Policy - (Edit) form 

opens with the General tab displayed.

4. On the NE MIB Statistics Policy - (Edit) form, click on the MIB Entry Policies tab button. A list of MIB statistics 

classes appears organized by the product name of the device that supports the MIB.

5. If required, configure the search filter and click on the Search button. Follow your instructor’s directions to 

search for the appropriate MIB statistics class for this lab. The list form displays the MIB entry policies that 

match the search criteria.

For this lab example, in order to limit the number of listed MIBs to OSPF site performance statistics counters 

for 7750 managed devices, the images above show the steps to configure the search filter with the following 

criteria: Product Name containing 7750, MIB Name containing OSPF, MIB Entry Name containing 

tmnxOspfSt.

6. Select one or more MIBs from the list, and click on the Properties button. The MIB Entry Policy (Edit) form 

opens.

Follow your instructor’s directions to select the appropriate MIB statistics class for configuring the polling 

interval for this lab.

This lab example, in order to configure the polling interval to collect OSPF site performance statistics from 

7750 managed devices, the images above show the steps to select the MIB counters for 7750 versions 7.0, 8.0 

and 9.0.
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1.1 Create an NE MIB Performance Statistics Policy

1.1.1 Configure Polling for MIB Statistics Class [cont.]

Switch to notes view!The MIB entry counter TIMETRA-OSPF-NG-MIB-tmnxOspfStatisticsEntry selected for this lab example collects 

OSPF site information which includes counts for the number of:

� times an attempt to add a route to, delete a route from, and modify a route in the Route Table Manager 

(RTM) failed for this OSPF instance

� CSPF requests and dropped CSPF requests made to the OSPF protocol

� paths found and paths not found for the requests made to OSPF protocol

� times the system was in the overflow state and times the system was overloaded

� new link-state advertisements that have been originated

� link-state advertisements received determined to be new instantiations

� times an attempt to run SPF has failed because SPF runs have been stopped as a result of insufficient 

memory resources

Technical Reference 

In order to find the appropriate MIB entry counter, see the Alcatel-Lucent 5620 SAM 11.0 R3 
Statistics Management Guide – Appendices for lists in tabular form of the MIB-based 

performance statistics counters that the 5620 SAM supports per device and release. 

See the Alcatel-Lucent 5620 SAM 11.0 R3 LTE User Guide - Appendices for lists of the MIB-

based performance statistics counters that the 5620 SAM LTE supports.

For MIB-based performance statistics counters supported by other release versions of the 5620 

SAM, refer to the corresponding 5620 SAM release documentation
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1.1 Create an NE MIB Performance Statistics Policy

1.1.1 Configure Polling for MIB Statistics Class [cont.]


 Modify the Polling Interval 
and Administrative State 
configuration parameters

� Click on the OK button
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6. On the MIB Entry Policy (Edit) form, modify as required the Polling Interval and Administrative State
configuration parameters:

� Polling Interval specifies how often MIB elements of discovered and managed devices are polled for 

changes. When changes are detected, the 5620 SAM rereads the MIB element and updates the database. 

For this lab example, in order to collect statistics every 5 minutes, select 5 minutes from the Polling 
Interval drop-down menu. 

� Administrative State specifies whether an performance statistics log policy is administratively enabled.

For this lab example, in order to enable collection of performance statistics for this MIB counter, select Up
from the Administrative State drop-down menu.

Caution

Changing the Number of Varbind per PDU parameter value may affect the time required for 

subsequent NE resynchronizations and degrade 5620 SAM server performance. Do not configure 

the parameter without contacting Alcatel-Lucent technical support.

The Number of Varbind per PDU parameter specifies the maximum number of variable 

bindings, or varbinds, in the SNMP PDUs associated with the MIB entry policy. The parameter is 

used to adjust the PDU size with respect to the network MTU size. The range is 20 to 200. The 

default is 100.

7. Click on the OK button to confirm the action. The MIB Entry Policy (Edit) form closes and the MIB Entry 
Policy (Edit) form reappears.

8. On the MIB Entry Policy (Edit) form, click on the OK or Apply button to save the changes, if required.
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1.1 Create an NE MIB Performance Statistics Policy

1.1.2 Assign Sites to an NE MIB Statistics Policy

� Choose an 
entry from the 
list and click on 
the Properties 
button

� Choose Tools→Statistics→MIB Policies

� Choose NE MIB Statistics Policy (SNMP) 
and click on the Search button
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Lab Exercise Objective:

In order to apply the NE performance statistics collection policy to selected managed devices, over the course of 

this lab exercise students will assign sites to an NE performance statistics collection policy.

Instructions:

Follow your instructor‘s directions to assign sites to the previously created NE performance statistics collection 

policy.

Technical Reference 

For more information on the steps to modify the polling interval for a MIB Statistics class see 

Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 3.3 Performance 
statistics collection procedures – Procedure 3-5 To configure polling for a MIB statistics 
class and Alcatel-Lucent 5620 SAM 10 R5 User Guide – Section 14.8 Device discovery 
procedures - Procedure 14-4 To configure NE mediation 

The following lines and the images above summarize the steps recommended to assign sites to the previously 

created NE performance statistics collection policy for this lab using.

1. Choose Tools→Statistics→MIB Policies from the 5620 SAM main menu. The MIB Statistics Policies form opens.

2. Choose NE MIB Statistics Policy (SNMP) from the object drop-down list. Click on the Search button. The list 

form displays the configured NE MIB statistics policies. 

3. Choose an entry from the list and click on the Properties button. The NE MIB Statistics Policy - (Edit) form 

opens with the General tab displayed.
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1.1 Create an NE MIB Performance Statistics Policy

1.1.2 Assign Sites to an NE MIB Statistics Policy [cont.]

� Open the Network Elements 
tab and click on the Assign 
Sites button

� Configure the filter 
criteria and click on 
the OK button
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4. Click on the Network Elements tab button. On the Network Elements tab click on the Assign Sites button. 

The Assign policy_name Filter form opens.

5. Configure the filter criteria as required, and click on the OK button. To list all managed NEs, leave the filter 

parameters empty and click on the OK button.

The Assign policy_name form opens with a list of NEs displayed.
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2 Specific MIB Performance Statistics Configuration 
Labs
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2 Specific MIB Performance Statistics Configuration Labs

2.1 Create a Specific MIB Statistics Collection Policy

Switch to notes view!
Lab Exercise Objective:

In order to modify, enable or disable collection for specific NE MIB objects, over the course of this 

lab exercise students will configure a policy for performance statistics collection on a specific 

NE MIB object.

Note 

For performance reasons, Alcatel-Lucent recommends using NE MIB policies to 

collect statistics from all instances of an object on an NE, and specific policies to 

enable or disable collection for specific NE MIB objects.

Instructor Preparation:

Provide students with instructions on: 

● the naming convention to be used for the policy 

● the polling synchronization time (which is critical to synchronize with an NE MIB policy).

● the MIB statistics class(es) to be configured in the policy. This may include port statistics, 

routing protocol statistics, among others.

Instructions:

Follow your instructor‘s directions to configure a policy for performance statistics collection on a 

specific NE MIB object.

Technical Reference 

For more information on the steps to create a specific NE MIB object statistics 

collection policy see Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management 
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collection policy see Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management 
Guide – Section 3.3 Performance statistics collection procedures – Procedure 3-
3 To create or modify a specific MIB statistics policy using a top-down method
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� Choose Tools→Statistics→MIB Policies 

2 Specific MIB Performance Statistics Configuration Labs

2.1 Create a Specific MIB Statistics Collection Policy [cont.]

� Choose Specific MIB 
Statistics Policy 
(SNMP) and click on 
the Create Button

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 5.1 Edition 4
Section 5 � Module 1 � Page 18

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to configure a specific MIB performance statistics collection policy to modify the collection of OSPF site 

statistics for this lab.

1. Choose Tools→Statistics→MIB Policies from the 5620 SAM main menu. The MIB Statistics Policies form opens.

2. Choose Specific MIB Statistics Policy (SNMP) from the object drop-down list. Click on the Create button to 

create a MIB statistics policy. The Specific MIB Statistics Policy (Create) form opens.
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2 Specific MIB Performance Statistics Configuration Labs

2.1 Create a Specific MIB Statistics Collection Policy [cont.]

� Configure the parameters:
• Auto-Assign ID / Role ID
• Role Name
• Description

� Click on the Select button
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3. On the Specific MIB Statistics Policy (Create) form, configure the parameters:

� Auto-Assign ID specifies whether the 5620 SAM automatically assigns a unique ID to the created object. This 

parameter is enabled by default.

� Policy ID specifies a unique ID number for the policy. The range is 1 to 65 535. To manually assign a Policy 

ID number the operator must disable the Auto-Assign ID parameter.

� Displayed Name specifies a unique name for the created policy object. The range is 0 to 80 characters.

� Polling Synchronization Time specifies the polling synchronization start time from which the polling 

intervals are calculated in hh:mm format based on a 24-hour clock. When the server restarts, the next 

appropriate collection interval is calculated and polling restarts. By default, this parameter is populated 

with the server time when the window was opened, it may be modified as required.

� Polling Admin State specifies whether the polling of managed devices is enabled (up). The options are:

� Up (default)

� Down

4. Click on the Select button. The Specific Stats Poller Policy form opens.
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2 Specific MIB Performance Statistics Configuration Labs

2.1 Create a Specific MIB Statistics Collection Policy [cont.]

� Choose an object type 
from the list and click 
on the OK button

	 Click on the Apply button to 
display additional tab buttons
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Using the Specific Stats Poller Policy form, follow your instructor’s directions to choose a monitored class object 

type from the list.

For this lab example in order to enable the collection of OSPF statistics at a different polling rate from selected 

sites, select the OSPF Site (Routing Management: OSPF) monitored class. This monitored class applies to 7701, 

7705, 7210, 7450, 7710 and 7750 devices.

Technical Reference 

See the Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Appendices for lists 
of the MIB-based performance statistics that the 5620 SAM supports. 

See the Alcatel-Lucent 5620 SAM 11.0 R3 LTE User Guide - Appendices for lists of the MIB-

based performance statistics that the 5620 SAM LTE supports.

For MIB-based performance statistics supported by other release versions of the 5620 SAM, refer 

to the corresponding 5620 SAM release documentation.

Click on the OK button. 

The Specific Stats Poller Policy form closes and the Specific MIB Statistics Policy form reappears with the object 

type displayed in the Monitored Class Name field.

5. Click on the Apply button. The Specific MIB Statistics Policy form refreshes to display additional tab buttons.

6. Close the MIB Statistics Policies form.
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� Choose an 
entry from the 
list and click on 
the Properties 
button

2.1 Create a Specific MIB Statistics Collection Policy

2.1.1 Configure Polling for a Specific MIB Statistics Class

� Choose Tools→Statistics→MIB Policies

� Choose Specific MIB Statistics Policy 
(SNMP) and click on the Search button
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Lab Exercise Objective:

In order to modify the collection criteria for a specific NE MIB statistic class on selected devices, over the course 

of this lab exercise students will configure the polling interval for a MIB Statistics class on a specific NE MIB 

statistics collection policy.

Instructions:

Follow your instructor‘s directions to modify the polling interval for a MIB Statistics class on a specific NE MIB 

statistics collection policy.

Technical Reference 

For more information on the steps to modify the polling interval for a MIB Statistics class see 

Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 3.3 Performance 
statistics collection procedures – Procedure 3-5 To configure polling for a MIB statistics 
class and Alcatel-Lucent 5620 SAM 10 R5 User Guide – Section 14.8 Device discovery 
procedures - Procedure 14.4 To configure NE mediation 

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to modify the previously configured specific MIB performance statistics collection policy in order to collect of 

OSPF site statistics from 7750 managed devices every 15 minutes for this lab.

1. Choose Tools→Statistics→MIB Policies from the 5620 SAM main menu. The MIB Statistics Policies form opens.

2. Choose Specific MIB Statistics Policy (SNMP) from the object drop-down list. Click on the Search button. The 

list form displays the configured specific MIB statistics policies MIB statistics policies. 

3. Choose an entry from the list and click on the Properties button. The Specific MIB Statistics Policy - (Edit) 
form opens with the General tab displayed.



5620 SAM � R12.0 Fundamentals
Performance Management � Scheduled Performance Statistics Lab

5 � 1 � 22
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

2.1 Create a Specific MIB Statistics Collection Policy

2.1.1 Configure Polling for a Specific MIB Statistics Class [cont.]

� Click on the MIB Entry 
Policies tab

� Select one or more 
MIBs from the list, 
and click on the 
Properties button
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4. On the Specific MIB Statistics Policy - (Edit) form, click on the MIB Entry Policies tab button. A list of MIBs 

for the selected Specific MIB Statistics Policy appears, organized by the product name of the device that 

supports the MIB.

If required, configure the search filter and click on the Search button. The list form displays the MIB entry 

policies that match the search criteria.

Technical Reference 

See the Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Appendices for lists 
in tabular form of the statistics counters that the 5620 SAM supports per device and release.

See the Alcatel-Lucent 5620 SAM 11.0 R3 LTE User Guide - Appendices for lists of the MIB-

based performance statistics that the 5620 SAM LTE supports.

For MIB-based performance statistics supported by other release versions of the 5620 SAM, refer 

to the corresponding 5620 SAM release documentation.

5. Select one or more MIBs from the list, and click on the Properties button. The MIB Entry Policy (Edit) form 

opens.

For this lab example the images above show the steps to modify the 7750 MIB entry policies for versions 7.0, 

8.0 and 9.0 for the previously configured Specific MIB Statistics Policy for the OSPF Site (Routing 

Management: OSPF) monitored class.



5620 SAM � R12.0 Fundamentals
Performance Management � Scheduled Performance Statistics Lab

5 � 1 � 23
COPYRIGHT © ALCATEL-LUCENT 2013. ALL RIGHTS RESERVED.

2.1 Create a Specific MIB Statistics Collection Policy

2.1.1 Configure Polling for a Specific MIB Statistics Class [cont.]

	 Modify the configuration 
parameters


 Click on the OK button
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6. On the MIB Entry Policy (Edit) form, modify as required the configuration parameters:

� Polling Interval specifies how often MIB elements of discovered and managed devices are polled for 
changes. When changes are detected, the 5620 SAM rereads the MIB element and updates the database.
For this lab example, in order to collect statistics every 15 minutes, select 15 minutes from the Polling 
Interval drop-down menu. 

� Administrative State specifies whether an performance statistics log policy is administratively enabled.
For this lab example, in order to enable collection of performance statistics for this MIB counter, select Up
from the Administrative State drop-down menu.

� Number of Varbind per PDU specifies the maximum number of variable bindings, or varbinds, in the SNMP 
PDUs associated with the MIB entry policy. The parameter is used to adjust the PDU size with respect to the 
network MTU size. The range is 20 to 200. The default is 100.

Caution

Changing the Number of Varbind per PDU parameter value may affect the time required for 

subsequent NE resynchronizations and degrade 5620 SAM server performance. Do not configure 

the parameter without contacting Alcatel-Lucent technical support.

7. Click on the OK button. 
Confirm the action.
The MIB Entry Policy (Edit) form closes and the MIB Entry Policy (Edit) form reappears.

8. On the MIB Entry Policy (Edit) form, click on the Apply button to save the changes, if required.
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2.1 Create a Specific MIB Statistics Collection Policy

2.1.2 Assign Sites to a Specific NE MIB Statistics Policy

� Click on the Monitored Objects tab button

� Click on the Add button
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Lab Exercise Objective:

In order to apply the specific MIB statistics policy only to selected managed devices, over the course of this lab 

exercise students will assign sites to a specific NE MIB statistics collection policy.

Instructions:

Follow your instructor‘s directions to assign sites to the previously created specific NE MIB statistics collection 

policy.

Technical Reference 

For more information on the steps to modify a specific NE MIB object statistics collection policy 

see Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 3.3 Performance 
statistics collection procedures – Procedure 3-3 To create or modify a specific MIB statistics 
policy using a top-down method.

The following lines and the images above summarize the steps recommended to assign sites to the previously 

created specific MIB performance statistics collection policy for this lab.

1. On the Specific MIB Statistics Policy - (Edit) form, click on the Monitored Objects tab button.

2. Click on the Add button. The Select monitored_object for Specific MIB Statistics Policy form opens.
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2.1 Create a Specific MIB Statistics Collection Policy

2.1.2 Assign Sites to a Specific NE MIB Statistics Policy [cont.]

� Select one or more objects in the 
list and click on the OK button

� Click on the 
Search button
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3. Configure the filter criteria and click on the Search button. A list of monitored objects is displayed.

4. Select one or more objects in the list and click on the OK button. The Select monitored_object for Specific 
MIB Statistics Policy form closes and the Specific MIB Statistics Policy form reappears with the selected 

objects listed.

5. Click on the OK button to save the changes. The Specific MIB Statistics Policy form closes and the MIB 
Statistics Policies form reappears.

6. Close the MIB Statistics Policies form..
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3 Viewing and Saving Scheduled Performance 
Statistic Records Labs 
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� Choose 
Properties

3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.1 Viewing Records for an Object 

� Select an object and right-click to 
open the contextual menu
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Lab Exercise Objective:

In order to view the scheduled performance statistics data records for a monitored object, over the course of this 

lab exercise students will open in an object the list of statistical data collected from the MIB counters as 

specified in an NE MIB statistics policy or a specific NE MIB statistics collection policy.

Instructor Preparation:

Provide students with instructions on an object for which scheduled performance statistics collection has been 

configured in advance to this lab.

Instructions:

Follow your instructor‘s directions to select an object which has been monitored by an NE MIB statistics policy or 

a specific NE MIB statistics collection policy and open the list of statistical data collected.

Technical Reference 

For more information on the steps to display the statistics values in a current statistics record 

for an object see Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 7.3 
Viewing statistics procedures – Procedure 7-4 To view performance statistics. 

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to open in a OSPF instance the list of statistical data collected according to the schedule of previously 

configured NE MIB statistics policy or specific MIB performance statistics collection policy for this lab.

1. Select on the Navigation Tree an object that has been assigned to an NE MIB statistics policy or a specific MIB 

performance statistics collection policy and right-click to open the contextual menu

For this lab example, using the Routing view on the navigation tree, navigate to the OSPF instance for which 

you want to view statistics choosing Router→Routing Instance→OSPFv2, as shown in the images below. 

Select a site that has been assigned to the previously configured NE MIB statistics policy or specific MIB 

performance statistics collection policy.

2. Choose Properties from the contextual menu. The Object Properties form opens with the General tab 

displayed.
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� Choose a 
statistics class

3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.1 Viewing Records for an Object  [cont.]

� Click on the Statistics 
tab button
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3. Click on the Statistics tab button

4. Choose a statistics class from the object drop-down list.

The statistics records for the selected class are displayed in a list.

For this lab example the images above show the steps to choose “SiteStats (Routing Management OSPF)”, the 

list shows the performance statistics records for the OSPF Site collected using the previously configured NE 

MIB statistics policy or specific MIB performance statistics collection policy. 

Note 

Notice that for statistics records generated by a policy the Record Type is shown as Scheduled. 

The time interval between record should be equal to the polling interval as configured on the 

policy assigned for this object.
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� Select a statistics record and 
click on the Properties button

3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.1 Viewing Records for an Object  [cont.]
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5. To view the statistics counter values for the statistics record, scroll horizontally to view all the statistics 

counter columns in the list. 

Alternatively, select the statistics record and click on the Properties button. The Statistics Record form 

opens displaying the statistics counter values for the statistics record

6. On the Statistics Record form, click on the Close button to close the form.

7. Close the Object Properties form.
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To save the collected scheduled statistics data to a file format

3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.2 Saving to a File Records for an Object 

� Right-click on the list heading

� choose Save 
to File 
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To save the collected scheduled statistics data to a file format.

1. On the Properties form opens with the Statistics tab displayed, identify the scheduled statistics records to 

view from the list form. If required configure the filter criteria and click on the Search button.

Right-click on the list heading, the contextual inventory menu opens.

2. To save the listed statistics record data to a file, choose Save to File from the contextual inventory menu. 

The Save form opens.

3. On the Save form, use the Save In parameter to choose a directory in which to save the listed information. 

Use the File Name parameter to create a filename. 

Choose a file format from the Files of Type drop-down menu.

4. Click on the Save button. The results of the inventory search are saved to the specified file.

5. Close the Save form.

6. Close the Properties form.
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3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.3 Viewing Records for a Set of Objects

� Choose Tools→ Statistics → Statistics Manager

� Choose a 
statistics class 
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Lab Exercise Objective:

In order to view the scheduled performance statistics data records for a set of object, over the course of this lab 

exercise students will display the statistics data records for an statistics class in one or more objects.

Instructor Preparation:

Provide students with instructions on a set of objects for which scheduled performance statistics collection has 

been configured in advance to this lab.

Instructions:

Follow your instructor‘s directions to select a statistic class which has been monitored by an NE MIB statistics 

policy or a specific NE MIB statistics collection policy and open the list of statistical data collected.

Technical Reference 

For more information on the steps to display the statistics values in a current statistics record 

for an object see Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 7.3 
Viewing statistics procedures – Procedure 7-2 To view statistics for a set of objects. 

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to display a list of OSPF site statistical data records collected according to the schedule of previously 

configured NE MIB statistics policy or specific MIB performance statistics collection policy for this lab.

1. Choose Tools → Statistics → Statistics Manager from the 5620 SAM main menu. The Browse Statistics form 

opens. 

2. Configure the Statistic Type parameter. 

3. Choose a statistics class from the object drop-down tree.

Alternatively, you may choose a statistics class by clicking on the Filter button for Object Type.
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3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.3 Viewing Records for a Set of Objects [cont.]

� Choose a Statistics 
Type view 

� Click on the 
Search button

� Choose a time 
filter criteria 
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3. Click on the Search button. The Browse Statistics form refreshes with a list of statistics records entries 

displayed. 

By default the Statistics Type view is Current Data, as a result the list will only display the most recent 

available statistics record entries for the selected statistics class.

4. Choose a Statistics Type view from the object drop-down menu.

5. If required, choose a time filter criteria.

The images above show the steps to open all available records for the OSPF site statistics class collected 

according to the schedule of previously configured NE MIB statistics policy or specific MIB performance 

statistics collection policy by choosing Statistics Record on the Statistics Type view and No filter in the time 

filter criteria.
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3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.3 Viewing Records for a Set of Objects [cont.]

� Select a statistics record and 
click on the Properties button
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6. To view the statistics counter values for the statistics record, scroll horizontally to view all the statistics 

counter columns in the list. 

Alternatively, select the statistics record and click on the Properties button. The Statistics Record form 

opens displaying the statistics counter values for the statistics record

7. On the Statistics Record form, click on the Close button to close the form.
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To save the listed scheduled statistics data to a file format

3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.4 Saving to a File Records for a Set of Objects

� Right-click on the list heading

� choose Save 
to File 
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To save to a file format the scheduled performance statistics data records for a set of object.

1. On the Properties form opens with the Statistics tab displayed, identify the on-demand statistics record to 

view from the list form. If required configure the filter criteria and click on the Search button. 

Right-click on the list heading, the contextual inventory menu opens.

2. To save the listed statistics record data to a file, choose Save to File from the contextual inventory menu. 

The Save form opens.

3. On the Save form, use the Save In parameter to choose a directory in which to save the listed information. 

Use the File Name parameter to create a filename. 

Choose a file format from the Files of Type drop-down menu.

4. Click on the Save button. The results of the inventory search are saved to the specified file.

5. Close the Save form.

6. Close the Properties form.
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3 Viewing and Saving Scheduled Performance Statistic Records Labs 

3.5 Create a Historical Performance Statistics Data Graph

� Choose a statistics 
record

� Click on the 
Plotter button 
and choose 
New Plot 
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Lab Exercise Objective:

In order to graphically plot historical performance statistics on the 5620 SAM GUI, over the course of this lab 

exercise students will create a historical performance statistics data graph.

Instructor Preparation:

Provide students with instructions on the statiscics counters on an object which scheduled performance statistics 

collection has been configured in advance to this lab.

Instructions:

Follow your instructor‘s directions to create a historical performance statistics data graph.

Technical Reference 

For more information on the steps to graphically plot statistics on the 5620 SAM GUI see Alcatel-
Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 8.3 Graphing statistics 
procedures – Procedure 8-2 To configure and plot a statistics graph

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to create a graph for historical OSPF site performance statistics data records collected according to the 

schedule of previously configured NE MIB statistics policy or specific MIB performance statistics collection 

policy for this lab.

1. Choose a statistics record. 

The images above show the steps to select a statistics entry record listed in the Browser Statistics form.

2. Click on the Plotter button and choose New Plot from the drop-down menu. The Statistics Plotter form 

opens.
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Module objectives

Upon completion of this lab module, you should be able to:

� Collect, display and save to file on-demand performance statistics records for a 
selected object

� Create a real-time performance statistics graph

� Save to a file real-time performance statistics graphical results and tabular 
results

� Launch a Statistics Plot Template from the navigation tree
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1 On-Demand Performance Statistics Labs
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� Choose 
Properties

1 On-Demand Performance Statistics Labs

1.1 Collect On-Demand Performance Statistics

� Select an object and right-click to 
open the contextual menu

Copyright © 2013 Alcatel-Lucent. All Rights Reserved.

TOS36033_V4.0-EQ-R12.0-Ed1 Module 5.2 Edition 4
Section 5 � Module 2 � Page 8

Lab Exercise Objective:

In order to collect current statistics records for an object, over the course of this lab exercise students will 

collect on-demand performance statistics for a selected object.

Instructor Preparation:

Provide students with instructions on an object for which on-demand performance statistics will be collected.

Instructions:

Follow your instructor‘s directions to collect and on-demand performance statistics for an object.

Technical Reference 

For more information on the steps to collect and display on-demand performance statistics see 

Alcatel-Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 7.3 Viewing 
statistics procedures – Procedure 7-1 To view on-demand statistics.

In order to exemplify the procedure, the following lines and the images above summarize the steps recommended 

to collect on-demand FIB Next-Hop performance statistics for a card slot for this lab.

1. Select an object on the Navigation Tree and right-click to open the contextual menu.

For this lab example the images above show the contextual menu for a card slot. 

2. Choose Properties from the contextual menu. The Properties form opens with the General tab displayed.
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1 On-Demand Performance Statistics Labs

1.1 Collect On-Demand Performance Statistics [cont.]

� Click on the 
Collect button 
or the Collect 
All button 

� Choose a statistics class 

� Click on the Statistics 
tab button
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3. Click on the Statistics tab button.

4. Choose a statistics class from the object drop-down list.

5. Perform one of the following:

a. Click on the Collect button to collect the statistics for only the specified class.

b. Click on the Collect All button to collect statistics for all classes.

The statistics records are displayed in a list.
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1 On-Demand Performance Statistics Labs

1.2 View On-Demand Performance Statistics
� Identify and select the on-
demand statistics record 

� Click on the 
Properties button
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Lab Exercise Objective:

In order to display the statistics values in a current statistics record and save the data in a file format, over the 

course of this lab exercise students will view and save to file on-demand performance statistics.

Instructions:

Follow your instructor‘s directions to display on-demand performance statistics for an object and save the tabular 

data in a file format.

Technical Reference 

For more information on the steps to display on-demand performance statistics see Alcatel-
Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 7.3 Viewing statistics 
procedures – Procedure 7-1 To view on-demand statistics

The following lines and the images above summarize the steps recommended to display the collected on-demand 

statistics for a card slot for this lab and save the data to a file format.

1. On the Properties form opens with the Statistics tab displayed, identify the on-demand statistics record to 

view from the list form.

2. To view collected on-demand the statistics perform one of the following:

a. Scroll horizontally to view the statistics counter values for the statistics record.

b. Open the statistics record to view it.

i. Select the statistics record and click on the Properties button. The Statistics Record form opens.

ii. View the statistics record.

iii. Click on the Close button to close the Statistics Record form.
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To save the collected on-demand statistics data to a file format

1 On-Demand Performance Statistics Labs

1.3 Save to file On-Demand Performance Statistics

� Right-click on the list heading

� choose Save 
to File 
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To save the collected on-demand statistics data to a file format.

1. On the Properties form opens with the Statistics tab displayed, identify the on-demand statistics record to 

view from the list form. If required configure the filter criteria and click on the Search button. 

Right-click on the list heading, the contextual inventory menu opens.

2. To save the listed statistics record data to a file, choose Save to File from the contextual inventory menu. 

The Save form opens.

3. On the Save form, use the Save In parameter to choose a directory in which to save the listed information. 

Use the File Name parameter to create a filename. 

Choose a file format from the Files of Type drop-down menu.

4. Click on the Save button. The results of the inventory search are saved to the specified file.

5. Close the Save form.

6. Close the Properties form.
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1 On-Demand Performance Statistics Labs

1.4 Create a Real-Time Performance Statistics Graph

� Right-click on an object in the navigation tree and choose Properties 

� Click on the Statistics tab button

� Choose a 
statistics class 
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Lab Exercise Objective:

In order to graphically plot real-time performance statistics on the 5620 SAM GUI, over the course of this lab 

exercise students will create a real-time performance statistics graph.

Instructor Preparation:

Provide students with instructions on an object for which real-time performance statistics will be collected.

Instructions:

Follow your instructor‘s directions to create a real-time performance statistics graph.

Technical Reference 

For more information on the steps to graphically plot statistics on the 5620 SAM GUI see Alcatel-
Lucent 5620 SAM 11.0 R3 Statistics Management Guide – Section 8.3 Graphing statistics 
procedures – Procedure 8-2 To configure and plot a statistics graph

The following lines and the images above summarize the steps recommended to create a graph for real-time 

Ethernet performance statistics on a physical port for this lab.

1. Right-click on an object in the navigation tree and choose Properties from the contextual menu. The 

Properties form for the object opens with the General tab displayed.

2. On the Properties form, click on the Statistics tab button.

3. Choose a statistics class from the object drop-down list
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1 On-Demand Performance Statistics Labs

1.4 Create a Real-Time Performance Statistics Graph [cont.]

� Click on the Plotter button 
and choose New Plot

� Choose a Statistics 
Group and a 
Statistics counter
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4. Click on the Plotter button and choose New Plot from the drop-down menu. The Statistics Plotter form 

opens.

5. Click on a plot in the Statistics Group column of the configuration panel and choose a statistics group from 

the drop-down list.

Additional configurable columns may appear in the configuration panel if the selected statistics group has 

filterable attributes. The columns allow you to filter the statistics. Perform the following actions to configure 

a filter, as required.

� Click on an up or down arrow in a column heading to specify an enumerated entry such as a queue ID.

� Double-click in a text-based column heading and type in a value.

Note 
The 5620 SAM does not validate a typed entry. You must type an entire entry correctly to 

generate the expected filter output.

Click on a plot in the Statistics Counter column of the configuration panel and choose a statistics counter 

from the drop-down list.

For this lab example the images above show the steps to choose the statistics group and statistics counter 

plot the total Ethernet packets for the selected period.
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1 On-Demand Performance Statistics Labs

1.4 Create a Real-Time Performance Statistics Graph [cont.]

� To add a plot choose an object in the 
list and click on the Duplicate button

	 Choose a Statistics Group 
and a Statistics counter

	 To start the real-time statistics graph 
choose a polling interval and click on 
the Real-time Plot button
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To Add a plot to the statistics plotter. The existing object can be duplicated to choose a new object. If the same 

object is used, the statistics counter must be unique. If a different object is used, the same statistics counter 

can be used for each object.

To add a plot using an object in the list:

6. Choose an object from the list and click on the Duplicate button. The plot is duplicated in the list.

7. Click on the new plot in the Statistics Group column and choose a statistics group from the drop-down list.

Click on the new plot in the Statistics Counter column and choose a statistics counter from the drop-down 

list. The counter must be unique.

To add another plot to the plotter, repeat steps 6 and 7. Up to four plots can be created on a graph.

8. To start the real-time statistics graph:

i. Choose a polling interval from the Real-time Polling Interval drop-down menu, or enter a value between 10 

and 3600.

ii. Click on the Real-time Plot button. The detail panel displays the plotted statistics using the configured 

polling interval.

Click on a plot in the Statistics Counter column of the configuration panel and choose a statistics counter 

from the drop-down list.
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1 On-Demand Performance Statistics Labs

1.5 Save the Real-Time Performance Statistics Graph Results

� Click on the 
Save current 
view button
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Lab Exercise Objective:

In order to save to a file the current view of a real-time performance statistics graph, over the course of this lab 

exercise students will save a real-time performance statistics graphical result.

Instructions:

Follow your instructor‘s directions to save to a file a real-time performance statistics plot in a graphical format.

Technical Reference 

For more information on the steps to save the statistics graph results see Alcatel-Lucent 5620 
SAM 11.0 R3 Statistics Management Guide – Section 8.3 Graphing statistics procedures –
Procedure 8-2 To configure and plot a statistics graph

The following lines and the images above summarize the steps recommended to save to a file the statistics graph 

results for this lab.

1. Click on the Save Current View button. The Save as form appears.

2. Specify a directory in which to save the statistics graph using the Save In parameter. The Save In form opens.

3. Enter a filename in the File Name field.

4. Choose JPG or PNG from the Type of File drop-down menu.

5. Click on the Save button. The Save as form closes and the graph is saved in the specified JPG or PNG file.
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1 On-Demand Performance Statistics Labs

1.6 Save the Real-Time Performance Statistics Table Results

Data panel

� Select Save to File to 
save tabular data

� Right-click on the 
table header
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Lab Exercise Objective:

In order to save to a file a table of the collected statistics values, over the course of this lab exercise students 

will save a real-time performance statistics table results.

Instructions:

Follow your instructor‘s directions to save to a file a a table of the real-time performance statistics collected 

values.

Technical Reference 

For more information on the steps to save the statistics table results see Alcatel-Lucent 5620 
SAM 11.0 R3 Statistics Management Guide – Section 8.3 Graphing statistics procedures –
Procedure 8-2 To configure and plot a statistics graph

The following lines and the images above summarize the steps recommended to save to a file the statistics table 

results for this lab.

1. Right-click on the plot value list heading, the contextual inventory menu opens.

2. Choose Save To File from the contextual menu. The Save form opens.

3. Specify a directory in which to save the statistics table using the Save In parameter. The Save In form opens.

4. Enter a filename in the File Name field.

5. Choose HTML or CSV from the Type of File drop-down menu.

6. Click on the Save button. The Save form closes and the contents of the plot value list are saved in the 

specified file.
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1 On-Demand Performance Statistics Labs

1.7 Launch a Statistics Plot from the Navigation Tree

� From the navigation tree, 
choose one NE  

� Right-click and choose 
Plotter > New Plot  
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Lab Exercise Objective:

In order to graphically plot real-time performance statistics on the 5620 SAM GUI for an object in the navigation 

tree, over the course of this lab exercise students will launch a real-time performance statistics graph from 

the navigation tree.

Instructor Preparation:

Provide students with instructions on an object for which real-time performance statistics will be collected.

Instructions:
1. Open the navigation tree and choose one NE

2.Right click and choose Plotter > New Plot
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On-Demand Performance Statistcs Lab
End of module
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